
 

 

Geoplot Registration Card 

 

Geoplot Version   Date received   Serial number___________________ 
Name and address of supplier__________________________________________________________________ 
__________________________________________________________________________________________ 
Your name     Your title_____________________________________ 
Organisation________________________________________________________________________________ 
Address___________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
City      County / State__________________________________ 
Postal / Zip code     Country_______________________________________ 
Telephone      Fax__________________________________________ 
Email address_______________________________________________________________________________ 
 

By answering the following questions you will be helping us to help you if you have a problem whilst using 
Geoplot. The information will also enable us to improve and develop Geoplot more effectively, by tailoring it 
more closely to your present and future requirements. Thank you ! 

 

Please supply details of the computers you will be using with Geoplot : 

      Notebook PC   Desk-top PC 

• Make and model_________________________________________________________________________ 
• Processor type___________________________________________________________________________ 
• Processor speed_________________________________________________________________________ 
• Memory size____________________________________________________________________________ 
• Hard-disk size___________________________________________________________________________ 
• Graphics card___________________________________________________________________________ 
• Graphics resolution used (eg 640x480)_______________________________________________________ 
• Screen / monitor dimension________________________________________________________________ 
• Operating system and release_______________________________________________________________ 
• Number of serial ports____________________________________________________________________ 
• Number of USB ports_____________________________________________________________________ 
• Number of Infra-red ports_________________________________________________________________ 
 

Please supply details of the printers you will be using with Geoplot : 

     Printer 1   Printer 2   Printer 3 

• Make and model_________________________________________________________________________ 
• Monochrome or colour____________________________________________________________________ 
• Resolution______________________________________________________________________________ 
• Maximum paper size_____________________________________________________________________ 
 

What survey types (eg resistance) and instruments (eg RM15) are you using with Geoplot ? 
__________________________________________________________________________________________ 

 
For what applications are you using Geoplot (eg archaeology, geology, environmental etc) ? 
__________________________________________________________________________________________ 
 



  
 

What other INSTRUMENTS would you like to input data from directly into Geoplot ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What other GRAPHICS export formats would you like ? If BMP is not sufficient why not ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What other DATA import / export formats would you like ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What other software packages (presentation, analysis, GIS etc) will you use with Geoplot ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What features do you like most in Geoplot ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What features do you like least in Geoplot ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
What new features would you like to see in future versions ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
Did you find instruction manual easy or hard to use ? How could it be improved ? 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 
Other comments : 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
__________________________________________________________________________________________ 
 

Thank you very much for registering and helping us with this survey. Please post to : Geoscan Research, 
Heather Brae, Chrisharben Park, Clayton, Bradford, BD14 6AE, UK or fax back to : +44-(0)1274-818253.
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 Licence Agreement and 
Limited Warranty 

Carefully read all the terms and conditions of this agreement before using the disks and hardware or software 
copy protection lock. Using the disks and hardware or software lock indicates your acceptance of the terms and 
conditions of this licence agreement, Terms and Limited Warranty. 

Licence Agreement 
This software and accompanying instruction manual are the subject of copyright. All rights are reserved. 
Unauthorised copying of the software or instruction manual is expressly forbidden. You may be held legally 
responsible for any copyright infringement which is caused by, or encouraged by, you. 

Subject to the above restrictions you may make one copy of each disk solely for back-up purposes. If you are 
using a software lock then you will not be able to make a copy of disk 3 due to the software authorisation 
process. You may use the program only on one computer or computer terminal at a time, unless you have 
purchased a multiuser network licence. You may not decompile, disassemble, reverse engineer, or in any way 
modify the program code. 

You may not rent, lease, loan or make the software available to third parties using the internet without the 
written permission of Geoscan Research. You may transfer your rights under this Licence Agreement on a 
permanent basis provided that : (a) you transfer all copies of the software and written material (including all 
prior versions) to one, and only one, other recipient, (b) additional licences, purchased at a discount on the price 
for a single copy, are not transfered as individual copies but are transferred to just one recipient, (c) the recipient 
agrees to the terms of this agreement, (d) the recipient re-registers each copy transfered - without this re-
registration technical support, updates and upgrades will not be available. In particular, you should note that 
additional licences, purchased at a discount on the price for a single copy, are for single departmental use only. 

Terms 
Your licence to use the program and documentation will automatically terminate if you fail to comply with the 
terms of this agreement. If the licence is terminated, you agree to return all copies of the program, protection 
lock and documentation to Geoscan Research. If it is found that any of the licence terms have been broken then 
Geoscan Research may, at its discretion, withdraw all technical advice, repair and servicing facilities and any 
other support for all products supplied by Geoscan Reserach, both software and hardware. Any existing 
hardware guarantees will, however, be honoured until their expiry dates. 

Limited Warranty 
This program and accompanying instruction manual are supplied "as is", without warranty of any kind. We 
make no warranties, express or implied, as to their performance, merchantability, or fitness for any particular 
purpose, or that the program or instruction manual are error free. In particular you should not use, or rely on, the 
program, files produced by the program, results of the program or its processing and presentations as evidence in 
a court of law, or in circumstances that could result in injury to a person or loss of property. The entire risk as to 
the results and performance is assumed by the user. In no event will Geoscan Research be liable to you for 
damages, including any loss of profits, lost savings, or other incidental or consequential damages arising out of 
your use or inability to use the program. 

Geoscan Research will replace, free of charge, defective diskettes or copy protection locks that are returned 
within 90 days of the date of purchase. Defective protection locks must be returned prior to replacement, fully 
insured against loss. If the lock is lost then we can accept no responsibilty and a  replacement will then only be 
sent out and charged at the full cost of a new Geoplot program. 
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 Insurance of the Copy 
Protection Lock 

Geoplot Protection 
Geoplot is copy protected by using either (a) a hardware lock (dongle) that plugs into the parallel port of the 
computer or (b) a software lock (authorisation) that is installed on your hard-disk. The software will only run if 
the hardware lock or software authorisation is present. The software authorisation can be transferred to another 
computer by using the floppy disk provided. New copies of the software are supplied using a software lock 
whilst upgrades from an earlier version to 3.0 normally use the the hardware lock issued earlier. We very much 
regret having to copy protect Geoplot and the inconvenience it may cause you. Unfortunately numerous 
instances of unauthorised copying of earlier versions of Geoplot have come to our notice, prompting us to adopt 
this approach. 

Please look after your enclosed  hardware or software lock system. In the case of software protection you will 
need the original disk 3 to transfer the authorisation from computer to computer. We strongly suggest that you 
insure the hardware or software lock against loss, theft etc for the full cost of a new Geoplot since we will not be 
be sending out replacments free of charge in such circumstances. An exception will be if the lock becomes 
faulty then, on its safe return and, in the case of a software lock with the authorisation still on disk 3, we will 
send out a replacement free of charge. Make a note of the serial number. You will be asked for this information 
if there is a problem with the disks, lock or the original lock is lost. 
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Chapter 1  

INTRODUCTION 

About This Documentation 
This document is an interim Instruction Manual which is being supplied with the initial release of Geoplot 3.0 
for Windows. A more comprehensive manual (200-250 pages) is in preparation and will be sent to you at no 
extra cost as soon as it is complete. In the meantime, we have supplied the graphics portion of the 
documentation from the earlier DOS version 2.02 for use in conjunction with version 3.0. We hope you do not 
find this mixture of documentation too confusing. Thank you for your understanding and patience. This 
documentation relates to Geoplot version 3.00s and earlier. 

Hardware Requirements 
Geoplot 3.0 consists of  three items: (a) CD with installation code, (b) comprehensive instruction manual with 
tutorial and (c) softare protection -  this is provided as either a USB or LPT hardware dongle, or a software 
authorisation. The software authorisation is transferred to your hard disk from a floppy disk or can be transferred 
to another PC via the floppy disk. 

The software is normally supplied for one user operating on a stand-alone PC or a computer network. Multiple 
user versions are available for use on client-server network systems. Multiple user educational versions, with 
restricted functionality, are available for use on client-server network systems.  

Operating system should be one of the following : Windows 3.1, 3.11, 95, 98, ME, NT4, 2000 or XP. Minimum 
recommended hardware is a Pentium II class processor, cpu speed 266 Mhz or faster, with SVGA display or 
better for desktop work. Geoplot 3.0 will also work on PC's as slow as a 486 DX2 40Mhz processor so an older 
laptop computer with VGA display running Windows 3.1, for example, could be used for downloading data in 
the field. An RS232 communication port is required if data is to be downloaded from instruments into Geoplot 
3.0 - if there is only a USB port available then a USB to serial port adapter may be used. A 3.5 inch floppy disk 
drive (built-in or external USB) may also be required for software authorisation transfer. 

Compatibility with earlier versions 
Grid data, composite data and master grids (meshes) generated using earlier versions of Geoplot (1.2 and 2.0) 
may be used directly with Geoplot 3.0. However, version 3.0 data is not backward compatible with version 1.2. 
Version 3.0 data may be read by version 2.0 but the resulting layout on the file information and history forms 
may not be as normal. Input templates generated with earlier versions are not compatible. 

Upgrades and Support 
Geoplot is undergoing constant improvement and refinement. Future upgrades will include interfaces to new 
instruments and new data formats, together with new processing and presentation facilities. If there are specific 
facilities not mentioned above that users would like to be included in future versions then we would be happy to 
consider suggestions. A charge will be made for upgrades. Full technical support is provided free of charge. 
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Insurance of the Copy Protection Lock 
As mentioned earlier, each Geoplot Licence is copy protected by using either (a) a hardware lock (dongle) that 
plugs into the parallel port of the computer or (b) a software lock (authorisation) that is installed on your hard-
disk. The software will only run if the hardware lock or software authorisation is present.  

Please look after your enclosed  hardware or software lock system. In the case of software protection you will 
need the original disk 3 to transfer the authorisation from computer to computer. We strongly suggest that you 
insure the hardware or software lock against loss, theft etc for the full cost of a new Geoplot. If the lock becomes 
faulty then, on its safe return (please insure) and, in the case of a software lock with the authorisation still on 
disk 3, we will send out a replacement free of charge. Make a note of the serial number. You will be asked for 
this information if there is a problem with the disks, lock or the original lock is lost. 

Note your Geoplot Serial Number here : 

Technical Support 
Full technical support, via telephone, fax or email, is provided free of charge. If you have a problem then please 
consult this manual first, looking at the main text, where various hints and tips are given and especially the 
Trouble-Shooting chapter which covers frequently asked questions and error messages. If you cannot find the 
answer then please contact Geoscan Research in the UK or the USA (see below), whichever is most convenient. 

When you call, fax or email please could you supply the following information : 

• Your name, organisation and Geoplot Licence number (appears on disks and Lock). 
• The type of hardware you are using (processor, speed, graphics display resolution and number of colours, 

printer type, serial or PS2 mouse). 
• Operating system in use, along with version number and service packs applied. 
• Details of the problem you are experiencing – please be as specific as possible. 
• The exact error number and location reported if one occured. 
• How you have tried to solve the problem. 

UK Technical Support 
In the UK we have set up a special Geoplot telephone hot-line : 01274-884828. Please use this number only for 
enquiries concerning Geoplot - it is not intended for enquiries concerning instrumentation etc. Respecting the 
purpose of this number will help us to provide you with better support for Geoplot. Should you be unable to 
make contact on the Geoplot hot-line then please use the normal office number which is : 01274-880568. Should 
you prefer to fax details of your problem then please send this to : 01274-818253. Our email address is: 
techsupport@geoscan-research.co.uk 

USA and Canada Technical Support 
In the USA technical support is available from Geoscan Research USA on Tel/Fax: 707-785-3384. The email 
address is somers@mcn.org. You may fax or telephone this number with specific technical support 
requirements, assistance with data processing, interpretation and survey design issues.  

Registering Your Geoplot Licence 
It is very important that you fill in the registration card you received with Geoplot. Not only will this feedback 
help us to improve Geoplot for your current and future needs, it will also ensure that you are notified of 
upgrades or updates to Geoplot. 
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How to Use the Geoplot Documentation 
Geoplot documentation comprises this instruction manual and a set of Reference cards. The manual is organised 
as follows : 

Chapter 1, Introduction  
Introduces Geoplot, its hardware requirements and tells you about important information concerning the copy 
protection Lock and registration. Typographic conventions used in the rest of this manual are introduced. 

Chapter 2, Installation 
Provides instructions for installing and uninstalling Geoplot, together with instructions on how to start up 
Geoplot and shows important first steps in using Geoplot, depending on the operating system. 

Chapter 3, Tutorial 
An extremely important chapter which uses a tutorial to provide the user with a solid understanding of the way 
Geoplot is organised and will introduce the user to many of Geoplot's facilities. Step by step you will be shown 
how to edit, process and present demonstration surveys. You should follow through the tutorial in detail, even if 
you have used the earlier DOS version 2.02, otherwise you will not become aware of new features added or 
changes that have been made. 

Chapter 4, Data Input 
Provides instructions on how to get data into Geoplot using (a) keyboard entry, (b) downloading of data from 
instruments and (c) import of data from other software packages. A reference section is included at the end. 

Chapter 5, Additional Information 
This chapter supplements the previous chapters. The text assumes you have worked through the tutorial and so 
have an understanding of the Geoplot environment. Major topics are : (a) export, (b) pseudo-section creation and 
(c) generation and overlay of contour plots. This chapter also presents guidelines on how to approach data 
processing for several survey types. 

Chapter 6, Trouble-Shooting 
This chapter answers a number of frequently asked questions concerning the use of Geoplot and explains some 
of the error messages you may meet using Geoplot. 

Appendices 
A number of appendices are provided which give background information and further reference sections. 

Reference Cards 
Reference cards provide summaries of : (a) Geoplot file types and technical terms and how they are used in the 
Geoplot environment, (b) processing sequences appropriate for different data types. The processing sequence 
cards allow the new user to become adept and competent in processing data with a minimum of effort, as well as 
showing how to prevent  inappropriate processing of the data. 

    IMPORTANT 

Before doing your first survey study Chapter 4, Data Input, very carefully, since if you 
collect data incorrectly you may not be able to download it into Geoplot. If you are new 
to processing techniques then the Reference cards will be of particular use. You will 
also need to set up the Options Menu before using Geoplot for the first time. This will 
enable you to configure Geoplot for your particular computer as well as your personal 
preferences, especially with regards to data storage and retrieval.  
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Document Conventions 
This manual uses the following typographic conventions : 

Example of convention Description 

Copy Text that you should type appears in a bold typeface. Also used when keywords are 
introduced or for extra emphasis. 

Ctrl+A A plus (+) sign indicates a combination of keys. For example, Ctrl+A means you 
should hold down the Ctrl key while pressing the A key. Similarily, Ctrl+Enter 
means you should hold down the Ctrl key while pressing the Enter key - it does not 
mean press the Ctrl key and then press the Enter key. 

Down key The cursor movement ("arrow") keys are called direction keys. They are referred to 
by the direction of the arrow marked on the key top (Up, Down, Left or Right). 

F8 The function keys, usually placed at the very top of the keyboard,are referred to by 
a capital "F" followed immediately by the number of the function key. This does 
not refer to the ordinary numeric keys. 

a: or  A: Disk drives and file names can be refered to by upper or lower case letters – they 
are not case sensitive. 

Rgrv\1.cmp Used to specify which data file is to be opened (1.cmp) and the directory (Rgrv) in 
which it will be found. 

   Toolbar button to which the text refers. 

Warnings 
Warnings of potential problems are displayed in a grey box with a “Stop” sign. Pay particular attention to the 
message to avoid problems occuring. 

      WARNING 

Warnings of potential problems are represented in this way, in a grey box with outline. 

 

Information Panels 
Important information is displayed in information panels which consist of text within grey shadow boxes. These 
panels may summarise information discussed in the text or may introduce very important concepts which you 
should read and understand whilst following the main text. 

 

Information 

Important information is displayed in this format, in a grey shadow box. 

Read.Me File 
Check the installation directory for a file called READ.ME. This file, if it is present will contain details of any 
recent changes to the program or manual that are not documented in this manual. Use Notepad or Wordpad  to 
read the READ.ME file. 

 



  

Chapter 2  

INSTALLATION 

Introduction 
Each Geoplot Licence is copy protected with either a hardware lock (dongle) or a software lock. The installation 
procedure is different for each protection type and hardware lock so please follow the appropriate set of 
instructions that follow. Hardware locks made by Matrix are blue whilst hardware locks supplied made by Az-
Tech are black.  

Matrix USB locks are now supplied as HID devices which do not normally require drivers installing (serial 
numbers GP05699 onwards). Previous Matrix USB locks (serial numbers GP05667-GP05697) require a driver 
installing. Please follow the appropriate instructions for your dongle serial number. 

Multiple and Network Installations and 60-day Trial Version installations are discussed at the end of the chapter. 

Hardware Protection Lock (Matrix serial number GP05699 and later) 

Geoplot Media 
Geoplot 3.0 is supplied on a single CD. The installation code comprises compressed executable files, data files 
and driver files (which may be required for LPT dongles) to be installed using the supplied installation 
programs. It is advisable to make a working copy of the installation media before installation. Use this copy for 
installation and store the original CD safely away. The CD also contains backup copies of  Geoplot system files, 
default options files, palettes, demo data etc in the RestoreFiles directory. 

Preparing to Install Geoplot 
Matrix hardware locks are available as either a USB dongle that plugs into a USB port of the PC or as an LPT 
dongle that plugs into the parallel port of the PC. USB Dongles can be used with Windows 98 (2nd Edition), 
ME, 2000, and XP. LPT Dongles can be used with Windows 3.1, 95, 98, ME, NT4, 2000 and XP. If  you do not 
have the correct dongle for your operating system then please contact Geoscan Research about changing the 
dongle type. The computer may be a standalone PC or connected to a network. 

LPT dongle installation is done in two stages. The first stage is to install Geoplot code from the CD. The second 
stage is to install drivers  that allow Geoplot to access the dongle. You will need to be a System Administrator or 
contact your IT department in order to install these drivers on NT4, 2000 or XP. 

Geoplot 3.0 can co-exist with Geoplot 2.0 for DOS and can access any data created by the DOS version. 
However, you must uninstall any Windows versions of Geoplot 3.0 if you plan to install to the same location. 
(During future use you will not need to uninstall Windows versions if you subsequently download update 
patches from the Geoscan Research website to bring your copy of Geoplot up to date.) 

The installation program creates required directories, copying files from the CD into those directories. Most 
required DLL and .VBX files are copied into Geoplot’s own directory; however, files IWPORT.VXD, 
MATRIX16.DLL and MATRIX32.DLL are copied into the \WINDOWS\SYSTEM directory.  Running the 
program drv_inst (for LPT driver support in NT4, 2000 or XP) will copy the driver file IWPORT.SYS from the 
Geoplot directory into the \WINDOWS\SYSTEM32\DRIVERS directory. 
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During installation no direct alterations are made to the Windows registries during code installation, though 
changes are made to WIN.INI, with a [GP300] entry being added. Windows itself will make updates to the 
registry concerning Geoplot. 

The installation program generates sample data in a “geoplot” directory on the drive where Windows is 
installed. Shade plot palettes are also generated in a “palette” directory on the drive where Windows is installed. 

Code Installation 
1 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

2 Ensure that the USB dongle is not plugged into a USB port. 

3     Make sure you have installed at least one printer driver on the system. Close all other programs. 

4 Uninstall any earlier versions of Geoplot 3.0. See the section below for general uninstallation details. 

5 Geoplot is provided on a CD containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk. Insert the CD in the CD-ROM slot. 

6 If you are using Windows 3.1 or 3.11, then whilst in Program Manager, select Run from the File menu and 
type d:\setupex.exe (where d is the name of the CD-ROM drive) and press Enter.  

7 If you are using Windows 98, ME, 2000 or XP the disk should automatically begin the installation when 
you insert the CD. If it does not click on the Start button on the Task Bar, select Run, and either Browse to 
d:\setupex.exe or type d:\setupex.exe (where d is the name of the CD-ROM drive) and press Return or 
click OK.  

8 Follow the instructions given on the screen. After an introductory screen an information screen appears. This 
includes a reminder of USB, LPT and operating system requirements.  

9 A dialog box then opens allowing you to choose where to install Geoplot. The default installation directory 
is “c:\gp300”. It is advisable to choose the default directory so that uninstall works correctly should you 
choose to remove Geoplot in the future, however you are free to choose another drive or directory but you 
must install Geoplot in a directory, not a root directory. Since Geoplot is a 16 bit application you must not 
use more than eight characters for directory or file names. 

10 The next screen allows you to choose the folder name that appears on the Program menu. The default is 
“Geoplot 3.00” and it also shows a list of existing folder names - if you do not use the default make sure 
you do not use an existing name. 

11 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

12 When you press “Next”, the installation will go ahead, with a progress report being made. 

13 The final screen will inform you when code installation is complete. 

Driver Installation 
• USB Dongles 

Windows 98, ME, 2000, XP. The USB dongles are HID compliant and so do not require a driver installing. 
When you plug the dongle into the USB port the LED should flash momentarily and  a message similar to: 
“Found New Hardware: USB Chip, Human Interface Device” will be displayed. You may now run Geoplot – 
see next section.  

• LPT Dongles 

Windows 3.1, 95, 98, ME. The LPT driver will already be installed in the \Windows\system directory. You may 
run Geoplot after code installation – see next section 

Windows NT4, 2000, XP. Before running Geoplot for the first time, go to the Program Menu, select the 
Geoplot folder and click on the program drv_inst. The Matrix LPT Driver program dialog box will appear, 
figure 2-3. Press Continue to install the driver. If you are instructed to reboot your computer to complete 
installation of the drivers please do so. When this is complete you may run Geoplot – see next section. 
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Figure 2-3.  LPT driver installation for Windows NT4, 2000 and XP. 

Running Geoplot 
Before you run Geoplot for the first time it is very important that you check your Regional Settings to ensure 
that the Decimal Symbol in the Number Tab is a decimal point and not a comma, otherwise you can encounter 
problems using Geoplot. You can access the Regional Settings by clicking on the Windows Start button, select 
Control Panel from the menu and then Regional Settings. 

    Regional Settings 

It is very important that you set your Regional Settings so that the Decimal Symbol in 
the Number Tab is a decimal point and not a comma otherwise you can encounter 
problems using Geoplot. You can access the Regional Settings by clicking on the 
Windows Start button, select Control Panel from the menu and then Regional Settings. 

 

 

If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the icon GP300mx to run Geoplot. If you are using Windows 95, 98, ME, NT4, 2000 or XP then, select 
“Geoplot 3.00” from the program menu, and then click on GP300mx in the sub-menu. Geoplot will now start.  

A splash screen will appear for a few seconds to be followed by the main Geoplot screen. You can run multiple 
instances of Geoplot at the same time for data comparison. Should your dongle not be present, or any printer 
connected is off-line then an error message will be displayed - following the advice should correct the problem.  

    IMPORTANT 

When you use Geoplot for the first time you should examine the Options Menu and 
configure the Graphics, FilePaths and Publish Options to your requirements and save 
these – the Tutorial in Chapter 3 shows you how to do this. Even if you do not change 
anything and accept the default options you should still save these. The FilePath 
entries will need changing if you install Geoplot on a drive other than c: otherwise 
Geoplot will not be able to locate the sample data provided. You should also have 
installed at least one printer in your Windows environment before using Geoplot, 
otherwise you will get a “Printer Error” if you try to access any functions that are 
directly or indirectly associated with printing. If side toolbars overlap the top menu bar 
their vertical position can be adjusted in Options, Environment, General tab. 
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Problems running Geoplot 
If you experience problems after the splash screen is shown and cannot proceed as far as the main Geoplot 
screen, first of all make sure Geoplot is the only program running and then try to start Geoplot again. If that does 
not resolve the problem then, for an LPT dongle, it is likely that a device driver or diagnostic has been loaded by 
Windows that is preventing access to the parallel port - examples are drivers for laser printers, parallel port 
scanners, parallel port sound devices, parallel port CDROM or ZIP drives.  In order to get Geoplot running it is 
neccessary to identify and disable the driver or diagnostic. See Chapter 6, Trouble-Shooting, for further advice. 

Uninstalling Geoplot 
To uninstall the main Geoplot application you should run the Uninstall program which is supplied with Geoplot 
– do not simply delete files. If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to 
open it up, and then double click on the Uninstall icon. If you are using Windows 95, 98, ME, NT4, 2000 or 
XP then, select “Geoplot 3.0” from the program menu, and then Uninstall. This will remove all the installed 
Geoplot files, directories, groups and program menu entries, though it will not remove the [GP300] entry in 
WIN.INI. You will also find that the file MRUFILES.INI is not removed by the uninstall program and this 
should be deleted manually – it is typically found in the file path: C:\GP300\GP300\OPTIONS\MRUFILES.INI. 

Hardware Protection Lock (Matrix serial number GP05667-GP05697) 

Geoplot Media 
Geoplot 3.0 is supplied on a single CD. The installation code comprises compressed executable files, data files 
and driver files for the dongle to be installed using the supplied installation programs. It is advisable to make a 
working copy of the installation media before installation. Use this copy for installation and store the original 
CD safely away. The CD also contains backup copies of  Geoplot system files, default options files, palettes, 
demo data etc in the RestoreFiles directory. 

Preparing to Install Geoplot 
Matrix hardware locks are available as either a USB dongle that plugs into a USB port of the PC or as an LPT 
dongle that plugs into the parallel port of the PC. USB Dongles can be used with Windows 98 (2nd Edition), 
ME, 2000, and XP. LPT Dongles can be used with Windows 3.1, 95, 98, ME, NT4, 2000 and XP. If  you do not 
have the correct dongle for your operating system then please contact Geoscan Research about changing the 
dongle type. The computer may be a standalone PC or connected to a network. 

Installation is done in two stages. The first stage is to install Geoplot code from the CD. The second stage is to 
install dongle drivers  that allow Geoplot to access the dongle. You will need to be a System Administrator or 
contact your IT department in order to install these drivers on NT4, 2000 or XP. 

     INSTALL USB INF FILE BEFORE PLUGGING IN DONGLE 

It is very important that you install the USB INF file before plugging in the USB dongle 
for the first time. This is so Plug&Play can properly locate the USB driver. 

 

Geoplot 3.0 can co-exist with Geoplot 2.0 for DOS and can access any data created by the DOS version. 
However, you must uninstall any Windows versions of Geoplot 3.0 if you plan to install to the same location. 
(During future use you will not need to uninstall Windows versions if you subsequently download update 
patches from the Geoscan Research website to bring your copy of Geoplot up to date.) 

The installation program creates required directories, copying files from the CD into those directories. Most 
required DLL and .VBX files are copied into Geoplot’s own directory; however, files IWPORT.VXD, 
MATRIX16.DLL and MATRIX32.DLL are copied into the \WINDOWS\SYSTEM directory.  Running the 
program drv_inst (for LPT driver support in NT4, 2000 or XP) will copy the driver file IWPORT.SYS from the 
Geoplot directory into the \WINDOWS\SYSTEM32\DRIVERS directory. 
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During installation no direct alterations are made to the Windows registries during code installation, though 
changes are made to WIN.INI, with a [GP300] entry being added. Windows itself will make updates to the 
registry concerning Geoplot. 

The installation program generates sample data in a “geoplot” directory on the drive where Windows is 
installed. Shade plot palettes are also generated in a “palette” directory on the drive where Windows is installed. 

Code Installation 
3 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

4 Ensure that the USB dongle is not plugged into a USB port. 

3     Make sure you have installed at least one printer driver on the system. Close all other programs. 

4 Uninstall any earlier versions of Geoplot 3.0. See the section below for general uninstallation details. 

5 Geoplot is provided on a CD containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk. Insert the CD in the CD-ROM slot. 

8 If you are using Windows 3.1 or 3.11, then whilst in Program Manager, select Run from the File menu and 
type d:\setupex.exe (where d is the name of the CD-ROM drive) and press Enter.  

9 If you are using Windows 98, ME, 2000 or XP the disk should automatically begin the installation when 
you insert the CD. If it does not click on the Start button on the Task Bar, select Run, and either Browse to 
d:\setupex.exe or type d:\setupex.exe (where d is the name of the CD-ROM drive) and press Return or 
click OK.  

8 Follow the instructions given on the screen. After an introductory screen an information screen appears. This 
includes a reminder of USB, LPT and operating system requirements.  

9 A dialog box then opens allowing you to choose where to install Geoplot. The default installation directory 
is “c:\gp300”. It is advisable to choose the default directory so that uninstall works correctly should you 
choose to remove Geoplot in the future, however you are free to choose another drive or directory but you 
must install Geoplot in a directory, not a root directory. Since Geoplot is a 16 bit application you must not 
use more than eight characters for directory or file names. 

14 The next screen allows you to choose the folder name that appears on the Program menu. The default is 
“Geoplot 3.00” and it also shows a list of existing folder names - if you do not use the default make sure 
you do not use an existing name. 

15 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

16 When you press “Next”, the installation will go ahead, with a progress report being made. 

17 The final screen will inform you when code installation is complete. 

Driver Installation 
• USB Dongles 

     INSTALL USB INF FILE BEFORE PLUGGING IN DONGLE 

It is very important that you install the USB INF file before plugging in the USB dongle 
for the first time. This is so Plug&Play can properly locate the USB driver. 

 

Windows 98, ME, 2000, XP. Before you plug in the dongle for the first time go to the Program Menu, select the 
Geoplot folder and click on the program inf_inst. After this has run and the file IWUSB.INF is successfully 
installed, figure 2-1, click OK and plug the dongle into a USB port. The Plug&Play manager will appear, 
‘Found New Hardware’, and after a short period the Matrix USB driver will be installed. If the Found New 
Hardware Wizard appears, figure 2-2, then follow the Wizard instructions to install USB drivers, selecting to 
install automatically. When this is complete you may run Geoplot – see next section. If there is an error 
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installing the driver then you should go to the Start menu, Settings, Control Panel, System and look in the 
Hardware list of ‘Device Manager’ for the USB dongle, click on Properties and update the driver  from there.  

 
Figure 2-1.  Successful USB INF file installation. 

           

 
Figure 2-2.  Found New Hardware Wizard in Windows XP. 

 

• LPT Dongles 

Windows 3.1, 95, 98, ME. The LPT driver will already be installed in the \Windows\system directory. You may 
run Geoplot after code installation – see next section 

Windows NT4, 2000, XP. Before running Geoplot for the first time, go to the Program Menu, select the 
Geoplot folder and click on the program drv_inst. The Matrix LPT Driver program dialog box will appear, 
figure 2-3. Press Continue to install the driver. If you are instructed to reboot your computer to complete 
installation of the drivers please do so. When this is complete you may run Geoplot – see next section. 
 

       
Figure 2-3.  LPT driver installation for Windows NT4, 2000 and XP. 

Running Geoplot 
Before you run Geoplot for the first time it is very important that you check your Regional Settings to ensure 
that the Decimal Symbol in the Number Tab is a decimal point and not a comma, otherwise you can encounter 
problems using Geoplot. You can access the Regional Settings by clicking on the Windows Start button, select 
Control Panel from the menu and then Regional Settings. 



     Installation      2-7

    Regional Settings 

It is very important that you set your Regional Settings so that the Decimal Symbol in 
the Number Tab is a decimal point and not a comma otherwise you can encounter 
problems using Geoplot. You can access the Regional Settings by clicking on the 
Windows Start button, select Control Panel from the menu and then Regional Settings. 

 

 

If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the icon GP300mx to run Geoplot. If you are using Windows 95, 98, ME, NT4, 2000 or XP then, select 
“Geoplot 3.00” from the program menu, and then click on GP300mx in the sub-menu. Geoplot will now start.  

A splash screen will appear for a few seconds to be followed by the main Geoplot screen. You can run multiple 
instances of Geoplot at the same time for data comparison. Should your dongle not be present, or any printer 
connected is off-line then an error message will be displayed - following the advice should correct the problem.  

    IMPORTANT 

When you use Geoplot for the first time you should examine the Options Menu and 
configure the Graphics, FilePaths and Publish Options to your requirements and save 
these – the Tutorial in Chapter 3 shows you how to do this. Even if you do not change 
anything and accept the default options you should still save these. The FilePath 
entries will need changing if you install Geoplot on a drive other than c: otherwise 
Geoplot will not be able to locate the sample data provided. You should also have 
installed at least one printer in your Windows environment before using Geoplot, 
otherwise you will get a “Printer Error” if you try to access any functions that are 
directly or indirectly associated with printing. If side toolbars overlap the top menu bar 
their vertical position can be adjusted in Options, Environment, General tab. 

 

Problems running Geoplot 
If you experience problems after the splash screen is shown and cannot proceed as far as the main Geoplot 
screen, first of all make sure Geoplot is the only program running and then try to start Geoplot again. If that does 
not resolve the problem then, for an LPT dongle, it is likely that a device driver or diagnostic has been loaded by 
Windows that is preventing access to the parallel port - examples are drivers for laser printers, parallel port 
scanners, parallel port sound devices, parallel port CDROM or ZIP drives.  In order to get Geoplot running it is 
neccessary to identify and disable the driver or diagnostic. See Chapter 6, Trouble-Shooting, for further advice. 

Uninstalling Geoplot 
To uninstall the main Geoplot application you should run the Uninstall program which is supplied with Geoplot 
– do not simply delete files. If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to 
open it up, and then double click on the Uninstall icon. If you are using Windows 95, 98, ME, NT4, 2000 or 
XP then, select “Geoplot 3.0” from the program menu, and then Uninstall. This will remove all the installed 
Geoplot files, directories, groups and program menu entries, though it will not remove the [GP300] entry in 
WIN.INI. You will also find that the file MRUFILES.INI is not removed by the uninstall program and this 
should be deleted manually – it is typically found in the file path: C:\GP300\GP300\OPTIONS\MRUFILES.INI. 
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Software Protection Lock 
Introduction 
Geoplot is protected using a software lock (authorisation) that must be transferred to your hard disk, along with 
the Geoplot code. If the authorisation is not present on the hard-disk Geoplot will not run. Installation of 
Geoplot is done in two separate stages: installation of the Geoplot code (see section entitled “Code Installation”) 
and then transfer of the authorisation from floppy disk to the hard disk of your computer (see section entitled 
“Authorisation Transfer From Flopy Disk to Computer”). You can install Geoplot on as many computers as you 
like, but only the computer that has the authorisation on its hard disk will run Geoplot. You can transfer the the 
authorisation from one computer to another using the floppy disk and a special transfer program called 
Authmanw - see the section entitled “Authorisation Transfer from Computer to Disk” for details. There is no 
need to uninstall Geoplot each time you wish to use it on a different computer, instead just transfer the 
authorisation. Please be sure to follow the instructions below for a successful installation and transfer of the 
authorisation – if you try to guess how to transfer the authorisation you will probably run into difficulties. Never 
attempt to move or copy the authorisation file using standard Windows means – you should only use Authmanw 
to move the authorisation. Though it is not usually necessary, you may wish, in mission critical situations, to 
transfer the authorisation to and from the floppy disk whilst in Safe Mode.  

Should you ever decide to install a new operating system or reformat the hard-disk, remember first to transfer 
the software authorisation safely back to the floppy disk so it is not lost. You are strongly advised to make a 
prominent reminder of this for future reference. 

 

     HARD-DISK REFORMAT OR NEW O/S INSTALLATION 

Before reformatting a hard disk or installing a new operating system you must transfer 
the authorisation back to the floppy disk. If you do not the authorisation will be lost and 
you will no longer be able to run Geoplot.  

Disable Norton Utilities Speed Disk  
Norton Utilities disk fragmenter program, Speed Disk, can corrupt the Geoplot software lock authorisation. This 
program may be installed by default as part of the Utilities package and its default configuration (later versions) 
allows movement of system files, which will include the Geoplot authorisation. However, if a Geoplot 
authorisation is moved by any utility other than Authmanw it may become corrupted and Geoplot will no longer 
run.  

 

   DISABLE NORTON UTILITIES SPEED DISK 

Before installing Geoplot and transfering the authorisation it is vital that you disable 
movement of system files by Speed Disk otherwise the authorisation may become 
corrupted. 

 

Before installing Geoplot and transfering the authorisation you should disable movement of system files by 
SpeedDisk by selecting Properties Option, Customise, Unmovable tab, and ensuring there is a tick alongside 
System. You could also, if you wish, name specific files of the type *.ekb as unmovable as well. You may wish 
to disable Speed Disk permanently to avoid future problems if it tries to move the authorisation. In general, 
avoid using any disk defragmention utilities that can move system files.  
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Disk Defragmentation in Windows 2000 and XP  
The standard defragmentation utilities supplied with Windows 3.1, 3.11, 95, 98, ME and NT4 do not usually 
cause any problems with the authorisation. Under some circumstances the defragmentation utilities supplied 
with Windows 2000 and XP can corrupt older Geoplot software lock authorisations (those supplied before May 
2003). However this seems to be a very rare problem and does not affect authorisations issued after May 2003. 
To be safe, and where possible, you should not attempt to defragment in 2000 and XP if you have an older 
authorisation. Should you experience problems please refer to Chapter 6, Trouble-shooting for further advice.  

Geoplot Media 
Geoplot 3.0 is supplied as either: (a) CD with Geoplot installation code and a single floppy disk with software 
authorisation, or as (b) three floppy disks where the Geoplot installation code is spread across the three disks and 
the software authorisation also resides on disk 3. The installation code comprises compressed executable files, 
data files and configuration files which must be installed using the supplied installation program. The CD also 
contains backup copies of  Geoplot system files, default options files, palettes, demo data etc in the RestoreFiles 
directory. 

Making a Copy of the Geoplot Installation Code  -  CD Version 
You can make a copy of the CD as a backup. WARNING - it is not possible to make a back-up copy of the floppy 
disk since this contains an uncopiable software authorisation file – if you try to do so you may damage or 
destroy the authorisation. Do not write-protect the floppy disk or the authorisation may be corrupted. 

  

     DO NOT COPY OR WRITE-PROTECT THE FLOPPY DISK 

NEVER attempt to make a copy of the floppy disk. If you do so you may corrupt the 
disk and authorisation. NEVER set the write-protection tab on the floppy disk. If you do 
so, and attempt to transfer the authorisation to, or from the disk, you may corrupt the 
disk and the authorisation. 

Making a Copy of the Geoplot Installation Code  -  Three Floppy Disk Version 
You can make working copies of installation disks 1 and 2 before installation using Window copy facilities. Use 
these copies for installation and store the original disks safely away. WARNING - it is not possible to make a 
direct copy of disk 3 using Windows copy facilities since this contains an uncopiable software authorisation file 
– if you try to do so you may damage or destroy the authorisation. However, it is possible to make a working 
installation copy on a third disk of the Geoplot files “_setup.3” and “Disk3.id” that appear on disk 3. These files 
are nothing to do with the software authorisation and are only associated with Geoplot installation. Do not write-
protect disk 3 or the authorisation may be corrupted. 

  DO NOT COPY OR WRITE-PROTECT DISK 3 

NEVER attempt to make a copy of disk 3. If you do so you may corrupt the disk and  
authorisation. NEVER set the write-protection tab on disk 3. If you do so, and attempt 
to transfer the authorisation to, or from disk 3, you may corrupt the disk and the 
authorisation. 

Preparing to Install Geoplot 
Geoplot 3.0, protected with a software lock, can be installed into Windows 3.1, 3.11, 95, 98, ME, NT4, 2000 
and XP. The computer may be a standalone PC or connected to a network. You must have Administration Rights 
if you wish to install Geoplot on NT4, 2000 or XP. 
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Geoplot 3.0 can co-exist with Geoplot 2.0 for DOS and can access any data created by the DOS version. The 
installation can also co-exist with most earlier beta versions, allowing these to be still used if required. The only 
exception is “Version 3.00, beta install” which must be uninstalled prior to installing this final version. The 
installation program creates required directories, copying files from the disks into those directories. Required 
DLL and .VBX files are copied into Geoplot’s own directory, not into your Windows system directory, thus 
avoiding clashes with existing DLL’s and VBX’s.  

No direct alterations are made to Windows registries, though changes are made to WIN.INI, with a [GP300] 
entry being added. Windows itself will make updates to the registry concerning Geoplot. 

The installation program generates sample data in a “geoplot” directory on the drive where Windows is 
installed. Shade plot palettes are also generated in a “palette” directory on the drive where Windows is installed.  

Once Geoplot is installed, the software authorisation must be transferred from the authorisation disk to the hard 
disk to enable the software to run.  

Code Installation - CD Version 
1 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

2 It is advisable, though not usually necessary, to disable any virus checkers running in the background – you 
will usually have to reboot the computer after disabling the virus checker. Close all other programs. 

3 Make sure you have installed at least one printer driver on the system. 

4 If you have previously installed a beta version of Geoplot called “Version 3.00, beta install” then you must 
uninstall this first before proceeding. See the section below for general uninstallation details. 

5 Geoplot is provided on a CD containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk.  

6 Insert the CD in the CD-ROM slot. If you are using Windows 3.1 or 3.11, then whilst in Program Manager, 
select Run from the File menu and type d:\setupex.exe (where d is the name of the CD-ROM drive) and 
press Enter. If you are using Windows 95, 98, ME, NT4, 2000 or XP the disk should automatically begin 
the installation when you insert the CD. If it does not click on the Start button on the Task Bar, select Run, 
and either Browse to d:\setupex.exe or type d:\setupex.exe (where d is the name of the CD-ROM drive) 
and press Return or click OK.  

7 Follow the instructions given on the screen. After an introductory screen an information screen appears to 
remind you of, amongst other things, how to transfer the software authorisation from the floppy disk to the 
hard disk.  

8 This is followed by a dialog box allowing you to choose where to install Geoplot. The default installation 
directory is “c:\gp300” though you are free to choose another drive or directory; however you must install 
Geoplot in a directory, not a root directory. It is advisable to choose the default directory so that uninstall 
works correctly should you choose to remove Geoplot later on.  

9 The next screen allows you to choose the folder name that appears on the Program menu (95, 98, ME, NT4, 
2000 and XP) or the group name (3.1, 3.11). The default is “Geoplot 3.00” and it also shows a list of existing 
folder names - if you do not use the default make sure you do not use an existing name. 

10 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

11 When you press “Next”, the installation will go ahead, with a progress report being made. 

12 The final screen will inform you when installation is complete. 

13 Transfer the software authorisation as described below. 

Code Installation - Three Floppy Disk Version 
1 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

2 It is advisable, though not usually necessary, to disable any virus checkers running in the background – you 
will usually have to reboot the computer after disabling the virus checker.  

3 Make sure you have installed at least one printer driver on the system. 
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4 If  you have previously installed a beta version of Geoplot called “Version 3.00, beta install” then you must 
uninstall this first before proceeding. See the section below for general uninstallation details. 

5 Geoplot is provided on three disks containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk. Make sure disk 3 is not write-
protected. 

6 Insert Disk 1. If you are using Windows 3.1 or 3.11, then whilst in Program Manager, select Run from the 
File menu and type a:\setup and press Enter. If you are using Windows 95, 98, ME, NT4, 2000 or XP, click 
on the Start button on the Task Bar, select Run, type a:\setup and press Return or click OK.  

7 Follow the instructions given on the screen. After an introductory screen an information screen appears to 
remind you of, amongst other things, how to transfer the software authorisation from disk 3 to the hard-disk.  

8 This is followed by a dialog box allowing you to choose where to install Geoplot. The default installation 
directory is “c:\gp300” though you are free to choose another drive or directory; however you must install 
Geoplot in a directory, not a root directory.  It is advisable to choose the default directory so that uninstall 
works correctly should you choose to remove Geoplot later on.  

9 The next screen allows you to choose the folder name that appears on the Program menu (95, 98, ME, NT4, 
2000 and XP) or the group name (3.1, 3.11). The default is “Geoplot 3.00” and it also shows a list of existing 
folder names - if you do not use the default make sure you do not use an existing name. 

10 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

11 When you press “Next”, the installation will go ahead, with a progress report being made and instructions 
when to insert the second and third floppy disk. 

12 The final screen will inform you when installation is complete. Leave disk 3 in the floppy disk drive. 

13 Transfer the software authorisation as described below. 

Authorisation Transfer From The Authorisation Floppy Disk to Computer 
If Geoplot is supplied on a CD the software authorisation will be on the accompanying floppy disk. If Geoplot is 
supplied on three floppy disks the software authorisation will be supplied on disk 3.  

1 Make sure all other programs are closed. With the authorisation disk in the disk drive, go to Windows 
Program Menu, or All Programs in XP, select the Geoplot folder and run the program Authmanw.  

2 Select Install from the main dialog box. 

3 In the Authorisation Name dialog box enter the following information, depending on the version of Geoplot 
you have:  

Single user :     Authorisation Name = gp300 

  Single user, 60 day trial :   Authorisation Name = gp300d 

  Network, 5 user :    Authorisation Name = gp300n5 

  Network, 10 user :    Authorisation Name = gp300n10 

  Educational Network, 25 user :  Authorisation Name = gp300e25 

  Educational Network, 25 user, 60 day trial : Authorisation Name = gp300ed 

 Make sure you enter the number “0” as part of the gp300 sequence, not the letter “o”. Go to step 4 if you are 
not using a foreign language keyboard or Windows installation. If you are using a foreign language 
keyboard or Windows installation you may find the Authorisation Name does not appear as above. If this is 
the case, then either change the Regional Settings in Control Panel so you can type the Name in exactly as it 
appears above, or enter the Name as ASCII characters. To do this, you must be using the numeric keypad – if 
you are using a laptop, set Numeric Lock to On and use the sequence of numbers above the keys : M, J, K, 
L, U, I, O, 7, 8, and 9. To enter an ASCII character press and hold down the Alt key to left hand side of the 
space bar whilst you enter the number representation of the ASCII character then release the Alt key to see 
the character appear. For example in ASCII g=103, p=112, 3=51, 0=48, d=100, e=101, n=110, 1=49. 
Remember to turn off Numeric lock when you have finished. 

4 Ensure the "Transfer Authorisation From" drive is set to the floppy disk drive (usually a:) and finally ensure 
the "Transfer Authorisation To" drive is set to the hard-disk installation directory which is normally 
c:\gp300, though change the drive if installing to a different hard-drive. Leave other settings at their default 
values – do not check the Force box. Click OK to transfer the authorisation to the hard disk. 
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5 Transfer is complete so you can remove the floppy disk. Store the disk in a safe place since you will need 
this to transfer the authorisation to another computer. See below for instructions on how to transfer the 
authorisation back to the disk. We strongly suggest that you insure the software lock system against loss, 
theft etc for the full cost of a new Geoplot. 

If you cannot transfer the authorisation try disabling virus checkers or any other software that checks the floppy 
disk drive. Installation monitor programs such as Cleansweep should not usually cause any problems. Note that 
you can move the authorisation using an LS120 drive as well as a standard floppy disk drive unless you are 
using NT4 in which case this may not be possible.  

Loss of Authorisation or Authorisation Transfer Problems 
If you experience problems transfering the authorisation or appear to have lost the authorisation even though 
you get a “successful transfer” message please refer to Chapter 6, Trouble-Shooting for further advice.   

Running Geoplot 

    Regional Settings 

It is very important that you set your Regional Settings so that the Decimal Symbol in 
the Number Tab is a decimal point and not a comma otherwise you can encounter 
problems using Geoplot. You can access the Regional settings by clicking on the 
Windows Start button, select Control Panel from the menu and then Regional Settings. 

 

 

If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the Geoplot icon to run Geoplot. If you are using Windows 95, 98, ME, NT4, 2000 or XP then, select 
“Geoplot 3.00” from the program menu, and then Geoplot from the sub-menu. Geoplot should now start. 
However, should you not have transferred the software authorisation you will get an error message reminding 
you to run Authmanw first.  

If  your copy of Geoplot is for a single user then a splash screen will appear for a few seconds to be followed by 
the main Geoplot screen. If your copy of Geoplot allows for more than one user (network), then a splash screen 
will appear and you will be prompted to enter a Geoplot user number, which can be between 1 and the 
maximum number of users. After entering a user number, click OK to continue and the main Geoplot screen will 
appear after a few seconds. If another user has already logged into Geoplot using the number you chose then you 
will be prompted to enter another, different, number. Logging on as different users allows individual users to 
have different Options preferences – see Appendix B for further information on Options and networks. 

If your copy of Geoplot is for a single user and you are on a network, then you may access Geoplot from any 
terminal. However, you may only have one copy of Geoplot running at any one time. If your copy of Geoplot is 
for more than one user on a network then you may run more than one copy of Geoplot simultaneously, up to the 
authorisation limit. 

    IMPORTANT 

When you use Geoplot for the first time you should examine the Options Menu and 
configure the Graphics, FilePaths and Publish Options to your requirements and save 
these – the Tutorial in Chapter 3 shows you how to do this. Even if you do not change 
anything and accept the default options you should still save these. The FilePath 
entries will need changing if you install Geoplot on a drive other than c: otherwise 
Geoplot will not be able to locate the sample data provided. You should also have 
installed at least one printer in your Windows environment before using Geoplot, 
otherwise you will get a “Printer Error” if you try to access any functions that are 
directly or indirectly associated with printing. 
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Authorisation Transfer From Computer to the Authorisation Floppy Disk 
You may install Geoplot on as many computers as you wish. However, only the computer that has had the 
software authorisation transferred to its hard disk will run Geoplot. You must run Authmanw and use the 
authorisation disk to transfer the authorisation from one computer to another. There is no need to uninstall 
Geoplot each time. To transfer the authoristion back to the floppy disk follow the procedure below.  

1 With the authorisation disk in the disk drive, go to Windows Program Menu, or All Programs in XP, select 
the Geoplot folder and run the program Authmanw.  

2 Select Remove from the main dialog box. 

3 In the Authorisation Name dialog box enter the following information, depending on the version of Geoplot 
you have :  

Single user :     Authorisation Name = gp300 

  Single user, 60 day trial :   Authorisation Name = gp300d 

  Network, 5 user :    Authorisation Name = gp300n5 

  Network, 10 user :    Authorisation Name = gp300n10 

  Educational Network, 25 user :  Authorisation Name = gp300e25 

  Educational Network, 25 user, 60 day trial : Authorisation Name = gp300ed 

Make sure you enter the number “0” as part of the gp300 sequence, not the letter “o”. Go to step 4 if you are 
not using a foreign language keyboard or Windows installation. If you are using a foreign language 
keyboard or Windows installation you may find the Authorisation Name does not appear as above. If this is 
the case, then either change the Regional Settings in Control Panel so you can type the Name in exactly as it 
appears above, or enter the Name as ASCII characters. To do this, you must be using the numeric keypad – if 
you are using a laptop, set Numeric Lock to On and use the sequence of numbers above the keys : M, J, K, 
L, U, I, O, 7, 8, and 9. To enter an ASCII character press and hold down the Alt key to left hand side of the 
space bar whilst you enter the number representation of the ASCII character then release the Alt key to see 
the character appear. For example in ASCII g=103, p=112, 3=51, 0=48, d=100, e=101, n=110, 1=49. 
Remember to turn off Numeric lock when you have finished. 

4 Ensure the "Transfer Authorisation From" drive is set to hard-disk directory which is normally c:\gp300, 
though change the drive letter if you installed to a different hard-drive and finally ensure the "Transfer 
Authorisation To" drive is set to the floppy disk drive. Leave Options set to Smart Remove – do not try Code 
Remove or Manual Code Remove. Click OK to transfer the authorisation to the floppy disk. 

5 Transfer is complete so you can remove the disk. Follow the earlier procedure to transfer the authorisation to 
another computer.  

Uninstalling Geoplot 
Before uninstalling Geoplot, first run Authmanw, as described in the previous section, to transfer the 
authorisation back on to the authorisation disk - make sure the authorisation disk is NOT write protected before 
doing this. Remember, there is no need to uninstall Geoplot if you just wish to transfer the authorisation from 
one computer to another. 

To uninstall the main Geoplot application you can run the Uninstall program which is supplied with Geoplot. If 
you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the Uninstall icon. If you are using Windows 95, 98, ME, NT4, 2000 or XP then, select “Geoplot 3.0” 
from the program menu, and then Uninstall. This will remove all the installed Geoplot files, directories, groups 
and program menu entries, though it will not remove the [GP300] entry in WIN.INI. You will also find that the 
file MRUFILES.INI is not removed by the uninstall program and this should be deleted manually – it is 
typically found in the file path: C:\GP300\GP300\OPTIONS\MRUFILES.INI. For network installations this file 
will be found one subdirectory deeper – see Appendix B for details. 
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Hardware Protection Lock (Az-Tech version) 
Preparing to Install Geoplot 
Geoplot 3.0, protected by a hardware lock, can be installed into Windows 3.1, 3.11, 95, 98, ME and NT4. If you 
wish to run Geoplot on Windows 2000, XP or higher then you will need to download and apply new drivers 
from the Az-Tech website – see below. However, these new drivers do not work on all 2000 and XP systems – 
should they not work on your system you will need to swop your dongle for a software authorisation version – 
note that if you do this you will no longer be able to run the DOS version.  

You will need to plug your Hardware Protection Lock into the parallel port. If you are connected to a network 
you will have to disable that connection in order for the dongle to operate. You must have Administration Rights 
if you wish to install Geoplot on NT4, 2000 or XP. 

Geoplot 3.0 can co-exist with Geoplot 2.0 for DOS and can access any data created by the DOS version. The 
installation can also co-exist with most earlier beta versions, allowing these to be still used if required. The only 
exception is “Version 3.00, beta install” which must be uninstalled prior to installing this final version. The 
installation program creates required directories, copying files from the disks into those directories. Required 
DLL and .VBX files are copied into Geoplot’s own directory, not into your Windows system directory, thus 
avoiding clashes with existing DLL’s and VBX’s.  

No direct alterations are made to the Windows 3.1, 95, 98 or ME registries, though changes are made to 
WIN.INI, with a [GP300] entry being added. Windows itself will make updates to the registry concerning 
Geoplot. 

In the case of NT4, changes do need to be made by you to the registry, SYSTEM32 directory and the 
SYSTEM32\DRIVERS directory. The Geoplot installation creates a program called NTSETUP.EXE in the 
Geoplot folder that you can run in order to make these registry changes and also to uninstall them. File 
DOWNTVDD.DLL is added to the C:\WINNT\SYSTEM32 directory, and file DS1410D.SYS is added to the 
C:\WINNT\SYSTEM32\DRIVERS directory. You will need to be a System Administrater yourself or will need 
to contact your IT department in order to run program NTSETUP.EXE successfully. If you are installing on 
NT4 then you will need Service Pack 2 as a minimum. 

In the case of 2000 and XP, once you have installed Geoplot you should go to the Az-Tech website download 
area: <http://www.az-tech.com/dnl.htm> and download Azsetup.exe and Azsetup.txt. Azsetup.txt gives 
instructions on installing the new driver. You will need to be a System Administrater yourself or will need to 
contact your IT department in order to run program Azsetup.exe successfully. These files are also included on 
the installation CD but if they do not work correctly,  you should check the Az-Tech website for later versions. 

The Geoplot installation program generates sample data in a “geoplot” directory on the drive where Windows is 
installed. Shade plot palettes are also generated in a “palette” directory on the drive where Windows is installed. 

Geoplot Media 
Geoplot 3.0 is supplied on either a single CD or on three floppy disks. The installation code comprises 
compressed executable files, data files and configuration files which must be installed using the supplied 
installation program. It is advisable to make working copes of the installation media before installation. Use 
these copies for installation and store the original disks safely away. The CD also contains backup copies of  
Geoplot system files, default options files, palettes, demo data etc in the RestoreFiles directory. 

Code Installation - CD Version 
1 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

2 Make sure you have installed at least one printer driver on the system. Close all other programs. 

3 If  you have previously installed a beta version of Geoplot called “Version 3.00, beta install” then you must 
uninstall this first before proceeding. See the section below for general uninstallation details. 

4 Geoplot is provided on a CD containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk. 

5 Insert the CD in the CD-ROM slot. If you are using Windows 3.1 or 3.11, then whilst in Program Manager, 
select Run from the File menu and type d:\setupex.exe (where d is the name of the CD-ROM drive) and 
press Enter. If you are using Windows 95, 98, ME, NT4, 2000 or XP the disk should automatically begin the 
installation when you insert the CD. If it does not click on the Start button on the Task Bar, select Run, and 
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either Browse to d:\setupex.exe or type d:\setupex.exe (where d is the name of the CD-ROM drive) and 
press Return or click OK.  

6 Follow the instructions given on the screen. After an introductory screen an information screen appears to 
remind you of, amongst other things, the NT4 requirements.  

7 This is followed by a dialog box allowing you to choose where to install Geoplot. The default installation 
directory is “c:\gp300” though you are free to choose another drive or directory; however you must install 
Geoplot in a directory, not a root directory. It is advisable to choose the default directory so that uninstall 
works correctly should you choose to remove Geoplot later on.  

8 The next screen allows you to choose the folder name that appears on the Program menu (95, 98, ME and 
NT4) or the group name (3.1, 3.11). The default is “Geoplot 3.00” and it also shows a list of existing folder 
names - if you do not use the default make sure you do not use an existing name. 

9 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

10 When you press “Next”, the installation will go ahead, with a progress report being made. 

11 The final screen will inform you when installation is complete. 

Code Installation – Three Floppy Disk Version 
1 Make sure you have backed up your system before installing Geoplot, especially WIN.INI and the registry, 

and that you have standard emergency repair disks to hand. 

2 Make sure you have installed at least one printer driver on the system. Close all other programs. 

3 If  you have previously installed a beta version of Geoplot called “Version 3.00, beta install” then you must 
uninstall this first before proceeding. See the section below for general uninstallation details. 

4 Geoplot is provided on three disks containing compressed files. You must install Geoplot following the 
instructions below - you cannot simply copy files onto your hard disk. 

5 Insert Disk 1. If you are using Windows 3.1 or 3.11, then whilst in Program Manager, select Run from the 
File menu and type a:\setup and press Enter. If you are using Windows 95, 98, ME or NT4 click on the Start 
button on the Task Bar, select Run, type a:\setup and press Return or click OK.  

6 Follow the instructions given on the screen. After an introductory screen an information screen appears to 
remind you of, amongst other things, the NT4 requirements.  

7 This is followed by a dialog box allowing you to choose where to install Geoplot. The default installation 
directory is “c:\gp300” though you are free to choose another drive or directory. It is advisable to choose the 
default directory so that uninstall works correctly should you choose to remove Geoplot later on.  

8 The next screen allows you to choose the folder name that appears on the Program menu (95, 98, ME and 
NT4) or the group name (3.1, 3.11). The default is “Geoplot 3.00” and it also shows a list of existing folder 
names - if you do not use the default make sure you do not use an existing name. 

9 The installation program then gives you a final summary of the installation you have specified. You can still 
change your mind at this stage and go back and alter installation details. 

10 When you press “Next”, the installation will go ahead, with a progress report being made and instructions 
when to insert the final floppy disk. 

12 The final screen will inform you when installation is complete. 

Running Geoplot 
If you are installing on NT4 then the first thing you should do is run the program NTSetup to install the required 
drivers.  This may be done by selecting “Geoplot 3.00” from the program menu, and then NTSetup from the 
sub-menu. Click on Install Drivers. Once the drivers have been installed you must reboot NT4 to activate them. 
If you are installing on 2000 or XP then the first thing you should do is to download new drivers from the Az-
Tech website as instructed earlier. Once the drivers have been installed you will generally need to reboot to 
activate them. 
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    Regional Settings 

It is very important that you set your Regional Settings so that the Decimal Symbol in 
the Number Tab is a decimal point and not a comma otherwise you can encounter 
problems using Geoplot. You can access the Regional settings by clicking on the 
Windows Start button, select Control Panel from the menu and then Regional Settings. 

 

 

If you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the Geoplot icon to run Geoplot. If you are using Windows 95, 98, ME or NT4 then, select “Geoplot 
3.00” from the program menu, and then Geoplot from the sub-menu.  Geoplot will now start.  

A splash screen will appear for a few seconds to be followed by the main Geoplot screen. Should your dongle 
not be present, or any printer connected be off-line then an error message will be displayed - following the 
advice should correct the problem. 

    IMPORTANT 

When you use Geoplot for the first time you should examine the Options Menu and 
configure the Graphics, FilePaths and Publish Options to your requirements and save 
these – the Tutorial in Chapter 3 shows you how to do this. Even if you do not change 
anything and accept the default options you should still save these. The FilePath 
entries will need changing if you install Geoplot on a drive other than c: otherwise 
Geoplot will not be able to locate the sample data provided. You should also have 
installed at least one printer in your Windows environment before using Geoplot, 
otherwise you will get a “Printer Error” if you try to access any functions that are 
directly or indirectly associated with printing. 

 

Problems running Geoplot 
If you experience problems after the splash screen is shown and cannot proceed as far as the main Geoplot 
screen, first of all make sure Geoplot is the only program running and then try to start Geoplot again (remember 
that you should not be logged onto a network). If that does not resolve the problem then it is likely that a device 
driver or diagnostic has been loaded by Windows that is preventing access to the parallel port - examples are 
drivers for laser printers, parallel port scanners, parallel port sound devices, parallel port CDROM or ZIP drives.  
In order to get Geoplot running it is neccessary to identify and disable the driver or diagnostic. See Chapter 6, 
Trouble-Shooting, for further advice. 

Uninstalling Geoplot 
If you have installed Geoplot on NT4 then the first thing you must do is remove the special NT4 installation 
registry entries before running the general Geoplot Uninstall program. You can do this by running the NTSetup 
program once again and click on Uninstall Drivers. Once you have run this program, reboot the PC and then 
delete the two files DS1410D.SYS and DOWNTVDD.DLL files manually - NTSetup cannot remove these. 

To uninstall the main Geoplot application you can run the Uninstall program which is supplied with Geoplot. If 
you are using Windows 3.1 or 3.11, double click on the “Geoplot 3.00” group to open it up, and then double 
click on the Uninstall icon. If you are using Windows 95, 98, ME, NT4, 2000 or XP then, select “Geoplot 3.0” 
from the program menu, and then Uninstall. This will remove all the installed Geoplot files, directories, groups 
and program menu entries, though it will not remove the [GP300] entry in WIN.INI. You will also find that the 
file MRUFILES.INI is not removed by the uninstall program and this should be deleted manually – it is 
typically found in the file path: C:\GP300\GP300\OPTIONS\MRUFILES.INI. 
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Multiple Installations 
It is possible to install multiple copies of Geoplot on one computer, where each installation is for a different 
hardware lock. To do this choose to install each instance of Geoplot not just in the default directory of c:\gp300 
but in differently named directories eg c:\gp300d1, c:\gp300d2 etc. When choosing the name that will appear on 
the Start menu include the dongle number eg “Geoplot 3.00 – dongle GPB99123”, “Geoplot 3.00 – dongle 
GPB99124” etc. When you start Geoplot select the program that matches the dongle plugged into the parallel 
port. 

Multi-User Network Installations 
The network must be a client-server network for multi-user operation – the network version will not run in 
multi-user mode on peer to peer systems, but only as a single copy. In principle you should follow the general 
instructions given earlier for single user installations. However, depending on your network configuration you 
may need to consider the following points.  

When installing Geoplot on a network you cannot use UNC addresses of the form \\NTSERVER. Instead you 
must use a conventional DOS drive letter and directory eg “G:\GP300”. 

You should install Geoplot and the authorisation on the main server. Typically this will be drive G: and you 
should install to the default directory GP300 (see Appendix B). The Geoplot executable and *.EVK 
authorisation (see Appendix B) must be in the same directory. Share this directory with any workgroups (local 
servers) for workstations. Set share permission for read, write and execute (the latter is required for the network 
authorisation to work correctly). Typically map the local drive on the workstations (for example C:) to the 
installation drive G:. 

For network operation, Geoplot creates subdirectories in the Options directory with names equivalent to the user 
number, up to the maximum number of users possible – for example G:\GP300\GP300\OPTIONS\1, 
G:\GP300\GP300\OPTIONS\2 etc, for user numbers 1 and 2, and up to G:\GP300\GP300\OPTIONS\25 for a 25 
user network version. Individual sets of *.ini files (see Appendix B) will be stored in each of these 
subdirectories, with each set unique to each user number. These files are present permanently. In addition a 
temporary file called loggedon.ini will be created each time a Geoplot user logs on and occurs only in the 
subdirectory relating to that user. It is used to ensure that two users cannot logon and use the same set of options. 
When a user exits Geoplot, the loggedon.ini file in his subdirectory only is killed, so that another user may 
subsequently log on afresh using that same number. 

At present the network installation will only create these individual Option files for you. You must additionally 
create individual Palette files in the subdirectories of individual users by copying files from the 
C:\GEOPLOT\PALETTE directory so that you have the following directory structure : 

G:\GP300\GP300\OPTIONS\1\PALETTE\*.PTT 

G:\GP300\GP300\OPTIONS\2\PALETTE\*.PTT and the same for 3, 4, 5 etc 

Other directories and contents that all users will need access to for Publishing will normally be automatically 
installed in the correct location and these are : 

G:\GP300\GP300\GPBITM 

G:\GP300\GP300\NORTH 

Optionally, but strongly recommended, users should also have access to the contents of the following directories 
to enable them to follow the tutorial and examples :  

G:\GEOPLOT\GRID 

G:\GEOPLOT\COMP 

G:\GEOPLOT\IMPDATA 

Once all the above files are copied, moved or remapped ensure that the Default File Paths specified in the 
Options menu for each user match the location where the above files are stored. Also set the file paths where 
users can store and retrieve other data. To enable each user to start Geoplot from their workstation create a 
desktop shortcut typically to : 

G:\GP300\GP300N5.EXE (or GP300N10 etc.) 

If the server system runs very slow and you wish to speed up Geoplot operation then you might wish to consider 
installing the authorisation on the main server (for example G:) and Geoplot on a local server or workstations 
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(for example C:). On a desktop shortcut make sure Start In is set to the address where the authorisation is 
installed, eg “G:\GP300”.  

If you are installing Geoplot on a Novell network which has a Microsoft Windows Client 3.10 in use either 
make sure all other clients are also version 3.10 or, if there is a mix of clients, upgrade the 3.10 version to 3.11 
or later, other wise you may encounter a “Authorisation not valid” error 4 message for that client. 

60 Day Trial Versions of Geoplot 
Trial versions of Geoplot are available that will expire 60 days after you transfer the authorisation from the 
floppy disk to the hard disk. These trial versions can be used with the sample data provided, by following the 
comprehensive tutorial in this manual. They can also be used with your own data using the extensive import 
facilities. 

 



 

Chapter 3  

TUTORIAL 

Introduction 
This chapter uses a tutorial to provide the user with a solid understanding of the way Geoplot is organised and used. 
Step by step manipulation of sample survey data introduces the user to many Geoplot 3.0 facilities. You should 
follow through the tutorial in detail, even if you have used the earlier DOS version 2.02. In the tutorial important 
concepts in Geoplot, such as how data is organised, are explained in separate information panels. Additional 
information may be found in Chapter 5. It is assumed that the user is familiar with typical Windows programs and 
techniques of using them. The tutorial is best made with screen set to 1024 x 768, 24 bit colour or higher, though 
smaller resolutions can also be used. 

Main Screen 
The opening screen consists of (a) standard menu at the top, (b) a horizontal toolbar just underneath which gives 
fast access to common menu items, (c) a process toolbar to the left, (d) a drawing toolbar to the right, (e) 
status bar at the bottom, (f) floating complete statistics and latest history forms.   

 

Figure 3-1.  Typical main screen at start-up. 
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The positions of the floating Latest History and Complete Statistics forms are remembered for future use so you can 
customise their position. If you are using a resolution better than VGA you may find the floating forms are better 
positioned nearer the bottom of the screen. To reposition them, drag each form to its new location. 

The toolbars and floating forms can be turned on and off using the View menu or buttons on the horizontal toolbar if 
it is visible. For example, to turn off the process toolbar, select Process Toolbar from the View menu (near the 
bottom). The toolbar will disappear and so will the tick on the View menu. Turn the process toolbar back on. The 
Latest History and Complete Statistics forms can also be turned on and off from the View menu. 

 A quicker way to turn the Latest History and Complete Statistics floating forms on and off is to click on 
the appropriate buttons (19th and 20th) on the horizontal toolbar. If you try this ensure the forms are left displayed 
afterwards. 

 Whenever the mouse moves over a toolbar button its function is reported at the left-hand side of the 
status bar. Try positioning the mouse over the 2nd button on the horizontal toolbar button for Open Grid or 
Composite Data and observe the report on the status bar.  

Help Menu 
There is no formal Help system as found on many Windows applications. In Geoplot the Help menu can be used to 
display several Help panels which discuss a variety of introductory topics. These are only summaries and reference 
should be made to the full paper manual for more complete information. Several Help panels can be displayed on 
screen at the same time. They may be positioned anywhere on the screen, resized or minimised according to how 
you want to reference to them. Key words are introduced in CAPITAL letters but thereafter are shown in lower 
case. The Basic Concepts on panels A-D give a broad introduction to the data structure behind Geoplot. Other 
panels give more detailed information on specific topics relating to the Geoplot environment. As an example, select 
Geoplot Flowchart from the Help menu. This Help panel summarises the typical steps you would take when dealing 
with data in Geoplot. If you are using a high screen resolution you might like to keep this Help panel handy (moved 
to the bottom left hand side or minimised) when working through the tutorial. The Basic Concepts are summarised 
on the enclosed Reference Card. 

Setting the Options 
The Options menu gives you extensive control over how Geoplot operates and allows you to select your preferred 
defaults for different views and forms. For example different default options can be chosen for:-  

• graphic plotting parameters and palette 
• screen colours 
• print scales 
• file paths 
• publish menu 
• drawing menu 
• preferred opening view      
• use of existing plotting parameters or default ones for graphics plot 
 

Select the Options Menu so we can check some of the essential settings that were made when Geoplot was installed. 
If these settings are not checked then you may encounter problems later on. Other settings will be discussed during 
the course of the Tutorial.  

Graphics Options – Palette Setting 
Select Graphics from the Options menu. The displayed Graphics Options form has six tabs : General, Grid and 
Gridding, Shade, Pattern, Trace and Dot-Density. Any changes you make will then become the default plotting 
parameters for your Geoplot program. If you wish to revert back to the options originally supplied with Geoplot 
then pressing the Reset to GP3 Defaults in the relevant tab will reset to the original Geoplot parameters for this tab.  

For the Tutorial accept the original  Geoplot defaults.  

Select the Shade tab and check the setting in the Default Shade Palette list box. It should be set to grey55.ptt (or 
GREY55.PTT depending on operating system) and if it is set to this then click Cancel. If it is not set to grey55.ptt, 
then highlight grey55.ptt and click OK. 
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Publish Options – Font Setting 
Select Publish from the Options menu. The displayed form shows various default settings for the Publish view. 
Check that there is a valid setting in Font Properties. The default font should typically be Arial, 12pt though it may 
be set to some other font, depending on the default printer driver on your system. If a valid font is displayed then 
click Cancel. If no setting is made then you should choose a font and font size and click OK. 

File Paths – Drive Setting 
Select File Paths from the Options menu. The displayed form shows the default file paths used by Geoplot - the 
drive letter is by default set to C. However, if you have installed Geoplot on a drive other than C then you must 
change these settings. For example, if you have installed Geoplot on drive D then change each of the File Path 
settings so that they start with D, not C and then click OK. If the drive settings matches the drive on which you 
installed Geoplot then just click Cancel. 

 

That concludes the essential Options settings. We suggest you do not change any other Option settings just yet, so 
that you can follow the tutorial. After the tutorial you may wish to return to the Options menu to customise Geoplot 
to your liking, especially the Graphics Options.   

We will now explore some of the data sets supplied with Geoplot. Before we do this you should familiarise yourself 
with the Geoplot 3 - Basic Concepts Reference Card so that you understand the terms we introduce in the tutorial. 

Opening Data Files 
 You can open a grid or composite data file by either selecting Open Grid / Composite… from the File 

menu or by using the Open Grid / Composite Data button on the horizontal toolbar. For the tutorial click on the 
Open Grid / Composite Data button (2nd horizontal toolbar button) to reveal the Open Dialog box, figure 3-2. 

 

 

Figure 3-2.  Open Grid or Composite Data dialog box. 

This form is very similar to a conventional Open Dialog box except that the File type can only be Composite or 
Grid, with Composite being the default setting. The default Directories matches the settings made in the File Paths 
options. Click on Grid in File Type and the Directories will change to c:\geoplot\grid, the default setting for grids. 
Select directory rgrv in the Directories list box and double click to reveal the list box on the left hand side which 
will show six files, 1.dat to 6.dat. Select 1.dat and click OK.  

The data will now be opened, with progress being shown briefly by a blue bar on the left hand side of the status bar 
and a graphics representation of the data will be shown, figure 3-3. The Complete Statistics and Latest History 
floating forms now display information relating to the grid data set. The name of the file and its file path are 
displayed at the top of the screen, along with the type of survey data - in this case Resistance data.  

Please note that you cannot open a Master Grid (or mesh) directly in Geoplot 3 as you could in earlier DOS 
versions. Details on how to create a composite appear later. 
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Master Grid or Mesh  

You cannot open a mesh of data directly in Geoplot 3 as you could in the earlier DOS versions. You 
can only create a composite from a mesh of grids for subsequent graphics or processing etc.  Note 
that the terms “Mesh” or “Mesh Template” used in the DOS version are now referred to as “Master 
Grid” in Geoplot 3, to comply with the ADS standard for the archiving of geophysical data. 

 

Different Views of the Data 
When you Open data it will be displayed as a graphics plot, which is the default action of Geoplot. There are four 
views you can have of opened data : graphics view, data view, history view and file details view. You can switch 
between the different views by using either the View menu or the function keys F5, F6, F7 or F8.  

You are at present  in the graphics view (F5), figure 3-3. 

Press F6 to show the data view. A table is shown of the numbers in the data set, with the X and Y coordinates 
shown at the top and left-hand side respectively. The data set measures 20 by 20 readings.  

Press F7 to show the history view. At the moment this view is blank since the data is in its raw form and has not 
been changed in any way. The entries always match the Latest History floating form, though the latter only has 
space to show the last four entries.  

Press F8 to show the file details view, see figure 3-4. This view gives information on the way the survey was 
performed, statistical information which matches the Complete Statistics floating form and a comments box.  

We can see from the file details that the sitename is rgrv - the same name as the directory in which the data is 
stored and that the grid is 1 - the same as the file name. The grid length (x direction) is 20m, grid width (y direction) 
is 20m, sample interval (x direction) is 1m and traverse interval (y direction) is 1m. Also on the left-hand side is 
survey type, units and the direction of the first traverse - from this the “north” direction on the graphics plot  is 
derived. On the right hand side of the file details view we see the full statistics which includes mean, standard 
deviation (SD), minimum, maximum, number of readings, number of dummy readings and the dummy value used 
in the data set (see information panel below). A histogram for the data set is also shown.  

 

Dummy Readings 

Dummy readings are used where an actual reading cannot be recorded. The default value set in 
Environment Options, Data tab is 2047.5 and any reading with this value is ignored by statistics, 
editing, processing and graphics. You can also set the dummy reading to be equal to the value 
stored with each data set (reported in statistics of the the file details view). 

 

Alternative Opening Views 
When you opened data earlier, it was displayed as a graphics plot, which is the default action of Geoplot. There are 
five alternative opening views possible : graphics view, data view, history view, file details view, and last view 
displayed. Look again at the Options menu, see Figure 3-10. If you select the Environment Options “Open” tab you 
can select the default opening view and whether the open view for graphics plots uses existing or default plotting 
parameters. For the tutorial accept the default opening view as Graphics. 

Dimensions 
The data view  shows that the grid data set measures 20 by 20 readings and the file details view that it measures 20 
metres by 20 metres. It is very important to understand the two alternative ways of dimensioning data in Geoplot 
which can be : (a) number of readings in the x or y direction or (b) dimension in metres in the x or y direction. This 
is discussed further in the information panel below. 
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Figure 3-3.  Typical graphics view – a shade plot using default plotting parameters. 

 

 

 

 

Figure 3-4.  Typical file details view of a 20m by 20m grid. 
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Dimensions – Metres or Number of Readings 

Geoplot uses two systems for specifying the size of a grid or composite data set : (a) length and 
width expressed in units of metres, and (b) X,Y coordinates expressed in units of number of 
readings.  

The first system allows you to relate the position and dimensions of an anomaly to its real life 
position on the ground. The second system makes it easier to select numbers within a grid or 
composite to view, present or process. Note that length and the X coordinate axis always align with 
the horizontal aspect of your computer screen. The width and Y coordinate axis always align with 
the vertical aspect of your computer screen. 

When data is input into Geoplot you are asked to specify the size of the data set in units of metres, 
that is : length, width, sample interval, and traverse interval. Once data is in Geoplot you then 
usually work with the X,Y coordinate system. In the coordinate system the reading in the top-left 
hand corner always has X,Y coordinates equal to 1,1, X is always positive going from left to right 
and Y is always positive going from top to bottom. You can convert from the metric to the coordinate 
system by dividing length by sample interval and dividing width by traverse interval. For example, if 
a grid has length 20m and a sample interval of 0.5m then there would be (20 / 0.5) = 40 readings 
distributed along the length or X direction. Similarily if a grid has a width of 10m and a traverse 
interval of 0.25m then there would be (10 / 0.25) = 40 readings distributed along the width or Y 
direction. 

 

Hardcopy 
The graphics, data, history and file details views can each be printed using the File menu. Before printing select a 
font. To do this select File Menu, Print Setup, and Font Properties from the dialog box. Select a font and Click OK 
twice to return to the main screen. Now select Print from the File menu to display a print dialog box. This box will 
be different for each view.  

In the file details view you should see a small dialog box which allows you to select a print-out of the history view 
at the same time as file details if you wish.  

In the graphics view the print dialog box allows you to choose whether to print: (a) the whole data set, (b) a specific 
block or (c) what you see on screen. You can also set the scale of the print-out.  

In the data view the print dialog box allows you to choose whether to print: (a) the whole data set or (b) a specific 
block. 

Whichever view you are in, you will then see the standard Windows Print dialog box which allows you to change 
printer Options etc. History, data and file details views can only be printed out in portrait view so ensure this 
orientation is set in printer Options. Press OK to start printing.  

Graphics View – Shade, Trace, Dot-Density and Pattern Plots 
Press F5 to return to the graphics view which we will now explore in more detail. There are four types of graphics 
plots available : shade, trace, dot-density and pattern. The default opening plot type is set in the Graphics Options. 
Although there is no formal contour plot there is a way of generating these using the processing facilities and shade 
plots in Geoplot – see Chapter 5 for more details.  

The graphic plot shown at present is known as a shade plot. This is the current default opening plot type set in the 
Graphics Option. The screen layout consists of the graphics plot centrally placed in the left-hand area. On the right-
hand side, in the graphics plot details, observe, looking from top to bottom, a triangular symbol showing the 
north direction, a vertical calibrated shade scalebar and its units, the name of the palette used for the shade 
scalebar, a dimensional scalebar, plot size, a histogram of the distribution of readings about the mean and 
finally a report of the plotting parameters used (you will not see the latter if using VGA resolution). 

You can change from one graphics plot type to another using the Graphics menu. Shade and trace plots also have 
their own special buttons on the horizontal toolbar for quick access to the plotting parameters dialog box.  
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Types of Graphic Plots 

In the graphics view there are four types of plot presentation provided : shade, trace, dot-density 
and pattern. Shade plots can have between 2 and 234 different shades of grey or colour. Trace 
plots represent data by a series of line graphs stacked vertically. The data may be viewed from all 
four sides, and the trace angles adjusted to give a 3D style view. Dot-density and pattern plots 
represent data values by the number of dots within a cell plotted either randomly or in a systematic 
way. Plotting parameters can be entered in standard, clip, compress or relief mode, with the default 
settings being defined in the Options Menu under Graphics Options. Relief plots (artificial sun) are 
particularly effective at removing background resistance variations and present an almost 
photographic style quality. 

  

 

 Click on the 10th horizontal toolbar button, Trace Plot. A dialog box similar to that shown in figure 3-5 
will appear. The dialog box allows you to : (a) set the plotting parameters, (b) determine whether a graphics plot is 
made of the whole of the data set or a smaller block, and (c) set the size of the graphic plot. The plotting parameters 
and size initially displayed when you first start Geoplot are the defaults set in Graphics Options. 

 

 

Figure 3-5. Typical dialog box for entering plotting parameters for trace plots. 

For now we will just accept the default settings so click on OK or press Return. The graphics screen will change to 
display a series of horizontal line graphs, stacked one above the other, to represent the data. The information in the 
graphics plot details panel has changed slightly from the shade view, with the palette being replaced by a vertical 
line that represents the vertical magnitude of a trace, though all the other types of information are still present. An 
example of a trace plot for another data set is shown in figure 3-11. 

Look at Dot-Density and Pattern plots using the Graphics menu, again accepting the default plotting parameters. 
Dot-density plots represent data values by the number of dots plotted randomly within a cell. Pattern plots represent 
data values  by the number of dots plotted in a systematic way within a cell. 

 

 Click on the 11th horizontal toolbar button, Shade Plot, to return to the previous shade plot and click 
OK to accept the default parameters. 
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Graphics View – Exploring Shade Plots 
We will now explore some of the graphics capabilities in more detail. For many operations you can use either 
buttons on the toolbars, the View or Graphics menu, shortcut keys or dialog boxes to change a graphics plot. We 
will explore the first three approaches initially and then compare these with the dialog boxes. Although the tutorial 
takes you through the graphics capabilities using a shade plot, the same approach can, in general, be applied to the 
other plot types as well. Exceptions are palette, which is only relevant to shade plots and gridding, which cannot be 
displayed in trace or pattern plots.  

Make sure you are in the graphics view by pressing F5 if necessary and display a shade plot of the data. 

Graphics Plot Details 

 The Display Graphics Plot Details button (18th button on the horizontal toolbar) will turn on and off 
display of the right-hand graphics panel. Click on the button and the graphic plot details information panel will now 
disappear and the graphics plot will move to the centre of the screen, thereby maximising the display area. Click on 
the button again to restore the information panel. You can also use Graphic Plot Details in the View menu to turn it 
on or off. 

Finding Data Values using the Mouse 
When Geoplot is in graphics view, the bottom status bar displays a panel to the right-hand side that contains two 
text boxes labelled X,Y and Data. Observe that the information in the panel changes as you move the mouse over 
the graphics plot. In the panel  X,Y shows both the coordinates and dimensionsional position of the mouse with 
respect to the graphics plot. Data shows the data value at that X,Y position. Figure 3-3 shows the data value reported 
when the mouse is over the top left-hand data point. The first pair of X,Y values, 0.5m,0.5m refer to the centre of 
the first reading position in the grid – in this case the centre of a 1m square. The second pair of X,Y values refer to 
the X,Y coordinates. The data value information in the graphics view can be invaluable when trying to understand 
your data set, and avoids having to switch to the data view. 

Zoom In to Centre, Zoom Out from Centre  

 Click on the 4th horizontal toolbar button, Zoom In to Centre. The plot will now increase in size.  Click 
on the 5th horizontal toolbar button, Zoom Out from Centre. The plot will now reduce back down in size. Note 
that the plot increases or decreases in size about its centre and that the dimensional scalebar reported on the right-
hand side changes accordingly. The current size is reported just under the dimensional scale bar. You can also press 
Ctrl-M and Ctrl-N or select Zoom In to Centre and Zoom Out from Centre on the View menu to achieve the same 
action. Try using these alternatives and change the size to be as large and as small as possible – you will hear a click 
or beep when you reach the limits. Return back to the size which shows 10m on the dimensional scale on the right-
hand side,  Size = x2. 

Invert Palette 

 Click on the 12th horizontal toolbar button, Invert Shade Palette. The graphics plot and the palette on 
the right-hand side both become a negative image of  the previous view. Click on the button to restore the previous 
palette view. You can also press Ctrl-I or select Invert Shade Palette from the Graphics menu to achieve the same 
action. Try using these alternatives. Note that palettes are not relevant to any other type of graphics plots except 
shade plots. Return back to a normal palette as shown in figure 3-3. 

Previous Shade Palette, Next Shade Palette 

 Click on the 13th horizontal toolbar button, Previous Shade Palette. The plot texture will now change 
slightly and the palette on the right-hand side will clearly have become more banded. The palette name on the right-
hand side will also have changed from grey55.ptt to grey25.ptt. Using this button steps back one by one through the 
available list of palettes. Click the button twice more until the grey07.ptt palette is reached. The plot and palette are 
now much coarser. Click the button about six more times so that the graphic plot and palette now becomes coloured. 
Using this button steps back through the available list of palettes. 

Click the 14th horizontal toolbar button, Next Shade Palette. This button steps forward through the available list 
of palettes, reversing the action of the Previous Shade Palette button. Click this button about eight more times to 
return to the grey55.ptt palette. Geoplot comes with a large number of pre-defined palettes but you can also define 
your own – see later in the tutorial. The full list of palettes is displayed in the shade plot dialog box – see figure 3-7.  
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You can also press Ctrl-H and Ctrl-J or select Previous Shade Palette and Next Shade Palette on the Graphics menu 
to achieve the same action as the toolbar buttons. 

Display Gridding 

 Click on the 15th horizontal toolbar button, Display Gridding. A set of nine orange crosses appear on 
the graphic plot which mark 5m intervals. You can set your own gridding preferences in Graphics Options where 
you can change the colour, interval and type of mark. Click on the button to remove the gridding. You can also 
select Gridding from the View menu to turn it on or off. Note that gridding cannot be displayed in trace or pattern 
plots. 

Select Area for Graphics 

 Click on the bottom button of the drawing toolbar, Select Area for Graphics. Now move the mouse 
over the graphics plot and position the mouse in the top left-hand corner so that the coordinates reported on the 
bottom status bar are 0.5m,0.5m  1,1. Hold down the left mouse button and drag the mouse towards the bottom 
right-hand corner until the coordinates reported on the status bar are 4.5m,4.5m  5,5 and a small square has been 
drawn over the plot. Release the mouse button and a dialog box will appear on the right-hand side which reports the 
coordinates of the area you have selected, figure 3-6. 

  

 

Figure 3-6.  Dialog box that reports the area selected by the mouse. 

The coordinates shown should be Top-Left XY = 1,1, Bottom-Right XY = 5,5. If they are not, then change them by 
typing in the correct numbers. Click OK or Return and a graphics plot will be made of just this selected area. You 
can also activate this process by choosing Select Area from the Graphics menu. 

Shade Plot Dialog Box 

Graphics Area and Size 

Move the mouse over the Shade Plot and click on it. Now press the Return key to display the dialog box for Shade 
Plots. If drawing of a graphic plot was the last activity then you need only press Return key. You can also select 
Shade Plot from the horizontal toolbar button or Graphic menu to display the shade plot dialog box – try these 
methods. The dialog box should look like figure 3-7. 

The dialog box allows you to : (a) change the plotting parameters, (b) determine whether a graphics plot is made of 
the whole of the data set or a smaller block (Graphics Area), and (c) set the size of the graphic plot. In the previous 
exercise we used Select Area for Graphics to select a smaller area of the data set for a graphics plot  – this area is 
known as a block. The dialog box also now reflects the current smaller area : Block is now set to On and the Top-
Left XY and Bottom-Right XY values are no longer greyed out but report the area we selected (compare Graphics 
Area in figure 3-7 with figure 3-5). When experimenting earlier with the Zoom buttons we also changed the plot 
size so that now the dialog box also reflects this new Size of x2. Try changing the size shown on the dialog box to 
see the range of possible sizes – it goes from x1/32 up to x5 and is reported in the Graphics Plot Details panel just 
under the dimensional scalebar. 

The dialog box offers an alternative means of setting plot size and graphics area, although usually it is faster to use 
toolbar buttons and the mouse. However, the dialog box offers the only way of deselecting a Block set by Select 
Area for Graphics. In the dialog box set Block to Off, set the size to x4 and click on OK to see a Shade Plot of the 
whole area at a much larger size which almost fills the screen. 

Default Plotting Parameters 

Select Graphics from the Options menu to show the Graphics Options dialog box, figure 3-8. When we looked at 
this earlier in the tutorial we accepted the Geoplot default parameters, but these default parameters can be 
customised. Remember it is also possible to revert back to Geoplot defaults for any tab in the Graphics Options by 
selecting the Reset to GP3 defaults. In the General tab you can set the default (opening) plot type, default plot size 



 3-10       Tutorial 

etc and under the Shade, Pattern, Trace and Dot-Density tabs you can set the default plotting parameters for each 
type of plot.  

Geoplot is supplied to you with the following defaults : (a) in the General tab : Default Plot Type = Shade, Default 
Plot Size = x 1 and (b) in the Shade tab : Clip plotting parameters set to: minimum = -3, maximum = +3, contrast = 
1, units = SD (standard deviation). Geoplot calculates the standard deviation and percentage plotting parameters by 
using the statistics stored with every grid and composite. There are different defaults for each graphics plot type. For 
the tutorial accept the Geoplot defaults but in future you may prefer to set new defaults that are more closely related 
to your typical data sets.  

Click Cancel to finish with the Graphics Options dialog box. 

 

 

Figure 3-7. Typical dialog box for entering graphics plotting parameters for shade plots. 

 

Shade Plot Modes - Clip Parameters 

The default plotting mode for shade plots is Clip which requires four additional parameters to be set 
: minimum, maximum, contrast and units. The minimum is the reading corresponding to the lowest 
point on the shade scale, the maximum is the reading corresponding to the highest point on the 
shade scale; any readings outside of this range are “clipped” to the minimum or maximum shade 
point chosen. The minimum or maximum can be specified in units of standard deviation (S.D), 
percentage (%) or absolute numbers, set by the Units field. The contrast factor determines whether 
the spread of greys or colours between minimum and maximum is made on a linear basis 
(contrast=1) or a non-linear basis (eg contrast=2 which gives a power law relationship). The other 
plot modes are Relief and Compress – these are described in more detail in Chapter 5.  

 

Changing the Plotting Parameters 

Ensure you are in the graphics view, with a shade plot of 1.dat visible. Display the shade plot dialog box. 

 When a Shade Plot graphics dialog box is shown, it is first populated with your chosen defaults, but if you change 
the dialog box values these new values are remembered for the current session with Geoplot, even if you swop to 
another view of the data e.g. file details view. If you change to another graphic plot type such as a Dot Density plot 
then it will first show the chosen default values for that plot type. These values can also be changed and likewise 
will be remembered for that plot type for the current session. You can revert back to your chosen defaults for each 
graphic type at any time by clicking on the Set to Defaults button in the relevant graphic dialog box.  
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You can use the histogram and floating complete statistics form as a guide to changing the plotting parameters and 
refining a graphics plot. For example, look at the histogram for 1.dat. Better values for the minimum and maximum 
might be : minimum=-1.5 SD, maximum =+1.5 SD since this covers the majority of readings. 

Change the minimum and maximum to these new values, (minimum = -1.5, maximum = +1.5, contrast = 1, units = 
SD), set size back down to x2 and press OK for a new plot. The calibration on the shade scalebar will alter to reflect 
the new plotting range, based on standard deviation calculations from the grid statistics – note that the shade 
scalebar calibration is always displayed in absolute units not standard deviation units. The new plotting parameters 
are reported on the bottom right-hand side. 

 

  

Figure 3-8.  Graphics options dialog box. 

Changing the Shade Scalebar Format 
If the data set you are working with has a very different range of numbers from normal you may find the shade 
scalebar resolution is not appropriate. You can change its format in the General tab of the Graphics Option, see 
figure 3-8. Note that you can also change the screen background colour and dummy data colour in the General tab. 
Select Graphics from the Options menu and in the General tab change Scalebar Data Format to : #.#.. Click OK and 
the graphics plot will be refreshed, with the scalebar adopting the new resolution.  

Comparing Data Sets 
So far we have looked at just one data set, rgrv/1.dat. There are in fact six grids in site rgrv and we will now look at 
shade plots of each grid in turn and compare their statistics and histograms.  

We need to compare shade plots for each data set using  the same parameters. Select Environment from the Options 
menu and then select the Open tab. Ensure Open View is set to” Graphics” and Open View for Graphics is set to 
“Use existing plotting parameters, Plot Type and Size”, see Figure 3-11. Choosing  “Use existing Plotting 
Parameters, Plot Type and Size” means that each time you open a new data set the parameters, size and plot type 
will be remembered from one data set to the next allowing the data sets to be compared. 

Before we open another grid data set, make a note on paper of the statistics in the floating complete statistics form 
and the scalebar calibration displayed for grid 1 with the plotting parameters set to : minimum = -1.5, maximum = 
+1.5, contrast = 1, units = SD. Now select the Open dialog box. Notice that the dialog box has remembered the last 
directory used (that is the last site) so we only need to select directly from the grid names 1, 2, 3, 4, 5, 6. Open each 
grid in turn and you will see a shade plot of each data set. The scalebar calibration and histogram will change for 
each grid, depending on the statistics of each data set. Note especially the maximum value in statistics.  

In grids 5 and 6 note the wider calibration range, narrower histograms and larger maximum readings. These are very 
different from the other grids, see figure 3-9. This is due to the presence of a pair of rogue readings or noise spikes 
in each grid. You can see two high readings, shown as black points, clearly in the lower half of  the graphics plot of 
grid 5.  
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Figure 3-9.  Histograms for grids 1 to 6 in site rgrv. 

It is these readings that are distorting the statistics and the histogram. These readings also distort the calculation of 
the plotting range, when expressed in terms of standard deviation. Change to a Trace Plot, using the Trace Plot 
button, and you can see the noise spikes much more clearly, figure 3-10.  Whilst using the default plotting 
parameters, based on standard deviation calculation, is acceptable for a quick look at the data, this may not present 
the best image since defects such as the noise spikes can bias the statistical calculations. You can avoid this bias by 
using absolute units in the plotting parameters. You will also find that using absolute units often makes it easier to 
examine or compare the application of various process functions, as we shall see later. 

 

 

Figure 3-10.  Trace plot of grid 5 clearly showing two noise spikes and a large maximum in statistics. 

Using Absolute Units 
Change back to a Shade Plot, using the toolbar button. To remove the bias effect of the noise spikes from the 
statistical data we can change from standard deviation to absolute units. We therefore also need to alter the 
minimum and maximum plotting parameters as these are currently relevant only to standard deviation units. We 
noted that only the plots of grids 5 and 6 had obvious noise spikes in them. The calibration range of the shade 
scalebar for grids 1 to 4 was consistently between about 50 and 80 ohms. We can therefore use that range as a basis 
for the minimum and maximum plotting parameters in absolute units. In the Shade Plot dialog box change the 
plotting parameters to : minimum = 50, maximum = 80, contrast = 1, units = absolute. Compare graphics plots of 
grids 1 to 6. Now that we are using absolute instead of standard deviation units, grids 5 and 6 appear similar to grids 
1 to 4 , in terms of background. Note the revised plotting paramenters are remembered from one data set to another 
because we are using “Use existing plotting Parameters, Plot Type and Size” as the default Open View for Graphics 
setting. 
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Figure 3-11.  Environment Options, Open tab. 

Data View 
We can look at the actual numerical values of the readings concerned by using the Data view. Make sure you have a 
graphics plot of grid 5 visible. Press F6 to change to the Data view. The default resolution used makes it hard to 
locate any large numbers. You can change the resolution by selecting Data Format from the View menu and 
selecting #. As soon as you do this the data view is refreshed at the new resoluion, figure 3-12. You can set the 
default resolution that is initially used when you start Geoplot by changing the Default Data View Format setting in 
the Data tab of Enviroment Options – for now leave the setting as it is.  

You can locate any reading within a data set by specifying its address using column (X) and row (Y) coordinates. 
This can be useful in accurately locating and specifying a reading or block of readings for graphics presentation or 
processing. We can see here one of the spikes, 544 ohms, is located at X=7, Y=13. The other spike, 652 ohms, is 
located at X=15, Y=14. You can navigate around the data view by either moving the rectangular cursor or moving 
the scroll bars at the bottom and right-hand side (there is no scroll bar on the right-hand side at the moment since the 
data set can fit in the screen without it). The cursor can be moved by clicking on a cell with the mouse, pressing 
Return or Tab key to move to the next cell on the right, using the arrow keys or by using the arrow keys in 
conjunction with the Ctrl key to move ten cells at a time. 

Editing Grid Data 
You can perform direct edits of individual data points in grids. However, you cannot edit individual data points in 
composite data directly - instead you must use the Add process function to change individual data points. To edit 
grid data, select Data from the Edit menu. The screen background, first column and heading colours will change to 
indicate you are in edit mode and the word “Edit” will also appear in the top left-hand corner of the table. If you 
choose Data from the Edit menu when you are in a view other than Data View, then the screen will revert to a Data 
View ready for you to edit. Move the cursor to the 544 ohm cell at X=7, Y=13 and either press the space bar or 
double click on the cell to highlight the number. 

Since we know this data point is a random noise spike and not valid data, we will replace it by the mean of the eight 
surrounding readings, 61.5ohms. Use the backspace key to delete 544 and type in 61.5. Press the Return key or 
move the cursor to another cell. The cell at 7,13 will immediately be updated to show the number at the current 
display resolution which is integer at the moment. Note that the complete statistics floating form is updated, the 
history floating form now has an entry : “Edit at 7,13, Old=544” and the name of the file and its file path displayed 
at the top of the screen now has “+++” added after it. The three crosses indicate data has been changed but not 
saved. We will revisit histories later on when we process composite data.  

Before we save the data, edit the other noise spike at 15,14, replacing it by the mean of the surrounding data points 
(60.5 ohms). Turn off editing by select Data from the Edit menu and the tick alongside Data will then be removed. 

Return to the graphics view using F5 and the graphics view will now be refreshed with a plot of the edited data. 
Note that the histogram of grid 5 now has a more normal distribution, similar to those of grids 1 to 4, now that the 
noise spikes have been removed. Display the graphics dialog box  by clicking on the Shade Plot button and change 
the plotting parameters back to : minimum = -1.5, maximum = +1.5, contrast = 1, units = standard deviation. Click 
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OK and now you will see a graphic plot using standard deviation units where the shadebar range and image contrast 
is no longer distorted by the outlying readings.  

 

History and Statistics Changes 

Whenever you modify data in any way, either by editing or processing, the history view (and floating 
history form) reports these changes. The changes are intially positioned after a horizontal dotted line 
in the History Views. When you save the data these changes are permanently recorded so you can 
trace back all the modifications you made to the data. Saving the data moves the horizontal line to a 
position just after the changes. The horizontal dotted line acts a divider between changes that have 
just been made and changes that have already been stored, useful for keeping track of where you 
are in an extensive processing session. All statistics are also updated when you edit or process 
data. 

 

  

 

Figure 3-12.  Data view of grid 5. 

We will only change and save grid 5, leaving grid 6 as it is, since it is usually more efficient to use the Despike 
process function to remove random noise spikes, something we will explore later. However, if in the future you find 
you do need to modify significant numbers of individual data points in a way that cannot be performed using one of 
the process functions, it is best to do it at the grid stage, rather than using the Add process function at the composite 
stage – for example when you have been entering data manually using the keyboard and have discovered some lines 
of data are incorrect.  

Saving Data Files 
 You can save a grid or composite file from either the File menu or by using the SaveAs button on the 

horizontal toolbar (note that there is only a SaveAs command, not a Save command to avoid accidentally 
overwriting data). Click on the SaveAs button to reveal the SaveAs dialog box, figure 3-13. 
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Figure 3-13.  SaveAs dialog box. 

The Directories setting now matches the location from which the data was opened and the name of the grid is 
offered as the file name entry. Click OK and you will get a message saying : “Raw data files cannot be overwritten. 
Press OK to continue and choose a new file name”. As you can see Geoplot protects you from over-writing your 
original grid data files. Type in 5e instead (the e after the 5 could stand for editing) and click OK. The three crosses 
will now disappear and the new file name will be displayed at the top of the screen.  

If you were to make further edits to grid data then you could save this with the same name of 5e since it is no longer 
the original raw data. Note that there is no need to add the file extension usually when entering the file name – the 
only time you need to enter the file extension is if you are specifying a full file path. You would enter a full path 
name if you wished to store the data in a directory that did not already exist.  

Creating a Master Grid 
Grids 1 to 6 in rgrv are part of a single site survey. The next step is to join the six grids together by creating a master 
grid, as an intermediate step, and then finally create a composite. Once joined together as a composite, we will be 
able to apply several process functions to enhance the data. 

 

Master Grid and Composites 

All individual grids may be combined into one data file that corresponds to the original survey area 
as follows. First, create a master grid file which defines how the individual grids of data fit adjacent 
to one another. The individual grids are still stored as independent files and the master grid does not 
itself contain any data, but just the names of the grids. All grids must be in one directory. 

Next, the master grid is used as a template to load into memory all the data from individual grids, 
arranged into the correct location with respect to one another. This assembled data is then stored as 
one large file known as a composite. Note that the individual grids are still preserved as individual 
files and that the master grid is only used as an intermediate step in the creation of a composite. 
Composites are the principle files manipulated in Geoplot. 

A master grid can also be used to define an optional bias, or numerical correction, for each grid in 
master grid. When data is loaded into memory using a master grid, any bias that is defined is added 
to the grid data, thereby shifting the background level. 

 

 

Select Master Grid from the File menu to display a dialog box similar to that shown in figure 3-14. Note that any 
existing data will be cleared from memory, with a warning being given if it has not been saved first.  
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The master grid has a maximum size of 50 by 50 locations. Each location can be used to enter the name of a grid. 
Note that the ‘Grid Source for Create Composite’ box automatically shows the path where the grids are stored since 
we have previously opened the grid files. You can navigate around the master grid and edit entries in just the same 
way as for the data view. Make the entries shown in figure 3-14 (note that we have used the edited grid 5e, not grid 
5) and then click on SaveAs. Usually the master grid is saved in a sub-directory with a name that matches the grid 
directory.  In this case, of course, the sub-directory should be rgrv but it will not yet exist. However, Geoplot will 
detect this and offer to create the directory for you. Click OK to accept and a SaveAs dialog box will be displayed, 
figure 3-15, already set at the rgrv directory. (Note for the future that you can also create a new directory using the 
New Directory button and the ‘Grid Source for Create Composite’ box will be updated to reflect this). In this case 
we will give the master grid the name 1.plm so just type in 1 as shown in figure 3-15 and then click on OK. 

The master grid will now be saved. Note that the full path name of the master grid is now shown at the top of the 
dialog box. Note that if you download data the required sub-directory will be created for you automatically. 

 

  

Figure 3-14.  Master Grid dialog box showing the six rgrv grid names entered. 

 

Figure 3-15.  Master Grid SaveAs dialog box. 

Creating a Composite 
Having created a master grid, click on Create Composite. Geoplot will now, by default, try and create a composite 
in a sub-directory that corresponds with the site name, rgrv again, in the default file path for composites as set in 
File Path Options. Since this path, c:\geoplot\comp\rgrv, does not yet exist Geoplot offers to create this path for you. 
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Click OK and you will be presented with a SaveAs box very similar to that for saving grids, except that now the 
Directories setting is preset to c:\ geoplot\comp\rgrv and all you need to do is enter a name for the composite. Type 
1 in the File Name box and click OK. 

The composite has now been created so close the master grid dialog box and click on the Open Grid/Composite 
Data toolbar button to look at the resulting composite. The Open dialog box automatically has Directories already 
set up to open the composite we have just created so select file 1.cmp and click OK. 

The resulting graphics plot may be too large for the screen, depending on your screen resolution, so reduce the size 
down by one step, either by clicking on the Zoom Out button, Ctrl-N or use the Shade Plot dialog box to change the 
size there. Size should be x1.  

We can see that grid 5e does not match the others, figure 3-16. Assume that this mismatch occured because we had 
to adjust the separation of the remote probes on a Twin Electrode survey, which had the effect of reducing the 
background by 10 ohms, and we made a note of this value at the time.  

There are three ways we can correct this mis-match. Firstly, we could use the Edge match process function available 
in the Process menu to automatically remove the discontinuities. Secondly, we could add 10 to that block of data 
using the Add process function in the Process menu. Whilst either of these two methods would normally be the best 
way to correct the mismatch, we will use an alternative way which will allow us to introduce the concepts of a 
master grid bias and editing of master grids.  

A master grid can also be used to define a bias, or numerical correction, for each grid. When data is loaded into 
memory using a master grid, any bias that is defined is added to the grid data, thereby shifting the background level. 
If we add a bias of 10 to grid 5e then, when all the grids are loaded using a master grid, the background level of grid 
5e should match the others. 

Editing a Master Grid 
Select Master Grid from the File menu to display the Master Grid dialog box. Click on Open to show the Open 
Master Grid dialog box. Select 1.plm, the master grid we have previously created and click on OK. The master grid 
will now be loaded. Move the cursor over the grid name 5e and click on Show Bias to reveal any bias already 
defined for that grid – the heading on the Master grid dialog box changes from Names to Bias. We have not yet 
defined a bias so type the number 10. 

 

  

Figure 3-16.  Composite created from grids 1 to 6 in site rgrv – before application of a master grid bias. 
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Typing the number 10 in this position in the bias view means it will be associated with grid 5e only when grid 5e 
data is loaded into memory using the master grid. Click on SaveAs. The SaveAs form will automatically suggest the 
name of the loaded master grid and if you press OK a reminder will appear that the file already exists. Click on OK 
to over-write the existing file.  

As before, create a composite and save it with the same name we used previously, 1.cmp. Again elect to over-write 
the existing file. Close the master grid dialog box and open the composite we have just created. You will see that 
there are now no discontinuities at the edge of grid 5e. 

Graphics View and Composites 
When you have composite data opened there are some additional graphics tools that can be used. We will load 
another set of data, a gradiometer survey, to look at these most effectively, but will return to our resistance data 
afterwards. Click on the Open Grid/Composite Data button to show the Open dialog box. Select a Directories path 
of c:\geoplot\comp\gmeadow, select file 1.cmp and click OK to open the new data set, figure 3-17. The plotting 
parameters should still be : minimum = -1.5, maximum = +1.5, contrast = 1, units = standard deviation, size x1. 

We can use two toolbar buttons to display information about the survey grids that were combined to create a 
composite (the toolbar buttons cannot be used with grid data alone, only with composites). These will be useful for 
the following sections that discuss processing. 

Display Survey Grid 

 Click on the 16th horizontal toolbar button, Display Survey Grid. The original Survey Grid will be 
superimposed on the composite – see figure 3-17 (which incidentally also shows grid numbers, as discussed below). 
You can set the Survey Grid colour displayed to your own liking in Graphics Options. Click on the button to 
remove the Survey Grid. You can also select Survey Grid from the View menu to turn it on or off. Note that Survey 
Grid cannot be displayed over trace or pattern plots. Make sure the Survey Grid is visible before proceeding further. 

 

 

Figure 3-17.  Gradiometer data showing survey grid and grid numbers. 
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Display Grid Numbers 

 Click on the 17th horizontal toolbar button, Display Grid Numbers. A sequence of numbers, starting 
with 1 in the top left-hand corner and ending with 25 in the bottom right-hand corner is superimposed over the 
composite – see figure 3-17, which also shows the survey grid, as discussed above. It is extremely important to 
realise that this numbering sequence is independent of the actual grid names (or numbers) which were used  to 
create the composite. The Grid Numbers are used to identify specific grids in the composite for processing by grid 
specific process functions such as Edge Match, Periodic Filter, Deslope and Destagger. 

You can alter the Grid Number colours in Graphics Options under the Grid and Gridding tab. Click on the button to 
remove the Grid Numbers. You can also select Grid Numbers from the View menu to turn it on or off. Note that 
Grid Numbers cannot be displayed over trace or pattern plots. Make sure the Grid Numbers are visible before 
proceeding further. 

There are four further graphics toolbar buttons that are useful when navigating around large composites. 

Zoom In x2 to Selected Area 

 Click on the 9th horizontal toolbar button, Zoom In x2 to Selected Area – do not confuse this button 
with the 7th button, Zoom In to Point. Now move the mouse over the graphics plot and position the cursor in the top 
left-hand corner so that the coordinates reported on the status bar are 37.5m,37.5m  38,38. Hold down the left mouse 
button and drag the mouse towards the bottom right-hand corner until the coordinates reported on the status bar are 
46.5m,46.5m  47,47 and a small square has been drawn over the plot. Release the mouse button and a dialog box 
will appear on the right-hand side which reports the coordinates of the area you have selected (much like the earlier 
figure 3-6, except the coordinates will be different). Click on OK and an enlarged image of the selected area will 
appear over the existing plot, figure 3-18. The function Zoom In x2 to Selected Area can be useful for looking in 
detail at a small area without having to change the overall size.  It can be especially useful when trying to examine 
the detail in a complex trace plot. Click on the Cancel button and the graphics view will now be restored to normal. 
You can also select Zoom In x2 to Selected Area from the View menu. This function can be used with all the 
graphics plots. 

 

 

Figure 3-18.  Gradiometer data showing use of the Zoom In x2 to Selected Area toolbar button. 
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Zoom In to Point 

 Click on the 7th horizontal toolbar button, Zoom In to Point. Now position the mouse roughly over the 
spike we have just looked at - the coordinates reported on the status bar should be 42.5m,41.5m  43,42. The cursor 
will have changed to four arrow directions. Left click on the spike and the whole graphics plot will be magnified, 
with the spike at the centre of the plot. This is different from the Zoom In function looked at earlier which is always 
centred on the centre of the data set. Use the  Zoom In to Point button twice more, with the mouse positioned at the 
same spike until size is reported as x4. 

The function Zoom In to Point can be used for homing in on a small area away from centre. You can also select 
Zoom In to Point from the View menu. Note that this function can be used with all the graphics plots.  

 

 

Figure 3-19.  Gradiometer data showing use of the Zoom In to Point toolbar button. 

Zoom Out from Point 

 Click on the 8th horizontal toolbar button, Zoom Out from Point. Again, position the mouse roughly 
over the spike we have just looked at and Left click. The whole graphics plot will now be reduced in size back to x3, 
with the spike at the centre of the plot, figure 3-19. Again, this is different from the Zoom Out function looked at 
earlier which is always centred on the centre of the data set. You can also select Zoom Out from Point from the 
View menu. This function can be used with all the graphics plots. (VGA resolution only : Zoom Out from Point 
once more so that size is x2). 

Pan Graphic to Point 

 Click on the 6th horizontal toolbar button, Pan Graphic to Point. Observe in figure 3-19 that only the 
left part of grid number 14 is visible. Now position the mouse anywhere over the visible part of grid 14 and left 
click. The magnification of the graphics plot will not change but all of grid 14 will now be visible – in effect the 
image has panned over to the right hand part of the data set. You can move around a large data set in this way 
without changing the current magnification. You can also select Pan Graphic to Point from the View menu. This 
function can be used with all the graphics plots. 
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Opening Recently Used Data – A Quick Method 
We will now return to our earlier resistance data set, composite 1.cmp in site rgrv, and apply some processing to it. 
Whilst you could open the data set as normal, using the Open Grid/Composite dialog box, it is much simpler to load 
it from the list of most recently used files at the bottom of the File menu. Select the File menu and you will see 
at the bottom a list of the last four files you opened. Rgrv\1.cmp is second in the list since gmeadow\1.cmp was the 
most recent. Click on c:\geoplot\comp\rgrv\1.cmp or type 2 to select that file, and the data set will be immediately 
opened as a graphic plot. 

Processing Data 
As we saw earler, this data set requires the noise spikes to be removed which can be done using the Despike process 
function. However, before doing that we will try applying a Low Pass or smoothing filter. This will allow us to 
explain how to use the combination of Save and Reload functions, which are found on the File menu and horizontal 
toolbar buttons, and will also serve to illustrate how important it is to apply process functions in the correct order. 
Make sure you have composite rgrv\1.cmp opened in a shade plot graphics view, with plotting parameters : 
minimum = -1.5, maximum = +1.5, contrast = 1, units = standard deviation, size = x1, with the floating history and 
statistics forms visible. 

Low Pass Filter 

 Click on the Low Pass Filter toolbar button which is approximately halfway down the process toolbar, 
or select it from the Process menu. This will reveal the Low Pass Filter dialog box, figure 3-20. 

 

 

Figure 3-20.  Low Pass Filter dialog box, Block Off. 

All process function dialog boxes allow you to enter processing parameters and, depending on the function, may 
also let you determine the Process Area. Selecting a Process Area allows you to operate on specific parts of a 
composite, rather than the whole composite - we will look at this later. For now we will operate on the whole of the 
composite and we can ignore Process Area, since it initially defaults to processing a complete composite, ie Block is 
Off. Take note in particular of the appearance of the noise spike in the lower left hand corner of the graphic before 
we apply the Low Pass Filter. 

Whenever possible Geoplot will offer default parameter entries. We will accept the defaults for now, which will 
apply minimal smoothing to the data, and click OK to start the process. Progress will be reported by a blue bar on 
the left-hand side of the status bar and when completed, the dialog box will disappear and the graphics plot will be 
updated, figure 3-21. 

Note that the statistics floating form is updated, the history floating form now has an entry in abreviated form : “LPF 
X=1 Y=1 W=G”, the histogram is updated and the name of the file and its file path displayed at the top of the screen 
now has “+++” added after it. The three crosses indicate data has been changed but not saved.  

Note that the Low Pass filter has smoothed the ditches which is what we would expect. Unfortunately the spike in 
the lower left-hand corner has been smeared out, producing a much larger block than before. This emphasises a very 
important point when processing data – you must apply process functions in the correct order to avoid badly 
presented plots or incorrect interpretations. This is discussed in greater detail in Chapter 5.  
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Figure 3-21.  Resistance data after low pass filtering. Note smearing of noise spike at the bottom. 

 

View Update 

Whenever an edit or process is applied the default action is to immediately update the current view, 
be it graphics, data, history or file details view. If displayed, the complete statistics and latest history 
forms will also be updated. You can turn off automatic graphics update, (Auto-redraw), in 
Environment Options or with the far right hand button on the horizontal toolbar. 

 

 

We should have “cleaned up” the composite first, by removing the noise spikes, before applying the Low Pass filter. 
We will now go back and do this exercise in the correct order. You could  reopen the data as normal but there is a 
faster method available using Reload. 

Reload 

 Click on the 1st button on the horizontal toolbar, Reload. A message will appear saying : “The current 
processed data will be lost if you reload data. Proceed with reload ?”. Click on OK and the original unprocessed 
data set will be reloaded. The graphics plot, floating forms, histogram etc will also be updated. You are able to use 
the Reload function only when data has been processed but unsaved (indicated by three crosses visible after the file 
name at the top of the screen). You can also select Reload from the File menu. The Reload button lettering is dark 
grey on a light grey background if a composite is unchanged but becomes green on a white background when a 
composite is changed but unsaved. 

Despike 

 Click on the Despike button which is approximately a third of the way down the process toolbar, or 
select it from the Process menu. This will show the Despike dialog box. Again, accept the default parameters and 
click OK. The graphics view, floating forms and histograms will all be updated. Now that the noise spikes have 
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been removed, the histogram is more like a normal distribution and the graphics plot range is no longer distorted by 
the outlying noise spikes. You can examine the effect of the Despike function by using the Cut and Combine 
function and thereby confirm that you have not inadvertently altered the data too much. 

Cut and Combine 

 Click on the Cut and Combine button which is approximately two thirds of the way down the process 
toolbar, or select it from the Process menu. This will show the Cut and Combine dialog box. Normally the Cut and 
Combine dialog box requires you to make coordinate entries but if you want to show the effect of the Despike 
function, or any other processing function, by subtracting an unsaved processed data set from the original 
unprocessed data, there is a special mode available which means that when the dialog box appears you can simply 
click on OK as the Combine function defaults to Subtract. Click on OK and the graphics view, floating forms and 
histograms will all be updated, figure 3-22. 

 

 

Figure 3-22.  The difference between data before and after Despiking, identifying spikes removed. 

The residual after subtraction represents the effect the Despike function had on the original unprocessed data. We 
can see the position of the major noise spike visible earlier, in the position of grid 6, but we can also see a number of 
other smaller noise spikes that have been removed. Use of the Despike function will have resulted in a less “noisy” 
graphics plot. All the noise spikes appear to be scattered randomly and there is no evidence of any features also 
being stripped out by the despike process. This confirms to us that the Despike parameters we chose were 
acceptable. Note the floating history form reports the complete Cut and Combine parameters applied. 

Having examined the effect of Despike in this way we must reload the original data and repeat the Despike. Use the 
Reload button to restore the original data and then Despike the data once more.  

We will save the despiked data for future use. Use the SaveAs button to show the SaveAs form and save the 
despiked data with the filename 1k. We now have two composites stored, one named 1.cmp which is original data, 
and a second named 1k.cmp which is a despiked version. Note that a report of the despike operation is now 
permanently stored with the second composite, along with properly calculated statistics and histogram. 

Now apply a Low Pass filter using the default parameters. The graphics plot now shows the ditches smoothed but 
this time no sign of smeared noise spikes. Note that the Low Pass Filter operation is added to the floating History 
form, just after the horizontal dotted line, indicating that it has been applied but not yet saved. As you apply more 
and more process functions they are added to the floating History view – the floating History form reports just the 
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latest four. You can view all of the History at any time by pressing the F7 key (try this) and then press the F5 key to 
return back to the graphics view (try this). 

You could go on to apply several more process functions before considering another save, or you may wish to save 
the composite in its current state first, as an intermediate record. This is a good habit since it saves the need to repeat 
a long sequence of processing if the last process function does not give the required results.  

Note that Cut and Combine can also be used in a number of other important ways. For example you can merge 
composites, overlay parts of different composites, look at the correlation between composites, overlay a contour plot 
over a shade plot etc. These are discussed further in Chapter 5. 

 

Editing and Processing Restrictions 

Grids 

All functions on the Edit Menu can be applied to grids but none from the Process Menu. 

Composites 

All functions on the Process Menu can be applied to composites but only Rotate, North, Units, Swop 
Adjacent Traverses and History edits can be applied from the Edit menu . 

 

Block Processing 
Up to now we have been applying process functions to the whole of the data set. You can apply some process 
functions to a selected block of data, in just the same way that you can look at a selected area of a graphics plot. For 
example we saw a facility for defining a Process Area in the Low Pass Filter dialog box. 

Select Area for Processing 

 To choose Select Area for Processing click on the bottom right-hand button of the process toolbar. 
Now, just as we did for Select Area for Graphics, move the mouse over the graphics plot and draw a small square, 
roughly 20m by 20m over the plot. Release the mouse button and a dialog box will appear on the right-hand side 
which reports the coordinates of the area you have selected, similar to that shown in figure 3-6. Click OK to accept 
and the box will remain superimposed over the graphic. You can also activate the selection of an area by selecting 
Select Area from the Process menu. Note that you cannot use Select Area for Processing in Trace Plots. 

Once a process area is selected it is available to all process functions that can work with a selected area. It is 
important to realise that graphics and process block coordinates operate totally independent of one another. 

Add 

 To choose the Add process function click on the button at the top of the process toolbar. This will show 
the Add dialog box, figure 3-23. Note that now we have selected an area, Block is set to On (Inclusive) and the 
coordinates of the area we selected are reported. You could if you wish modify the coordinates in this form – and 
even turn Block On or Off. Type 10 into the Value field and Click OK. The graphics will be updated and you will 
see the data in the selected area will be darker than the surrounding readings. The history form will report the value 
added and also the coordinates of the selected area. Note that the process area is still drawn over the plot. 

Select Add again and you will also see that the process area is still active, ie Block is On (Inclusive). The current 
Process Area always remains active until you click on the graphics. The Process Area can also be turned off in the 
dialog box. If you set a Block back to On in the dialog box, the rectangle will reappear on the graphics plot. 

Leaving the area selected means you can quickly apply several processes to just that area without having to 
reactivate it each time – for example you may be trying match two background levels which calls for repeated Add 
operations. Type -10 into the Value this time and click OK. Now you will see the graphic will be restored to its 
former state. Click anywhere on the plot to turn off the selected area. You will find Block in the dialog box is now 
set to Off but the old coordinates are still retained should you wish to use them again.  



     Tutorial      3-25

 

 

Figure 3-23.  Add dialog box, Block On. 

Effect of Composite Rotation on Process Functions 
Load the composite gmeadow\1.cmp that we looked at previously and set the plotting parameters to : minimum = -
3, maximum = +5, contrast = 1, units = absolute, size = x1, with the survey grid turned on.  

Note that the north symbol points to the right-hand side of the screen, not upwards. At this point it is very tempting 
to make the north symbol point upwards and indeed this is possible, but doing so at this stage will have a major 
impact on what processing we can subsequently apply, as will be explained shortly. 

Select Rotate from the Edit menu. A dialog box will appear that offers a default rotation angle of 270 degrees. Click 
OK to accept this and the graphics plot and north symbol will both be rotated, so that the north symbol now points 
upwards. Whilst this may look visually more satisfying, it is very important to realise that the original traverse 
direction is also rotated through 270 degrees and is now aligned in the Y direction. However, several very useful 
process functions are traverse dependent and only operate in the X direction ( e.g. Destagger, Zero Mean Traverse, 
Spectrum and Periodic Filter). Therefore, if you use Rotate at this stage it means you will not be able to use these 
process functions to “clean up” the data. It is always best to leave rotation until the last operation. Even then it may 
not be needed, since the Publish view in Geoplot allows you to rotate an image in that view, prior to printing, so that 
the north direction is pointing upwards.  

Either select Rotate again from the Edit menu and rotate through 90 degrees, to undo the 270 dgree rotation, or 
alternatively just click on Reload to restore the data to its original angle. 

 Grid Traverse Direction and Composite Rotation 

Composite data should, in general, only be rotated 90 or 270 degrees AFTER all 
processing has been completed, since many process functions depend on the original 
traverse direction being aligned in the X direction. Similarily, you should arrange your 
survey so that all the grids are traversed in the same direction and will be assembled into 
a composite with their traverse directions aligned in the X direction.  

 

 

Of course, there are some occasions when you might want to temporarily rotate the data. For example if you want to 
attempt to reduce the effect of ridge and furrow that runs in the Y direction then you would want to rotate the data 
through 90 degrees before applying Spectrum and Periodic Filter, but once that task is done you would generally 
rotate back to the original direction.  

If you rotate through 180 degrees then this will have no impact on traverse direction dependent functions. So you 
can safely rotate composite data through 180 degrees if, for example, you want to Destagger the odd lines of data, 
rather than the even lines, that this function will normally change.  
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Other Processing Functions 
Finally we will take a look at two very useful process function for gradiometer surveys and a further statistical tool. 
Make sure that the gradiometer data you have just rotated is back to its original direction, with the north symbol 
pointing to the right. 

You will see in the gradiometer data that there are grid edge discontinuities and also horizontal striping in the data. 
You can usually correct for these quickly using the Zero Mean Traverse function. Note also that the histogram is 
very narrow, indicating spikes in the data – as confirmed by the large minimum and maximum values in the 
Complete Statistics floating form.  

As we have seen above, the order in which data is processed is important. Usually you would start a data processing 
session with a Clip of the data, before applying other functions. This means that large spikes do not then upset any 
statistical calculations made by other processing functions. 

Clip 

 Click on the Clip button which is approximately a quarter of the way down the process toolbar, or select 
it from the Process menu. Typical clipping values might be +/-3 standard deviations since a normal histogram 
distribution would be expected to lie within this range. Looking at the Complete Statistics floating form, three 
standard deviations equals about 40nT, a high figure probably arising because of the large spikes in the data. From 
experience we will use lower clipping levels of +/-20nT since we are in fact interested here in the low nT levels. 
Type -20 in the Minimum field, 20 in the Maximum field and click OK. The histogram immediately becomes much 
wider, and the standard deviation much lower, indicating the spikes have been discarded – compare histograms of 
figures 3-17 and 3-24. We are now in a position to apply the Zero Mean Traverse function.  

Zero Mean Traverse 

 Click on the Zero Mean Traverse button which is approximately half way down the process toolbar, 
or select it from the Process menu. Accept the default parameters and click OK. You will see an immediate 
improvement in edge matching (turn off the survey grid for a better view) and also much of the horizontal striping 
has been removed. The improvements made by  Zero Mean Traverse can be seen in figure 3-24. Note that, as 
explained earlier about Rotation, if you had already rotated the data through 270 degrees, to realign the north 
symbol, you would not have been able to use the Zero Mean Traverse function and achieve the great improvements 
we have just seen. Save this processed data for future use as 1cz. 

Statistics 

 Use the Select Process Area button to select the small area shown in figure 3-24, taking care to avoid 
high readings (use TL xy, BR xy coordinates shown in the floating form of figure 3-24). Now click on the 
Statistics button at the bottom of the process toolbar. The Statistics dialog box will be shown with the coordinates 
of the selected block displayed and Block set to On. Click on OK and a floating  form will be displayed on the left 
hand side which reports the statistics of just that area, not the statistics of the complete data set. In this case it is used 
to find out the standard deviation of the background noise in a quieter area, which can be used, for example, to set 
plotting parameters or in statistical detection methods – see later.  

This form can be minimised if required and will retain its information even when a new data set is loaded. 
Maintaining the information in this way enables the statistics of different data sets to be compared. If Block is set to 
Off then the information in the form represents the same as that displayed in the Complete Statistics floating form, 
that is, the statistics of the whole data set, not just a selected area.  

Aborting a Process Function 
You can abort a process function that has started its action (but which will clearly take some time) by pressing the 
Cancel button in the process dialog box or by pressing the Escape key. A message will appear saying : “The current 
data will be lost if you abort this process. Procede with abort ?”. If you click Cancel the process function will 
resume and complete as normal. If you press OK the process function will abort, the screen will clear, the data set 
will be closed, and any previous unsaved processing will be lost. You must then re-open the data as usual if you 
wish to continue processing data from the last saved data set. 
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Figure 3-24.  Block statistics of a small selected area in a quieter region of a gradiometer survey. 

Auto Redraw 
 Whenever data has been processed or edited then the usual option has been to revert to the graphics view 

and present an updated graphics plot. This happens regardless of whether you are in the graphics view or another 
view, such as the data view. Most of the time this is the preferred option. Sometimes, however, you may not want 
the graphics view to be refreshed – for example if you are correcting a number of data points in the data view, by 
adding or subtracting to them individually, you may want to stay in the data view until all the data points have been 
corrected. In this case you can click on the Auto Redraw button which is positioned at the far right-hand side of 
the horizontal toolbar. A cross will appear in the button to indicate Auto Redraw has been turned Off. Clicking on 
the button again will restore the tick to indicate Auto Redraw is operational again. Turning Auto Redraw on again 
will not in itself refresh the graphics plot – instead you must display the graphics dialog box and Click OK. You can 
also control Auto Redraw using the Environment Options General tab. Make sure you leave Auto Redraw set to On. 

Create Palette 
So far we have just used the palettes provided with Geoplot but you can create and edit your own palettes. Select 
Palette from the Graphics menu to display the Palette creation dialog box, figure 3-25.  

A blank, white, palette is initially shown on the left-hand side. First you must make an entry in the Number of 
Colours text box. The default is 13 but you can enter any number between 2 and 234 (however, if your Windows 
colour resolution is set to 256 colours then you will only be able to work with palettes of less than 100 colours). 
Enter a value of 25. The palette has a Node report underneath which gives the exact position of the mouse over the 
palette. If the Node report is not already visible, move the mouse over the palette to make it appear. Move the 
mouse to the top of the palette so that the Node value is reported as 1. Move the mouse down the palette and notice 
the Node report change, reaching 25 at the bottom of the palette. The numbers also change when the mouse is 
positioned just to the right, and outside of, the palette. The Node number can be used as an aid to accurate 
positioning of colours in the palette. 

We are going to create a grey scale palette initially, with black at the top, white at the bottom and grey shades in 
between. The Red, Blue and Green sliders in the Colour frame are all initially set to their most intense colour, 255. 
Move all the sliders to the left-hand side, so the colour intensity becomes 0 for each. The colour box underneath 
the sliders will change colour as the sliders  move and will eventually become black.  
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Move the mouse to a position over the palette so that the Node number reported is 1 and left click on the palette. A 
black band will appear on the palette and a white text box will appear to the right of this, just outside the palette. 
The number in this text box indicates the node number, in this case 1, and the box is known as a node box. Now 
move all the sliders to the right-hand side, so the colour intensity becomes 255 for each. Move the mouse to the 
bottom of the palette until the Node number equals 25 and left-click here. Although no colour appears, since it will 
be a white band on a white background, the corresponding text box, with 25 in it, will appear just to the right of the 
palette, and will in fact have placed a colour band in place.  

 

 

Figure 3-25.  Typical palette dialog box. 

Click on the Flood button to fill in the scalebar between nodes 1 and 25. Click on the SaveAs button on the form to 
display a palette SaveAs dialog box. The default Directories match the settings made in the File Paths options. A list 
of all the existing palettes can be seen in the left-hand box. Type testpal1 in the File Name box and click OK. This 
palette is now available for use in Geoplot. 

Next we will add a red colour band to the top of the palette. Set the Red slider to its maximum value of 255 and the 
Red and Blue sliders to their minimum values, so that the colour box is red. Move the mouse over the palette until 
the Node number equals 1and then Left click to apply a single red band to the greyscale. Save this new palette with 
a name of testpal2.  

You can place individual bands of colour anywhere on the palette scalebar. Change the colour box to a colour of 
your liking, move the mouse to the centre of the palette and left-click to place the colour band on the palette. Move 
this band by left-clicking on the node box reported to the right of the band and hold the button down - the node 
number will change to red. Move the node box and its associated colour band will follow it to its new position; 
release the left button when the desired position is reached, say a quarter of the way down the palette. Delete this 
colour band by right-clicking on the Node box to the right of the band, the number will change to blue, and then 
click on Clear Node. The colour band will disappear leaving the grey scale underneath. Click on Clear Palette to 
erase the palette we have just created. Apply a red band to the top of the empty scalebar at node number 1 position 
and save this palette as testpal3. 

Although we have only built up simple palettes here, you can flood small sections of the scalebar to build up a 
complex palette. You can also edit an existing palette by clicking on the Open button on the palette control dialog 
box, and select a palette from the palette list box to load it into the palette scalebar for editing. It is advisable to save 
palettes with a relevant name that will give it a sensible position in the palette list box (which is alphanumeric) so 
that it is easier to step to adjacent palettes using the toolbar buttons – see later. 

Statistical Detection 
We will now use the three palettes we have just created to show how graphics, palettes and processing can be 
combined to form a  simple statistical feature detection method. Gradiometer data in a uniform magnetic field has a 
mean of 0 and a Gaussian random distribution centered about 0. The total random noise in a survey map is made up 
from contributions from the magnetometer, the site geology and defects in the operator’s field method. Statistically 
speaking any noise data with a magnitude greater than approximately 2.5 standard deviations is unlikely (0.5 %), 
and at the 3 standard deviations level very unlikely indeed (0.1%). The corresponding likelihood at 2 standard 
deviations is 2.5%. Therefore, by setting a threshold at 2.5 standard deviations and accepting only data greater than 
this threshold, we can create a statistical detection method or technique with which we can say “we are statistically 
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confident that there is only a 0.5% chance that data greater than the threshold was caused by noise in the survey”. 
This suggests that features which exceed the threshold are from a different population, ie one with a feature induced 
signal level greater than zero. Even greater certainty can be obtained by setting the threshold at 3 standard 
deviations. The detection threshold is site and survey dependent but can easily be obtained by measuring the 
standard deviation of the survey data in a “quiet” or feature free area. 

Load the gradiometer data set we processed earlier, gmeadow\1cz.cmp, and set the plotting parameters to : 
minimum = -3, maximum = +3, contrast = 1, units = Std Dev, size = x1, with the survey grid turned off. Select the 
palette testpal1.ptt that we have just created by showing the shade plot dialog box and select testpal1.ptt from the 
Palette list box. We have already applied the Clip and Zero Mean Traverse process functions to the data set and that 
is all we propose to do, so we can now apply the finishing process functions which are Interpolate and Low Pass 
Filter which will give a smoother appearance to the data.  

We will not do as we did for the resistance data Despike the data. The spikes in the resistance data were not real but 
were data collection defects which needed removing. In the gradiometer data the spikes represent real data, probably 
due to surface iron. If you Despike gradiometer data then it is very important that you remember the Despike 
function will only remove the large positive or negative readings and may leave behind associated, encircling low 
level negative or positive readings. You must then take great care not to forget the origin of such areas when 
subsequently interpreting the processed data - it is all too easy for "pits" to appear in this way. This is one very 
good reason why you should leave despiking of gradiometer data until the very latest stages in the process sequence 
or not even attempt it in most cases – consider that even the iron spikes may in some circumstances be part of the 
archaeological record, rather than surface clutter, and should be preserved, not automatically rejected. 

 Click on the Interpolate button which is three-quarters of the way down the process toolbar, or select it 
from the Process Menu. Accept the default which is to interpolate in the Y direction with a SinX/X method, 
doubling the number of readings in the Y direction, and click OK. After the process has finished, click on the 
Interpolate button again but this time select the X direction and click OK. The data set will now have sample and 
traverse intervals of 0.5m, instead of the 1m values previously – press F8 to check this in the file details view and 
then press F5 to return back to the graphics view. Save this data with the name 1czi. 

 Click on the Low Pass Filter button, change the X and Y radii to 2 and click OK. This further 
smoothes the appearance of the plot and will lower the standard deviation of the background noise. Do not save the 
data at this stage. 

 

 

Figure 3-26.  Statistical detection using a threshold set at 2 standard deviations of a quiet area. 
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 Click on the Process Area button and draw a box. This will reveal the Selected Coordinates dialog box. 
Amend these coordinates so that a process area is selected with coordinates : Top-Left XY = 48,83, Bottom-Right 
XY =  56,122. Click OK. This is one of the quieter areas and will give us some measure of the background noise 
level. 

 Click on the Statistics button, and click OK in the dialog box. This will  then show the standard deviation 
of the selected process area, 0.47nT. We can use this standard deviation value to set the plotting parameters for the 
whole graphics plot by changing the minimum and maximum plotting parameters to values which are twice this 
standard deviation, ie 0.94nT. Display the Shade Plot dialog box and set the plotting parameters to : minimum = -
0.94, maximum = +0.94, contrast = 1, units  = absolute, and click OK. The plot will be much darker, with the 
circular features very pronounced.  

 Click on the Next Shade Palette button. The Shade Plot will be refreshed  to show the plot with 
testpal2.ptt. The red band at the top of the palette has been used to threshold the data, and highlights all data above 
the 2 standard deviation level, but at the same time showing data below the threshold. Click on the Next Shade 
Palette button again to show the plot with testpal3.ptt. Now only data above the 2 standard deviation level is visible 
– this plot could form the basis of a statistically meaningful interpretation diagram, figure 3-26. 

Publishing 
We have up to now looked at the graphics view, data view, history view and file details view in Geoplot. A fifth 
view, publish view, function key F9, is also available for creating a published presentation of your graphics plots. 
This can combine several graphics images from different sites, different types (eg shade and trace plots), text, 
shapes, lines etc for doing a high quality presentation. You must open a document or start a new document in the 
Publish Menu before the F9 key or the publish view becomes active. 

New Publish Document 
Select New Document from the Publish menu. A Publish Template dialog box will then be shown which allows you 
to define the publish layout  in terms of paper size, orientation and margins. You can use this form to predefine 
several different layouts in advance if you wish. For now we will just accept the defaults which should show A4 
paper, Portrait, and margins of 2cm. Click OK and the publish view will then appear, figure 3-27. Turn off the 
floating Latest History and Complete Statistics forms so that you get an unclutterd publish view. Note that the 
header at the top of the screen has now changed to Publish Document, as opposed to Gradiometer Data which was 
the previous header. A representation of the paper outline is shown in black and the margins are shown as a dotted 
red line. A grid of closely spaced orange dots appears over the paper, the minor grid, with a grid of black dots at a 
wider spacing, the major grid. We will refer to the virtual A4 paper seen on screen simply as paper in future. 

Move the mouse over the paper, and the status bar to the right-hand side will report the XY coordinates of the 
mouse position in centimetres. The orange (minor) and black (major) grids can be used as a guide when positioning 
objects on the paper – you can also arrange for the objects to snap to the grid if you wish. 

Publish Grid 

 Click on the Publish Grid button which is next to the last button on the top horizontal toolbar. The 
orange and black dots will disappear and a cross will appear in the button. Click on the button again to restore the 
grid. You can also control the Publish Grid status using the Environment Options General tab. Turning off the grid 
also turns off  Snap to Grid until the grid is restored to view. 

Publish Options 
Select Publish from the Options menu to show the Publish Options dialog box, figure 3-28. Trace/DD Penwidth 
determines the thickness of trace and dot-density lines and dots.  Border determines the style and width of any 
border lines which may be placeded at the margins, (the optional border facility can be turned on and off in the 
Publish menu). North Sign determines the style of the north symbol to be displayed. Font Properties determines the 
default text style used when adding text to your publish document. Page Gridding allows you to define the colours 
and spacing of the major and minor publish grid. The check-box allows you to determine whether Snap to Grid will 
be available. Click Cancel to close this form. 
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Publish New, Open, Save, Save As and Clear 
Pull down the Publish menu. You will see that publish documents have their own New, Open, Save, Save As and 
Clear functions - they are separate from the File menu which relates only to the grid and composite data sets. The 
one exception to this is Print on the File menu which adapts its function to the current main screen view, be it 
graphics, data, history, file details or publish view. 

 

 

Figure 3-27.  Typical main screen for a new publish document. 

 

 

Figure 3-28.  Typical Publish Options dialog box. 
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Saving a Graphics Plot for Publish 
Press F5 to return to the graphics view. Display the shade plot dialog box and return the plotting parameters back to 
: minimum = -3, maximum = +3, contrast = 1, units = Std Dev, and Palette = grey55. Note that the header at the top 
of the screen now returns back to reporting Gradiometer data and file path of : “c:\geoplot\comp\gmeadow\1czi.cmp 
+++”. Select Save Graphic Plot from the Graphics menu. A message will appear saying “Data has not been saved. 
Please save data before saving bitmap”. This message appears because the  present graphics view is showing 
processed but unsaved data i.e. it has a file name with suffix “+++”. To save a graphics plot for import into Publish 
the processed or edited data set of the graphics plot must have been saved. Save the current processed data set using 
the file menu or SaveAs button with the name 1czil. Now select Save Graphic Plot from the Graphics menu (or 
press Ctrl+G) and a save dialog box will appear. The Directories setting is determined by the settings made in File 
Paths options for Save (Export) Graphics Plot. Normally it is a good idea to change the default File Path Options for 
saving graphics plots to include a sub-directory corresponding with different sites or projects but for now just accept 
the default, type 1czil in the FileName box and click OK. 

Save Graphic Plot saves not only the current graphics plot as a bitmap, but also a bitmap image of the graphics 
scalebar, and a bitmap image of the histogram. These bitmaps can subsequently be imported into the publish view, 
at a specific scale, for publishing. Alternatively, you can use the saved bitmaps for exporting to other Windows 
packages. There are separate Save commands in the Graphics Menu for Palette ScaleBar and Histogram should you 
wish to save these individually for import into some other Windows package. 

When a bitmap is saved it has stored with it the location of the original data set in a file which also records 
information about plotting parameters, whether the survey grid is overlain, type of graphic etc.  This is so that when 
printing a Publish document, Geoplot can access the original data set which will give a high quality printout, 
regardless of the resolution at which the bitmap was originally saved. It is therefore imperative you do not 
subsequently move the data files from their original location, otherwise the Publish view will not be able to locate 
the data. 

Importing a Graphics Plot for Publish 
Press F9 to return to the publish view. Select Import Graphic Plot from the Publish menu, (not  Import Bitmap) and 
the dialog box shown in figure 3-29 will appear. 

 

Getting Images into Publish 

Use Import Graphic Plot on the Publish menu to import a graphics plot previously saved using the 
Graphics menu. Use Import MetaFiles and Import Bitmaps to import files generated by other 
packages eg company logo. 

 

 

 

Figure 3-29.  Typical Import Graphic Plot dialog box. 
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You will find the name of the file that we have just saved in the graphics view appears in the list box, except it now 
has an extension of .bmp to indicate it is a bitmap, not a data file. Click once to select that name so that it appears in 
the Graphic Plot Name box. Print Scale allows you to set the scale of the printed graphic plot regardless of the size 
of the bitmap. Associate Objects allows you to determine which additional objects are imported into the publish 
document, along with the graphics plot. For now just accept the defaults and click OK to import the graphic plot and 
associate objects. A collection of objects will appear in the top left-hand corner of the paper. 

 Since the objects are at a small scale, increase the size one step by either typing Ctrl+M, selecting the 
Zoom In button from the horizontal toolbar or use the View menu – just as we did for a graphics plot. Note that a 
scroll bar may have appeared on the right-hand side, depending on your screen resolution, to help navigate around 
the plot.  

 Note that, apart from Zoom Out, the other Zoom buttons used in graphics view are not available in the 
Publish View. 

We will now move all the objects, except the graphics plot, over to the right-hand side, but still within the margins, 
in the following sequence : north symbol, 40m distance, dimensional scalebar, nT units, shade scalebar calibration 
and lastly the shade scalebar. To move the north symbol, move the mouse over its centre, left click on it and a 
rectangular outline will appear. Keep the left key depressed and drag the object to its new position then release the 
key. See figure 3-30 for an indication of the new positions we are aiming for. Move all the other objects to their new 
positions - if you have difficulty finding the centre (as may occur over the dimensional scalebar) you can increase 
the size with the Zoom In button to make it easier, move the object to its new location then reduce the size back 
down again. Some objects (north symbol, histogram, dimensional scalebar, and the shade scalebar) can be resized so 
you may see the cursor change to a double arrow as it passes over the edge of an object. Make sure the cursor 
returns back to a pointer over the centre of a sizeable object before trying to move it. Lastly move the graphics plot 
so that it is within the margins, with its top edge about 7.5cm below the top edge of the paper. You should have 
noticed that some of the objects snapped to the grid when you placed them. 

You can display the properties of each object by right-clicking on them. This will display a form that gives the 
current position of the top left-hand corner of the object, information about the source bitmap and source data set, 
and a button that enables you to delete the object. Objects that involve text additionally show the current font 
properties, the graphics plot also gives further information about the associated objects etc. and objects that can be 
resized give their dimensions. Right-click on each object in turn to see this, leaving each one by clicking on OK.  

 

 

Figure 3-30.  Complete demonstration publication document. 
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You can also move an object by editing the current position in the properties box – try this for the dimensional 
scalebar for example and you will see it instantly move as the Left and Top values are changed.  

The north symbol, histogram, dimensional scalebar and the shade scalebar can be resized. To do this move the 
mouse over the edge of the object until you see the cursor change to a double arrow. Left click at this point and keep 
the mouse depressed as you change the dimensions of the object. Note that the dimensional scalebar can only have 
its width changed, not its length since it must be printed out to the correct scale. You can also change the 
dimensions of objects using the properties form. Try changing the sizes of the above objects by both methods so 
they look similar in relative size to those shown in figure 3-30.  

Right-click on the graphics plot to show the properties form. The graphics plot can be rotated in 90 degree steps by 
changing the Image View setting. Change it from Front to Left. You will see the matching north symbol has now 
rotated through 90 degrees so that it points upwards. Now click OK and you will see the graphics plot has been 
replaced by a rectangle with diagonal lines and a red spot in the bottom-left hand corner. If you were to print out the 
publish document at this stage you would find the image had been rotated through 90 degrees, in line with the north 
symbol rotation. It is not possible to show the rotated image directly in publish so the new location of the original 
top right-hand corner is denoted by the red spot. Right-click on the graphics plot again and restore Image View to 
Front and click OK to undo the rotation. You could also have rotated the original data when it was in the graphics 
view by using Rotate on the Edit menu and then saving it, before importing it into Publish. 

Right-click on the nT units to show the properties form. The font properties can be changed using this form – try 
changing the font, making the font size larger and checking bold. You will see these changes instantly if nT is not 
covered by the form. Change the font properties back to their original values and click OK. All text objects can be 
changed in this way using the properties form. 

 

Adding, Moving and Editing Publish Objects 

You can add text, shapes and lines using the drawing toolbar on the right-hand side or the Draw and 
Publish menus. Imported objects can be moved around by dragging with the mouse. You can 
display and change their properties by right-clicking on them. Text, shapes and lines can only be 
edited and moved by right-clicking on them and changing their properties. 

 

 

We will now save the publication as it is so far, so that should we make any mistakes we can resume publishing 
again at this stage. Select Save As from the Publish menu, not Save As from the File menu. A typical SaveAs dialog 
box is now shown, except that this time it is for saving a publish document. The Directories setting is determined by 
the settings made in File Paths options for Published Document. Normally it is a good idea to change the default 
File Path Options for saving publish documents to include a sub-directory corresponding with different sites or 
projects but for now just accept the default, type 1 in the FileName box and click OK. The heading at the top of the 
screen will change to include this file name and its path. 

Now we will import another graphic plot. Press F5 to return to the graphics view and open the resistance data we 
processed earlier, rgrv\1k.cmp. Use Save Graphic Plot on the Graphics menu to save this data set as a bitmap, with 
file name 1k and then press F9 to return back to the publish view. Select Import Graphic Plot on the Publish menu 
to display the Import Graphic Plot dialog box. This time uncheck North Symbol and Distance Scale, since we 
already have these present and correct from the gradiometer data. Select file 1k, click OK and when the objects are 
displayed in the top left-hand corner, move them to the approximate locations shown in figure 3-30 and resize them. 
Note that once again three crosses have appeared next to the file name at the top of the screen indicating changes 
have been made but not saved. 

Write Text  

 Click on the Write Text button which is the last but one on the drawing toolbar or select it from the 
Publish menu. A dialog box headed New Text will appear. Click on Edit Text and another dialog box called Text 
Editor will appear below the New Text dialog box. Type in the text : Gradiometer and Resistance Data and 
Click OK in the Text Editor dialog box. Both dialog boxes will disappear and the text just typed in will appear in 
the top left-hand corner. Drag the text inside the margins and then right-click on it to reveal the property form. 
Change the font to 24 point and Bold. You will see the text change immediately. Click on OK to accept this and 
move the north symbol out of the way if it obscures the text slightly. To edit any existing text move the mouse over 
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the text and right-click to reveal the Text properties. Click on Edit Text and the Text Editor dialog box will appear 
allowing you to edit the text or change the Text properties. 

Pointer 

 If you click on a drawing toolbar button but then decide, before you draw anything, that you do not after 
all want to draw a shape or line, you can make the mouse cursor revert back to the normal pointer shape by clicking 
on the Pointer toolbar button at the top of the drawing toolbar. Note if you draw a shape or line by mistake then 
you must right-click on it before you can delete it using the property form – see below. 

Draw Rectangle 

 Click on the Draw Rectangle button which is fourth down on the drawing toolbar, and move the mouse 
a little way under the text we have just written. The cursor will have changed to a cross. Press down the left-key 
and, whilst keeping it depressed, draw out a rectangle similar to the one shown in figure 3-30. You have just drawn 
a rectangle that has transparent fill, ie one with no pattern in its centre, and which can have other objects placed 
within it or over it. You can also activate Draw Rectangle from the Draw Menu by selecting Rectangle, Transparent. 
There are a range of other shapes and fills of various colours and patterns available from the toolbar or Draw menu. 
Move the mouse over the edge of the rectangle until the resize cursor appears and right-click to show the property 
form, figure 3-31 – you can display the property form of other shapes in a similar fashion, ie by moving the mouse 
over the edge of the shape and right-clicking. 

 

 

Figure 3-31.  Typical shape properties dialog box. 

You can resize shapes by using the mouse but you cannot move them. Instead you must use the Shape property form 
to alter their position by changing the values in Left and Top. You can also alter many of the other properties when 
the form is displayed. Try changing the Outline to Oval and Fill to Pattern and you will see the shape immediately 
transformed. Change these properties back to their original settings : Outline = Rectangle and Fill = Transparent and 
click OK. Resize the object until it has a relative size as shown in figure 3-30.  

Use the Write Text button to create the text : Publication Demonstration. Change the font size to 18 point, Bold 
and drag the text to inside the rectangle. So we do not lose our work to date, save the publication document by 
selecting Save from the Publish menu and continue with the tutorial. 

Line 

 Use the scroll bar at the right-hand side of the screen to expose the lower part of the paper. To draw a line 
similar to that shown in figure 3-30 click on the Line toolbar button and, just as for a shape, the mouse cursor will 
change into a cross ready for drawing. This time, hold down the Shift key and position the mouse to the left-hand 
side, underneath the graphic plot of rgrv\1k.cmp. Whilst keeping the left mouse key pressed down, draw a line to the 
right-hand side and release the mouse. Keeping the Shift key depressed ensures the line can be only drawn 
horizontally, vertically or at 45 degrees. If you do not hold down the Shift key the line can be drawn at any angle. 
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Position the mouse at either end of the line, until the mouse cursor changes to four arrows and then right-click. This 
will reveal the properties form for the line which allows you to change the form of the line : colour, width and style, 
and its position. You can only change the position of the line by editing the start and end XY coordinates in the 
property form.  

Import Bitmap / Import Metafile 
Select Import Bitmap from the Publish menu and the Import Bitmap dialog box will be shown. The Directories 
setting is determined by the settings made in File Paths options for Image Import (*.bmp, *.wmf). Select the file 
Geoscan.bmp and click OK. Reduce the magnification so that the whole page can be seen – a new object will have 
appeared in the top left-hand corner. Keep the left mouse key depressed over the object and drag it to a position on 
the right-hand side, below the line we have just drawn. Resize the object so that it has similar proportions to that 
shown in figure 3-30. We have just imported the Geoscan Research logo but this could have been any bitmap.  Note 
that you can resize imported bitmaps but you cannot resize imported graphics plots – these have their scale fixed 
when you import them. Windows metafiles can be imported in a very similar way to the importation of bitmaps. 

 

Graphics Plot Layering 

You cannot place objects (text, rectangles, circles etc) directly over a graphics plot but can move 
them over the plot by editing their positional properties. If an object is positioned in the same region 
as a graphics plot it may appear on screen hidden behind the graphics plot. However, it will be 
printed out correctly on top of a graphics plot. To make an object appear in front of a graphics plot 
on screen, right click on the graphics plot to display its properties, and click OK - this sets the 
graphics plot Layering to Back. 

 

Positioning Text or a Shape Over a Graphics Plot 
Finally, we will position some text over a graphics plot – you might want to do this to identify features in a report. 
Create the short piece of text : Text using the Write Text toolbar button and make sure the font is 24 point, Bold. 
Right click on the graphics plot of the second survey we imported, rgrv\1k.cmp. Note that Layering in the properties 
form will be set to Back. This will ensure that the graphics image will be in the background and any text we move 
over the graphics plot will be at the front and thus visible.  

You can only move the Text over graphics plot using the Text properties box. Right click on the text to display its 
properties. Change the Left and Top entries so that the text is positioned over the graphics plot in a visible position 
and click on OK – see for example figure 3-30. You can if you wish right-click on the text again and reposition it 
slightly using the same method. Although you will see a white box surrounding the text on the screen, the text only 
will appear on the print-out. Save the publish document before we print it out. 

Hardcopy 
Make sure all of the publish document is visible on screen, as in figure 3-27, by using the Zoom Out or Ctrl-N. If 
you do not do this your published document may be printed out in more than one section. Select Print from the File 
menu to display the standard Windows Print dialog form which allows you to change printer Options etc. To start 
off with, set your printer to a medium resolution (of 300 - 360dpi) and click on OK to start the print-out. You will 
see a series of blue completion bars on the status bar as a graphics of each object is sent to the printer driver. 
Remember that the graphics plots printed out are not just copies of the bitmaps used in the publish view but are 
generated directly from the original data set and show all the data possible at the chosen printer resolution. 

When you print out a published document, a large quantity of interim print data may be created, depending on the 
complexity of the document, and the printer driver settings, including resolution, half-toning method, colour or 
black ink, fine detail mode and indeed the printer itself. To create this interim print data a large quantity of both 
Virtual Memory and free hard disk space (eg 100Mb) may be required. If this is not available then the print job may 
be lost or may be greatly slowed down. If you have limited resources available and experience such problems 
printing then reduce the amount of memory or hard disk space required by reducing the printer resolution, choose 
black ink only, deselect fine detail mode etc. For example reducing resolution from 720/1440dpi down to 360dpi 
may solve the problem with little difference in final appearance. 
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Preserving the Published Document Structure  
Although a published document appears to be complete on screen, it is actually stored as a text file that defines the 
relative positions of all the objects that you see on screen (and on paper). The text file refers to graphics plots, 
bitmaps and metafiles by their path names – it does not actually embed graphic images in the document file. It is 
therefore vitally important that the original file can be located whenever you open up a published document. If the 
file is no longer at its original location the published document will not open properly. Bear this in mind when 
backing up data, restoring data or relocating data.  

For example, the publish tutorial shown earlier saved a graphics plot of "c:\geoplot\comp\gmeadow\1czil.cmp" 
(plotted with palette "c:\geoplot\palette\grey55.ptt") as a bitmap with file name "c:\geoplot\expimg\1czil.bmp". 
Reference is made in the published document text file to all three files, including the palette used, so these must be 
preserved in their original locations for a published document to open properly. However, since the published 
document is simply a text file you can edit this if you want to change a file path location. 

Exploring Geoplot Further 
We have been able to only cover a small fraction of Geoplot’s facilities in this tutorial. Areas that we have not 
explored include : data input via keyboard, download of data from instruments, import of data, export of data, 
generation of stacked pseudo-sections, and further edit facilities and process functions. These are discussed in the 
following chapters. Chapter 5 also includes a comprehensive discussion of recommended processing techniques for 
different types of data. Further examples of the use of combined process functions are given, including the creation 
of contour lines and overlaying of these on shade plots – these illustrate the power that lies within the process tools, 
beyond their everyday application. 
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Chapter 4  

DATA  INPUT 

Introduction 
Data may be input into Geoplot in three different ways : (a) transfer of data from a data-logger via the RS232 port, 
called Download Data on the File menu, (b) manual entry of data from paper records, called Keyboard Input on the 
File menu or (c) from a disk file from another program, eg in ASCII or XYZ format, called Import Data on the File 
menu. Imported data may be input and stored in either grid or composite format whereas data-logger and manual 
entry data may only be input and stored in grid format.  

In all cases an Input Template is used to define details about the data to be input, such as sitename, grid or 
composite size, sample and traverse interval, traverse mode, instrumentation, accessories etc. The Input Template 
details can be predefined with your standard survey details, for routine input, or input details can be defined just 
prior to data input. The input details are subsequently stored with each data set and form the basis of the grid and 
composite information files. It is very important that these details are properly defined for correct input of data into 
Geoplot. 

The general procedure for inputting data into Geoplot can be summarised as follows : 

• Collect data using correct survey strategy. 
• Select Input method from File menu :– Download Data, Keyboard Input or Import. 
• Choose grid or composite for Import – other methods can only be in grid format. 
• Specify Survey Type and Instrumentation. 
• Enter Input Template details, including sitename. 
• Follow instructions specific to each method. 
• Data is stored in path defined by sitename and default directory. 
 

A Predefined Input Template can be used which will enable items 3 – 5 in the above list to be completed in one 
step, which helps avoid detail entry errors. The two most important steps for successful input of data into Geoplot 
are : (a) collect data using the correct survey strategy and (b) enter the input template details correctly. Special 
emphasis of these two points is made in the following text – please follow the instructions carefully. 

    IMPORTANT 

It is very important to : (a) collect data using the correct survey strategy, and (b) enter the 
survey details into an Input Template correctly. Failure to follow these points may result in 
loss of your field data. Read the following information carefully. 

 

 

This chapter is divided into the following main topics : Survey Strategy, Data Storage, Input Templates, Download 
Data, Keyboard Input, Import Data, Reference Section for Grid Input Templates (this includes download details for 
the RM15/MPX15 configurations and Dual FM256 Gradiometer configurations). 
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Survey Strategy 
There are some very specific requirements for data input that must be satisfied if you are to make maximum use of 
the way Geoplot is structured and maximum use of the process functions. If you do not adhere to these requirements 
you may be very limited in what you can subsequently do with the data. At the very least you may generate extra 
work for yourself. At the very worst you may find you can do nothing with the data at all. It is therefore extremely 
important that you : (a) understand the implications before starting your survey and (b) define and use a survey 
strategy that complies with these requirements. These general requirements are discussed below and specific 
requirements are summarised in a warning box at the start of each input method.  

As we have already seen in the Tutorial, Geoplot is primarily structured to input data in grid format, a master grid is 
then used to define how these grids fit next to one another, and finally a composite is generated for processing the 
data. This is a fast and easy way to handle small blocks of data and then combine them later on. The following 
points all relate to this strategy. 

Consistent Grid Size, Survey Pattern and Orientation. 

For each site, always use grids that have the same size, sample and traverse interval, traverse direction and 
orientation - this will meet the requirements of a master grid. Whilst you could use the Edit Menu to rotate grids, to 
correct for inconsistent traverse directions, if some of the grids are not symetrical in terms of readings and physical 
size, and you rotate through 90 or 270 degrees, you will not be able to assemble a composite from a master grid. 

The only course of action then would be to create individual composites from each grid and then use the process Cut 
and Combine function to reassemble the survey, piece by piece. This will be extremely time consuming to do. It is 
far better to do the survey correctly in the first place. More importantly, if you cannot create a composite directly 
from grids you will not be able to use many of the grid or traverse based process functions such as Zero Mean Grid, 
Edge Match, Zero Mean Traverse etc. This will limit greatly what you can subsequently do with the data. 

 

 

Figure 4-1.  Acceptable survey pattern and strategy – sample and traverse intervals identical. 

Geoplot Traverse Direction 

When data is input into Geoplot it will be stored such that the first row of readings will be displayed (in Data View 
or Graphics) horizontally with respect to the computer screen, with the first reading being in the top left hand 
corner. This horizontal direction is always understood to be the traverse direction by many process functions, so you 
should make sure the actual traverse direction made in the field corresponds to this when data is input. If the 
traverse direction is not horizontal with respect to the computer screen then you will not be able to use many of the 
traverse based process functions such as Zero Mean Traverse or Periodic Defect. 

Downloaded data from Geoscan instruments should usually meet this requirement, providing you plan the survey so 
as to avoid rotation of grids in order to assemble a master grid.  

For Imported data and manually entered data you should make sure that the first row of input data is in fact 
equivalent to the first traverse made with the instrument. Plan the survey so as to avoid having to rotate all grids to 
achieve this, thus avoiding unneccessary additional work. If you have to rotate grids through 90 or 270 degrees the 
traverse direction will not align with the horizontal of the screen. However, rotation through 180 degrees is 
acceptable. 

Survey Traverse Direction 

When collecting data with Geoscan instruments, always arrange for the first traverse in a grid to be in a clockwise 
direction from the first reading. If you imagine looking at a plan view of a grid, the first reading could be in any of 
the four corners, figure 4-2. Geoplot expects the first traverse of Downloaded data to always be in a clockwise 
direction from this first reading. If your first traverse is in the opposite direction the data will be interpreted 
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incorrectly, resulting in a mirror image. Whilst you can correct for this using the Edit menu, it will be time 
consuming and inefficient. Make sure all grids are surveyed with the start position in the same relative corner. 

 

 

Figure 4-2.  Acceptable traverse start points and direction (clockwise). 

Dummy Readings 

Regardless of input method, you must ensure that regions where data does not exist are filled in with dummy 
readings. This will ensure the correct calculation of grid and composite statistics. Simply leaving the data value as a 
zero will not be good enough. The default dummy reading, set in Environment Options is 2047.5, which is 
compatible with Geoscan Research instruments, but can be changed to any other value. 

If you are surveying with a Geoscan Data-Logger then you can use the instrument DUMMY, FINISH LINE or 
IMAGE LINE keys to fill unsurveyed regions with dummy readings. If you are inputting data manually you can use 
the “d” key to easily enter a dummy reading and move the cursor onto the next cell. If you are importing data then 
ensure the Import Dummy Value setting equals the dummy reading used in the survey.  

If you have not used any of the above methods of dealing with dummy readings then you should either edit each 
grid accordingly (an inefficient method if large areas are involved), or use the process functions to insert dummy 
readings when data is assembled in the composite format (the most efficient method if large areas are involved). 

Geoscan Research Data-Loggers 

It is extremely important to realise that you can only have one grid size, sample interval, traverse mode etc specified 
in Geoscan instruments for any one surveying session before dumping data - you must not mix grid sizes, sampling 
intervals by changing the menu settings. If you do so the data will certainly be scrambled and may probably be 
unretrievable, especially if, for example, Log Zero Drift is set to On. If you need to survey a site with mixed grid 
sizes, sampling intervals etc then you must dump data between each change of grid size etc on the instrument, 
setting up the input details accordingly each time. However, this method of surveying is not to be recommended 
since many of the Process functions depend on a uniform grid size, sampling interval etc and you will not be able to 
use them on master grids or composites if this is not the case - see earlier comments. 

It is a very good idea to standardise on one grid size and survey pattern for each site. Do not consider mixing this 
grid size with another smaller grid size if you need to cover smaller areas with dummy readings - instead use your 
standard grid and use the FINISH LINE and IMAGE LINE keyboard commands on the instrument to insert dummy 
readings. 

Batch Input 

Inputting a group of data sets as a batch can only work for data sets that are identical in form, that is, they must have 
the same dimensions, sampling intervals, traverse mode etc as specified in the input details. If these details are 
different for some data sets then you must break the batch down into smaller groups where the input details will be 
identical for each member of a group. If you try to input a batch of data sets that have a mixture of input details the 
data will certainly be scrambled and may probably be unretrievable, especially if, for example, Log Zero Drift is set 
to On. 

Importing Data - Grid versus Composite Format 

Data can be imported in either grid or composite format. Always try to input data in grid format if possible since it 
will be much easier to re-assemble the data using a master grid, and you will also then have access to process 
functions that operate on grid positions within the composite, for example Zero Mean Grid, Zero Mean Traverse and 
Edge Match. Input of data in composite format is intended for data sets which cannot be accommodated by the grid 
format, usually because they are much too large for a grid or because their size does not match the predefined grid 
sizes that Geoplot uses.   
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Data Storage 
Default File Paths 
Unless there is special provision on a dialog box (eg for Import), Geoplot uses a combination of the Options Default 
File Path settings and a directory equal to the sitename (entered in a dialog box) to determine the file path structure 
in which to store and retrieve grids, master grids and composites. For example, a grid (filename) with the name 
"resgrid1" in site "resgrove" would be stored in the following way, if using the default File Path settings (the spaces 
are included only for clarity) : 

c:\geoplot\grid  \resgrove \resgrid1   (.dat .grd .grs) 

  Default File Path     Sitename      Grid 

Each grid actually comprises three files, with extensions .dat, .grd and .grs, and these are shown in brackets at the 
right hand side. Similarily, a composite (also consisting of three files) with name “rescomp1” in site “resgrove” 
would be stored thus : 

c:\geoplot\comp  \resgrove \rescomp1   (.cmp .cmd .cms) 

  Default File Path     Sitename      Composite 

Likewise, a corresponding master grid, “resmesh1” would be stored in the following way : 

c:\geoplot\mesh  \resgrove \resmesh1   (.plm) 

  Default File Path     Sitename      Master Grid 

A grid input template with name "resinput", used possibly to input the grids of site resgrove, would be stored in the 
Input Template default File Path  (note there is no sitename involved now) : 

  c:\geoplot\input  \resinput    (.gip) 

  Default File Path  Grid Input Template 

Likewise, a composite input template with name "resinput would be stored in the following way : 

  c:\geoplot\input  \resinput    (.cip) 

  Default File Path  Composite Input Template 

Import data, eg file 1.xyz, should be placed in the Data Import default File Path, ready for importation  : 

  c:\geoplot\eidata  \1.xyz 

  Default File Path  File for import 

You are free to define whatever Default File Paths you wish (data must be in a sub-directory, never a root directory) 
but if you want to use data from Geoplot version 1.2 you may decide to change the Default File Path entries to 
specific definitions which differ from the default values supplied with this version of Geoplot. We recommend you 
use the default settings supplied if you are a new Geoplot user, or, if you have a lot of Geoplot 1.2 data already, then 
consider rearranging your data to conform with the new default settings. 

Filenames and Directories 
Whilst you are free in principal to devise whatever names you like for the Default File Paths and filenames, the 
DOS operating system places certain restrictions on the characters you can use. The characters that you can use for 
directories and filenames are as follows : 

• The letters A-Z. Upper and lower case are not distinguished between. 
• The digits 0-9 
• The special characters ! @ # $ % ^ & ( ) _ - ~ ' { } 
 
The characters that DOS does not allow you to use for directories and filenames are as follows :  

• * + = [ ] : ; " , . ? / | < > \ space, tab, and any control character. 
 
If you try to use the disallowed characters for directories or filenames anywhere in Geoplot then the computer will 
beep and will not accept the key press. However, there is one exception to this rule that Geoplot allows. When 
defining the file paths the characters \ . :   need to be used. Geoplot will therefore accept entry of these characters in 
those lines only. All filenames and directories are limited to 8 characters maximum. Longer filenames created 
outside of Geoplot will be viewed truncated in Geoplot ending with the “~” character and a number, eg filena~1.dat. 
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Suggestions for Sitenames and Filenames 
Table 4-1 shows two possible naming convention for sites, grids, meshes and composites. Both have their 
advantages and disadvantages, and of course there are many other possibilities also.  

    Sitename Grids   Master Grids Composites 

Naming Convention 1:  

Resistance Survey  rgrv  1, 2, 3  1  1 

      4, 5, 6  2  2 

Magnetometer Survey mgrv  1, 2, 3  1  1 

      4, 5, 6  2  2 

Naming Convention 2: 

Resistance Survey  groveres  grvr1, grvr2,  grvr1  grvr1 

      grvr3, grvr4 grvr2  grvr2 

      grvr5, grvr6 

 Magnetometer Survey grovemag grvm1, grvm2,  grvm1  grvm1 

      grvm3, grvm4,  grvm2  grvm2 

      grvm5, grvm5 

Table 4-1.  Two possible naming conventions for resistance and gradiometer surveys of the same site. 

The first site naming convention has the sitename start with a letter signifying the survey type : "r" for resistance 
and "m" for magnetometer. This has the advantage of ensuring similar survey types are grouped together when 
generating a sorted list, and are visually identifiable by looking at the first letter. You could use, for example, the 
following convention for the first letter : 

  r Resistance  g Gradiometer 
  m Magnetometer  e Electromagnetic 
  i Induced Polarisation x Magnetic Susceptibility 
  p Pulse Induction  v Viscosity 

 
The second site name convention identifies survey type using three letters at the end of a longer sitename, making 
identification easier still. Placing the three letters at the beginning might be better if sorting is important to you. The 
first convention uses a much shorter name for the site than the second convention. This is quicker to type in but is 
not so descriptive as the second convention, as well as offering fewer permutations. 

For grids, master grids and composite, the first convention simply uses numbers. Remember that you can only use 
this approach if you define distinctive site/survey names. It makes typing names in much quicker, especially when 
defining a master grid, or list of filenames for downloading, though quick entry methods are available to speed entry 
of longer more complex names, as are used in the second convention. However, when it comes to backing up, 
copying or moving data the chances of overwriting (and thus losing) files is much reduced by using longer and more 
descriptive sitenames and filenames, as in the second convention.  

Bear in mind that data collected with the FM256 system operated in dual gradiometer mode will have two separate 
data sets collected per grid, one for each gradiometer, which might well be stored under the same sitename. You 
could differentiate between them using, for example names such as 1a (slave data) and 1b (master data). These will 
be eventually merged to form the overall grid 1, though this will be done at the composite stage – see the Reference 
section later in this chapter and Processing Techniques in Chapter 6 for further details. 

    WARNING 

You should not use "DUMMY" as the name for a grid file since Geoplot uses this special 
name to identify grids which are full of dummy data in a master grid – this is to maintain 
compatibility with earlier versions.  
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When you are in the Geoplot environment you will always be warned if you are about to overwrite an existing file 
and given the chance to abort the operation. Indeed, Geoplot will not allow you to overwrite a raw grid data file – 
they are termed protected files. Separating grid, master grid and composite data from each other by defining 
different Default File Paths helps considerably in reducing the chance of overwriting existing data files when 
outside of the Geoplot environment.  

There is one very useful advantage of keeping a composite name short. It allows you the freedom to store processed 
composites with shorthand signatures for the process functions applied, making them much easier to distinguish. 
For example composite name "1kzl2g" could be used to remind you that the following process functions had been 
applied to composite 1: Despike, Zero Mean Traverse, Low Pass Filter of radius 2 with Gaussian weighting (the 
letters are derived from the underlining used in the Process menu. You could use a similar shorthand convention 
when editing grids and master grids. For example an edited version of grid "1" could be renamed "1e", the "e" 
standing for edited. 

You will probably have only a few Input templates, so the naming convention is not so critical. You will probably 
define one input template at each site so the simplest convention is just to give it the same name as the site, or 
alternatively a name relating to the survey type. This latter suggestion is most attractive if you have adopted a 
standard survey strategy for a given survey/instrument type. If you carry out more than one survey type at each site 
be sure to distinguish this with different Input Template names. 

Data Backup 
In its normal operation, Geoplot will not allow you to over-write primary grid data (though edited grid data can be 
overwritten if you confirm this is acceptable). Note, however, that the primary grid files are not write protected by 
setting a file attribute. Instead, a flag is set in the grid information file to indicate to Geoplot that the data should not 
be overwritten. This flag will only be looked at by Geoplot and not by any other application. This means, for 
example, that Windows Explorer could be used to over-write or delete your data. You are therefore strongly advised 
to make back-up copies of all your primary (grid) survey data at least, since there is no mechanism to stop other 
applications overwriting your data files. Similarily, since there is no mechanism to protect other Geoplot files then, 
it is also advisable to make back-ups of your master grids, input templates and composites. Remember that grids and 
composites each consist of three files, all of which need backing up – see Basic Concepts Reference Card.  

Input Templates 
Introduction 
An input template is a file that documents survey details (such as size of the data set and instrumentation) and is 
designed for use as an aid to inputting data into grids or composites. Since data can be input into grid or composite 
format, provision is made for separate grid and composite input templates. The input template documentation is 
stored with each grid and composite, for later use by Geoplot. 

 It is usual to pre-define an input template for a site, though it can optionally be defined each time during the data 
input phase. Input templates can be saved, opened and edited just like normal files, so you can easily create a range 
of pre-defined templates for different instruments or survey requirements. Note that an input template is only a text 
file, it does not contain data, nor does it refer to any specific grid or composite, and as a consequence it does not 
have any associated statistics or histogram. 

New Template 
To create a new template select New Template from the File menu. A dialog box like that of figure 4-3 will appear 
which allows you to specify survey type, instrument and whether the template should be for grids or composites. 

First select the Survey Type – as you change this selection the Instrument list box contents will change to match the 
choice. Next, single click on one of the items in the Instrument list box. If you are not using Geoscan Research 
instruments then choose User Defined from the list box. If the survey type is not listed then choose User Defined in 
the Survey Type selection box. Click on either grid or composite template. As an example, we will define a grid 
input template for general purpose use with a standard RM15/PA5 system. Select Survey Type = Resistance, 
Instrument = RM15, and Template Type = Grid. Note that there are four possible choices of RM15 instrument and 
it is crucial if you are using an MPX15 multiplexer that you make the correct choice, otherwise the data maynot be 
assembled correctly. This is discussed further in the Reference section at the end of this chapter. Press Next to 
continue. 
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Grid Input Template 
A grid input template will then be shown, figure 4-4. This dialog box consists of two tabs. The first tab allows entry 
of Acquisition details, Instrumentation details and Comments. The second tab allows entry of Accessory details. 
These input details include sitename, map reference, direction of the first traverse, grid length, sample interval, 
grid width, traverse interval, traverse mode, survey type, instrument, instrumentation details and comments field. 
The input details will be automatically stored in the grid information file when the data is input. 

 

 

Figure 4-3.  Dialog box for defining a New Input Template. 

 

Figure 4-4.  Typical dialog box for creating a Grid Input Template - first tab. 
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Entry of the sitename is optional at this stage - if you do not do it at this point you will be asked to when it comes to 
actually inputting the data. For general purpose use you would not make an entry at this stage. Entry in the Map 
Reference field is optional. The Direction of First Traverse field may be set to one of the following: N, NNE, NE, 
ENE, E, ESE, SE, SSE, S, SSW, SW, WSW, W, WNW, NW, or NNW and defines the heading of the first traverse 
surveyed. This information will be used to orientate the North symbol correctly in graphics plots. It is especially 
important that you enter the dimensional and sampling details correctly, being particularily careful to differentiate 
between grid length and width and between sample interval and traverse interval. If Traverse Mode is set to Zig-
Zag, and data is being dumped from a Geoscan instrument, then Geoplot will correct for the way the data was 
collected, reversing every other line of data as it is dumped. If Grid Traverse Mode is set to Parallel or data is being 
imported or manually entered then no correction will be made.  

The Survey Type, Instrument and Units fields will already have entries made in them. The fields appearing in the 
Instrumentation group will depend on the Instrument specified previously and are discussed further in the Reference 
section at the end of this chapter. It is very important that these details match the instrument settings, especially Log 
Zero Drift Status for the Fluxgate Gradiometers. Likewise, the Accessories tab settings are especially important for 
the MPX15 multiplexer. 

You can make whatever entries you like in the three Comments lines, for example details of survey conditions or 
problems with the batch of grids you will be dumping. As soon as you make any changes to the input template, 
“+++” is appended to the dialog box title to indicate changes have been made. 

 

 

Figure 4-5.  Typical dialog box for creating a Grid Input Template - second tab 

When you are satisfied with the entries made click Save As. This will reveal a standard Save As dialog box, with the 
highlight placed ready for you to enter the grid input template name. The default Directories setting is determined 
by the Default File Paths options for an input template. Since we are making this a general purpose input template, 
or prefined input template, for use with an RM15/PA5 non-multiplexed system we will call it “rmsingle”, where the 
“single” part distiguishes it from parallel or multiple logging sessions with the MPX15 – see the Reference section 
at the end of this chapter for further details. Type in rmsingle and click OK to save the template. You must not 
save any template with the name “0default” since this is a reserved name whose function is described later. The 
SaveAs dialog box will disappear, leaving behind the input template. Note that the title has now changed to : 
“c:\geoplot\iptem\rmsingle.gip” and that grid input templates have a file suffix of .gip. You can make further 
changes to the template and save it with a new name if you wish. Press Cancel twice to return back to the main 
screen. 
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Composite Input Template 
To create a composite input template, follow the same procedure as for defining a grid input template, ie select New 
Template from the File menu but this time set Template Type to Composite. The cautions given for grid input 
templates regarding correct selection of instrument type are not so critical here, since composite tnput templates are 
intended for import of data only. Instead you must pay much greater attention to the dimensional details. To 
compare the appearance and functionality of the two input template types we will use exactly the same settings as 
we did for the grid input template : select Survey Type = Resistance, Instrument = RM15, but this time Template 
Type = Composite. Click Next to preoceed. 

A composite input template will then be shown, figure 4-6. This dialog box allows entry of Composite Details and 
Source Grid. These input details include sitename, direction of the first traverse, composite length, sample 
interval, composite width, traverse interval, traverse mode, survey type, instrument, instrument units and the 
dimensions of the grids that make up the composite. The input details will be automatically stored in the composite 
information file when the data is input. 

 

 

Figure 4-6.  Typical dialog box for creating a Composite Input Template. 

Entry of the sitename is optional at this stage - if you do not do it at this point you will be asked to when it comes to 
actually inputting the data. For general purpose use you would not make an entry at this stage. The Direction of First 
Traverse field may be set to one of the following: N, NNE, NE, ENE, E, ESE, SE, SSE, S, SSW, SW, WSW, W, 
WNW, NW, or NNW and defines the heading of the first traverse surveyed. This information will be used to 
orientate the North symbol correctly in graphics plots.  

It is especially important that you enter the dimensional and sampling details correctly, being particularily careful 
to differentiate between grid length and width and between sample interval and traverse interval. Composite length 
and width must be entered in units of metres not readings - there is no need to add the "m" for meters since Geoplot 
will add this when the information file is stored. If the dimensions are not exact multiples of 10m then Geoplot will 
round up accordingly and fill in the extra reading positions with dummy readings. The Survey Type, Instrument and 
Units fields will already have entries made in them. 

If the input data was collected on a grid basis, then enter the source grid dimensions in Source Grid. This 
information is required if you propose to subsequently use any process functions that operate on grid positions such 
as Deslope, Edge Match, Spectrum and Periodic Defect. If the source grid dimensions are unknown or not relevant 
then just leave the default values as they are but do not attempt to use grid based process functions.  

As soon as you make any changes to the input template, “+++” is appended to the dialog box title to indicate 
changes have been made. When you are satisfied with the entries made click Save As. This will reveal a standard 
Save As dialog box, with the highlight placed ready for you to enter the composite input template name. The default 
Directories setting is determined by the Default File Paths options for an input template. This is the same directory 
used for storage of grid input templates but the two template types are distinguished by their suffixes : .gip and .cip 
for grid and composite types respectively. You must not save any template with the name “0default” since this is a 
reserved name whose function is described later. Once the template is saved, the SaveAs dialog box will disappear, 
leaving behind the input template. You can make further changes to the template and save it with a new name if you 
wish. Press Cancel twice to return back to the main screen. 
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Editing Input Templates 
Both grid and composite input templates can be edited by using Open Template on the File menu. You will be 
presented with a typical Open dialog box in which to select the template type, directory and its name. Once opened, 
make any changes and save these as outlined above, eithet using the same name or a new name. 

Download Data 
Introduction 
This section describes how to download data from Geoscan Instruments. As we have already seen, Geoplot has very 
specific requirements for the data format. It is extremely important to define and use a survey strategy that complies 
with these requirements. These were discussed earlier in some detail but are summarised here again : 

 

  DOWNLOAD DATA (from Geoscan Instrumentation) 

For each site, always use grids that have the same size, survey pattern and orientation. 

The initial traverse must be in a clockwise direction from the first reading, with respect to a 
plan view of a grid. 

Choose the traverse direction so that it will be horizontal with respect to the computer 
screen when grids are finally assembled using a master grid. Plan the survey so as to 
avoid rotation of grids to achieve this. 

Always complete unsurveyed parts of a grid with dummy readings using the instrument 
DUMMY, FINISH LINE or IMAGE LINE keys to ensure correct calculation of the grid 
statistics. 

Whilst logging data into the memory of Geoscan Research instrumentation you must not 
change grid size, sample or traverse interval, Log Zero Drift status etc. If you must make 
such changes always dump data before doing so. 

Input of several grids of data at the same time is only suitable for grids that are identical in 
form as specified in the input details (ie they must have the same size, same sample and 
traverse interval, same traverse mode, same traverse direction etc). 

 

 

Input Options 
Several options regarding download of data can be set in Environment Options, Input tab. These settings include the 
Comm port to be used for the RS232 link, the download progress report style, the default FM36 Log Zero Drift 
status that will appear in a new input template (not one that has already been defined), whether the current date and 
time will be recorded with the data and whether date style will be European or USA. Generally the default settings 
can be used, though of course they should be changed to suit your preferences or PC requirements – progress report 
style is discussed later on and in Chapter 6, Troubleshooting. 

Input Template Selection 
Select Download Data from the File menu, or type Ctrl+D. A dialog box appears that allows you to select either a 
predefined input template from a list box, or proceed to define input details next, figure 4-7. Note that download of 
data is always in grid format, never composite. 

If you select a predefined grid input template and click Next the selected template will be displayed. If you choose 
not to select a predefined input template, but leave “0default” highlighted in the list box, the next dialog box will be 
just the same as if you were starting to create a new input template. A form similar to that of figure 4-3 will appear, 
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except there will be no choice of grid or composite input template. Proceed just as though you were creating a new 
grid input template, entering the input details carefully. If a sitename has not been previously defined in the input 
template do so now. 

As an example of downloading data we will simulate downloading of the six grids of the “rgrv” tutorial resistance 
data. First highlight the general purpose grid input template "rmsingle" which we defined earlier and click Next to 
display the input template details. Type rgrv into the Sitename field. 

At this point you should always check the input details displayed very carefully before proceeding any further. It is 
especially important that you enter the dimensional and sampling details correctly, being particularily careful to 
differentiate between grid length and width and between sample interval and traverse interval. It is very important 
that instrumentation and accessory details match the instrument settings, especially Log Zero Drift Status for the 
Fluxgate Gradiometers, and the accessories tab settings for the MPX15 multiplexer. See Reference section at the 
end of this chapter for guidance. 

 

  CHECK INPUT DETAILS 

It is extremely important that the input details are correct. If they are inaccurate this may 
result in invalid data which may be uncorrectable at a later date, except by tedious manual 
re-entry. In some circumstances even this may not be possible.  

 

 

 

Figure 4-7.  Dialog box for selecting a predefined input template for Download of data. 

Download File Names 
Once you are satisfied the input details are correct click on Next or press Return to procede to the next stage. A 
dialog box will appear that allows you to enter a list or table of up to 254 file names for batch input, figure 4-8. As 
each data set is input and stored it is given the next name in the table, starting with the first entry.  

Type each name into the table, pressing the Tab or Return key to move to the next entry. When all names are 
entered, you can move the rectangular cursor up and down the table by moving the scroll bar on the right-hand side, 
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by using the up and down arrow keys or by using the up and down arrow keys in conjunction with the Ctrl key to 
move ten cells at a time. The cursor can also be moved by clicking on a cell with the mouse, pressing Return or Tab 
key. Following our example of download the six “rgrv” data sets, you would enter the grid names 1, 2, 3, 4, 5 and 6, 
as shown in figure 4-8. There is a quick method for entering these as we shall see in the next section. 

 

 

Figure 4-8.  Dialog box for entering input file names. 

Quick Entry 
The Quick Entry button provides a means for quickly entering a batch of file names with optional prefixes and 
suffixes, figure 4-9. To use this, position the cursor where you want the group of file names to begin then click on 
Quick Entry. Enter optional prefixes and suffixes, and  a  numeric or alphanumeric range of file names and then 
click OK to enter them at the cursor point. For example the entries of figure 4-9 will generate the table of file names 
shown in figure 4-8. Quick Entry can be used as many times as you like - simply position the cursor where you want 
the next sequence of names to be started - it can even overwrite previous entries if desired. For the quick entry 
technique to be of use, you must of course ensure that the input data was collected or is numbered consecutively. If 
you want to clear the table of names at any point then click on the Clear Table button. Once you have entered the 
names click on Next. 

 

  

Figure 4-9.  Dialog box for quick entry of input file names. 
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Note that the Quick Entry form will be modified slightly if you are downloading RM15 + MPX15 (Multiple) data. 
A check box is added, called Auto RM15 Multiple Log Mode Suffix, which will automatically append letters to the 
end of grid names – see the Reference section at the end of this chapter for further details. 

Duplicate or Existing File Names 
Geoplot will next check to see if there are any duplicate entries in the table, giving a warning if there are. Next, a 
check is made to see if any files entered in the table already exist in the destination directory and will issue a 
warning if that is the case, reporting the number of protected and unprotected files that occur with the same name. 
Since Geoplot will not let you overwrite existing raw data files (protected grids), you will have to choose new 
names if they already exist. Clear the table, enter new names and click Next again. Note that edited grids 
(unprotected files) can be overwritten so if this is acceptable to you click OK to allow the data files to be 
overwritten and proceed to the next stage. If you do not want these files to be overwritten click on Cancel key, clear 
the table, enter new names and click on Next again. 

Screen Savers and Battery Standby 
Before you procede further you must ensure that screen savers, battery standby and battery monitor are disabled – a 
reminder is given on the dialog box. If you do not disable them, then when these become active they can interrupt 
the real-time handling of the data flow into the PC, leading to loss of the data stream. Should this happen you will 
have to dump the data again. As well as disabling screen savers, battery standby and battery monitor, make sure 
there are no other background tasks operating that may interrogate the serial ports or acquire CPU time, eg some 
personal organiser synchronising software, by default, continually scans the serial ports for activity – this must be 
disabled before downloading data. Some virus checkers may need disabling if they interupt the flow of data. Infra-
red ports and some internal modems may also need disabling – see Chapter 6, Trouble-shooting for further 
information. 

Download Instructions 
Geoplot will then count how many entries there are in the list, ending at the first blank entry, and displays a new 
form giving download instructions. The instructions advise you to : (a) connect the data dump lead between the 
instrument and PC, (b) switch the instrument on and wait 1 second, then (c) click on Next to proceed to the next 
stage.  

Waiting for Data… 
A new form will appear, figure 4-10, which has a progress bar and a message above it : "Waiting for data ... Press 
DUMP on Instrument" - at this point the computer is actively looking for input at the RS232 port. 

 

 

Figure 4-10.  Second set of instructions for downloading data via the RS232 port. 

If you decide you want to abandon data input at this stage then you should click on Cancel. If you wish to procede 
with downloading data, press the DUMP key on the instrument. Note that it is vital you press DUMP at this point, 
and not before. If you press DUMP before this point the instrument will start transmitting data before the computer 
is ready to receive. As a result data will be corrupted and you will probably get an error message since the 
computer will not be able to synchronise with the data input. Alternatively, you may inadvertently lose some data, 
the computer resynchronises but the rest would then be scrambled. If you press DUMP at the correct time, the 
computer will respond with a new message saying "Receiving data…”. After a short time this message is replaced 
with a message saying “Downloaded : 100”, where 100 is the number of readings dowloaded so far; this number 
will increment in steps of 100 until Geoplot calculates all the data has been downloaded, based the number of grid 
names listed and the input details. You can abandon data input at any stage by just by clicking Cancel. 
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Overflow Problems 
A progress report consisting of a bar and reading count is normally shown as the data is downloaded. If there is a 
large quantity of data and the computer is of an old design, and hence slow, then you may get a “Buffer Overflow” 
error message. If so, then go to Environment options and change the progress report to either Bar only or none at all.  
Also, do not move the mouse or progress form during download since this will generate a Windows call which will 
be serviced in preference to handling the RS232 data. The internal buffer may not have sufficient capacity to 
temporarily store the incoming data in the interim. Further advice is given in Chapter 6, Troubleshooting. 

Completion 
Once all the data has been input, the computer will beep and display the message “Download successfully 
completed”. You can then switch off the logger which can now be used for surveying further grids. The input data, 
which has only been temporarily stored up to now, is then processed and whilst this is happening the status bar will 
report on the current grid being processed. Processing includes sorting the data for zigzag traverses, correcting for 
zero drift if enabled, calculation of grid statistics and histogram etc. All the data will then be stored in grid format, 
using the names listed in the Input File Names dialog box. Geoplot also automatically creates a master grid directory 
that matches the directory in which the grids are stored. This will make saving a new master grid much simpler 
when you come to combining the grids. 

Click on the OK button and Geoplot will then return to the list of grid names to be input. Cancel the form to return 
to the main screen. 

Keyboard Input 
Introduction 
This section describes how to use the keyboard to type in data sets that have previously been recorded on gridded 
paper. Data entered manually may be stored in grid format only, not composite. If the data set is of a size or form 
not suitable for direct entry as a grid, then it should be broken down into blocks that can be input as grids of data. 
The blocks should preferably be of equal size so that they can be recombined using a master grid. 

As we have already seen, Geoplot has very specific requirements for the data format. It is extremely important to 
define and use a survey strategy that complies with these requirements. These were discussed earlier in some detail 
but are summarised here again : 

 

  KEYBOARD INPUT 

For each site, always use grids that have the same size, survey pattern and orientation. 

Ensure that the first row of input data is equivalent to the first traverse made with the 
instrument.  

Choose the traverse direction so that it will be horizontal with respect to the computer 
screen when grids are finally assembled using a master grid. Plan the survey so as to 
avoid rotation of grids to achieve this. 

Always complete unsurveyed parts of a grid with dummy readings to ensure correct 
calculation of the grid statistics. 

 

 

Setting Number Resolution 
Data is typed into a data entry grid, which is very similar in appearance to the normal Data view we have seen 
already in the tutorial. Before starting keyboard entry you should make sure that the data entry grid can display the 
numbers with appropriate resolution. The resolution is initially set by the “Default Data View Format” setting made 
in the Data tab of Environment Options. However, if data has been previously loaded, and the resolution in the Data 
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view has subsequently been changed using the View menu, then this new resolution will over-ride the options 
setting and determines the data grid entry resolution. 

For data entry it is usual to set resolution equal to that of the number of significant decimal places in the data set. If 
resolution is set between # and #.###### then the data entry grid will have 9 columns visible at any one time, with 
each column able to display 7 digits. The resolution setting controls the number of decimal places visible in each 
column. If resolution is set to #### then the data entry grid will have 15 columns visible, with each column able to 
display 4 digits but no decimal places. If resolution is set to General Number then the data entry grid will have 7 
columns visible at any one time, with each column able to display 9 digits. General Number allows a maximum of 7 
decimal places. Do not use a resolution of #.####### (7 decimal places) for data entry - General Number performs 
the same function. In the case of our example data, Rgrv\1.dat, set the resolution for the data entry grid to #.#. 

Data may be entered as positive or negative floating point numbers consisting of up to 10 characters, including 
decimal point, with a maximum of 7 decimal places and 7 significant digits. There is no provision for entering 
exponential numbers, though General Number may display high value numbers as exponentials. Remember to set 
resolution before proceeding to the next stage – you will not be able to change it when using the data entry grid. 

Input Template Selection 
Select Keyboard Input from the File menu. A dialog box appears that allows you to select either a predefined input 
template from a list box, or proceed to define input details next, figure 4-7. Note that keyboard input of data is 
always in grid format, never composite. If the data set is of a size or form not suitable for direct entry as a grid, then 
it should be broken down into blocks that can be input as grids of data. The blocks should preferably be of equal 
size so that they can be recombined using a mesh template. 

If you select a predefined grid input template and click Next the selected template will be displayed. If you choose 
not to select a predefined input template, but leave “0default” highlighted in the list box, the next dialog box will be 
just the same as if you were starting to create a new input template. A form similar to that of figure 4-11 will appear, 
except there will be no choice of grid or composite input template. Proceed just as though you were creating a new 
grid input template, entering the input details carefully. If a sitename has not been previously defined in the input 
template do so now. 

As an example of inputting data we will simulate the manual entry of  grid “1” of the “rgrv” tutorial resistance data. 
First highlight the general purpose grid input template "rmsingle" which we defined earlier and click Next to display 
the input template details. Type rgrv into the Sitename field. 

At this point you should always check the input details displayed very carefully before proceeding any further. It is 
especially important that you enter the dimensional and sampling details correctly, being particularily careful to 
differentiate between grid length and width and between sample interval and traverse interval. Note that, unlike the 
previous section for downloading data, Geoplot will not make any adjustments to the data based on instrumentation 
details, but merely records these settings for your future reference. See the Reference section at the end of this 
chapter for guidance. 

 

  CHECK INPUT DETAILS 

It is extremely important that the input details are correct. If they are inaccurate this may 
result in invalid data which may be uncorrectable at a later date, except by tedious manual 
re-entry.  

 

 

Data Entry 
Once you are satisfied the input details are correct click on Next or press Return to procede to the next stage. A data 
entry grid form will appear, similar to that of figure 4-11. The column (X) and row (Y) coordinates identify the 
location of any reading within a data set and a rectangular cursor will be positioned at 1,1, the first data point 
position.  

To enter data simply type a number and press Return or Tab to move the cursor one position to the right. You can 
see in figure 4-11 the first four readings from Rgrv\1.dat entered. When the cursor gets to the end of the visible part 
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of a row (column 9 in our example) the column index numbers displayed will automatically increment by one to 
allow further entries to be made – in this case you will be able to enter data in column 10, and so on When the 
cursor gets to the end of a row, in this case column 20, and you press Return, you will hear a short beep and the 
cursor will wrap around to the start of the next row, column 1.  

When entering data you would normally start at the top left hand corner of the gridded paper and input the readings 
from left to right, row by row. The first row of numbers to be entered should be equivalent to the first traverse made 
with the instrument with the data point in the top-left hand corner of the screen representing the first data point to be 
recorded. There is no need to enter the leading zero of numbers such as "0.2" or "-0.2".  

Dummy readings may be entered by pressing the letter “D”, upper or lower case, which will insert the data value 
"2047.5" (or whatever dummy value is specified in Environent Options, Data tab) and move the highlight right to 
the next column. Alternatively just enter the dummy value manually. You should complete unsurveyed parts of a 
grid with dummy readings to ensure correct calculation of the grid statistics. 

Editing During Entry 
If you make a mistake during data entry you can go back and correct your mistake by moving the rectangular cursor 
to the appropriate cell position and either press the space bar or double click on the cell to highlight the number. 
Any changes can then be made. You can navigate around the data entry form by either moving the rectangular 
cursor or moving the scroll bars at the bottom and right-hand side (there is no scroll bar on the right-hand side at the 
moment since the data set can fit in the screen without it). The cursor can be moved by clicking on a cell with the 
mouse, pressing Return or Tab key to move to the next cell on the right, using the arrow keys or by using the arrow 
keys in conjunction with the Ctrl key to move ten cells at a time. If you use the arrow keys to move the cursor to the 
start of a row, any further movement to the left will wrap the cursor round to the last column of the previous row. 

 

 

Figure 4-11.  Typical keyboard entry form, showing first 4 readings of grid Rgrv\1.dat. 

Saving Data 
Once you are satisfied with the data entries display the SaveAs dialog box using either the File menu or by clicking 
on the SaveAs button on the horizontal toolbar. If there is no directory corresponding to the sitename entered in the 
input template, Geoplot will offer to create that directory for you – usually you would accept. Select the appropriate 
directory, enter a filename for the grid of data you have just entered and press OK. Note that you cannot over-write 
raw data files so if you are following our example of typing in the data from Rgrv\1.dat you will see the message : 
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“Raw data files cannot be overwritten. Press OK to continue and choose a new file name”. In this case choose a new 
filename, for example 1e and press OK to save the data.  

Note that there is no need to add the file extension usually when entering the file name – the only time you need to 
enter the file extension is if you are specifying a full file path. You would enter a full path name if you wished to 
store the data in a directory that did not already exist.  

As you enter data you can save the data at regular intervals as backups should there be a power failure etc. If you 
needed to resume entering data from such a position you would open the data set as normal, display the data view 
and then activate editing using the Edit menu. 

Completion 
The grid information file will contain grid statistics, histogram etc and a copy of the input details. Geoplot will not 
have taken any action based on the input details such as Traverse mode, but will merely record them. For example, 
if Traverse Mode is set to Zig-zag Geoplot will not make a correction for every other traverse. This is unlike the 
situation when downloading data from Geoscan instruments when direct action will be taken, based on input details. 

Import Data 
Introduction 
This section describes how to import data from a disk file in a variety of formats. Six formats are supported : ASCII 
column data, XYZ data where the data separator can be either comma, space or tab and Spreadsheet data where the 
data separator can be either comma or tab. Imported data can be stored grid or composite format. A batch of files 
can be inputted at the same time, though all must comply with the same input template details.  

As we have already seen, Geoplot has very specific requirements for the data format. It is extremely important to 
define and use a survey strategy that complies with these requirements. These were discussed earlier in some detail 
but are summarised here again : 

         IMPORT DATA 

Always try to use grid format (rather than composite format) if several files are to be joined 
into one. 

If grids are used then, for each site, always ensure they have the same size, survey 
pattern and orientation. 

Ensure that the first row of input data is equivalent to the first traverse made with the 
instrument. 

Choose the traverse direction so that it will be horizontal with respect to the computer 
screen. Plan the survey so as to avoid rotation of grids to achieve this. 

Always complete unsurveyed parts with dummy readings to ensure correct calculation of 
the grid statistics. 

Batch input of data is only suitable for data sets that are identical in form as specified in 
the input details (ie they must have the same size, same sample and traverse interval, 
same traverse direction etc). 

 

Input Template Selection 
Select Import Data from the File menu. A dialog box appears that allows you to select either a predefined input 
template from a list box, or proceed to define input details next. The form will be similar to that of figure 4-7 except 
it additionally gives you the choice of importing in grid or composite format.  
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If you select a predefined grid input template and click Next the selected template will be displayed. If you choose 
not to select a predefined input template, but leave “0default” highlighted in the list box, the next dialog box will be 
just the same as if you were starting to create a new input template. A form similar to that of figure 4-3 will appear, 
except there will be no choice of grid or composite input template, since that choice will have been made 
previously. Proceed just as though you were creating a new grid input template, entering the input details carefully. 
If a sitename has not been previously defined in the input template do so now. 

At this point you should always check the input details displayed very carefully before proceeding any further. It is 
especially important that you enter the dimensional and sampling details correctly, being particularily careful to 
differentiate between grid length and width and between sample interval and traverse interval. Note that, unlike the 
previous sections for downloading data or keyboard entry, Geoplot will not make any adjustments to the data based 
on instrumentation details, but merely records these settings for your future reference. For example setting Traverse 
Mode to Zig-zag will not adjust the data. See the Reference section at the end of this chapter for guidance. 

An example of importing a sample data set is discussed towards the end of this section. 

 

  CHECK INPUT DETAILS 

It is extremely important that the input details are correct. If they are inaccurate this may 
result in invalid data which may be uncorrectable at a later date. 

  

 

Import Dialog Box 
Once you are satisfied the input details are correct click on Next or press Return to procede to the next stage. An 
Import dialog box will appear, similar to that of figure 4-12. A message will appear on the status bar which indicates 
the order in which you complete the dialog box : Import File Format, Import File Parameters, Save To directory, 
Drives, Import Directory, Extension and lastly Filenames. Set each of these in turn. 

Import File Format 

Import File Format can be set to XYZ - CommaSV (comma separated variables), XYZ - SpaceSV (space separated 
variables), XYZ - TabSV (tab separated variables), Z (ASCII column data), Spreadsheet – CommaSV (comma 
separated variables) or Spreadsheet – TabSV (tab separated variables). Typical data has the following appearance : 

• XYZ – CommaSV 1,1,205.6 
1,2,213.7 etc 

• XYZ - SpaceSV  1  1  205.6 
1  2  213.7 etc 

• XYZ - TabSV   1 2 205.6 
1 2 213.7 etc 

• Z   205.6 
213.7 etc 

• Spreadsheet - CommaSV  205.6, 213.7, 200.5 etc 
 
• Spreadsheet - TabSV   205.6 213.7  200.5 etc 

 
Z data is simply a vertical column of data values, separated by carriage return, line feed characters. As data is 
imported the values are allocated to an array on a row by row basis. As you change the Import File Format setting, 
the Extension displayed will change to a default setting of .xyz for XYZ import, .dat for the Z import, .csv for 
Spreadsheet – CommaSV import and .txt for Spreadsheet – TabSV import. The list of Filenames will also change 
accordingly. 
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Import File Parameters 

The Import File Parameters displayed will change, depending on the choice of Import File Format made earlier. All 
the XYZ Import Formats have settings for : Reference Corner, Reference X Coordinate, Reference Y Coordinate, X 
Increment, Y Increment, a check box for Specify Dummy value and a text box for entering Import Dummy Value.  

For XYZ Imported data, Reference Corner specifies where the origin of the X and Y coordinates lies within the 
import data set itself, figure 4-13, not Geoplot coordinates, in other words which quadrant the data set was defined 
in. The default setting is Bottom-Left but can be changed to Top-Left if required. Reference X Coordinate and 
Reference Y Coordinate specify the origin of the Reference Corner within the import data set itself, not Geoplot 
coordinates. Usually the origin is 0, 0 (the default values) but can be changed if the origin has been offset from this 
value – see the example at the end of this section for further clarification and an example. The X Increment and Y 
Increment entries are taken from the input template details and match the sample and traverse intervals.  

For Z and Spreadsheet Imported data, Reference corner specifies the position of the first reading to be imported in 
terms of Geoplot’s X and Y coordinates, figure 4-13. The default setting is Top-Left but can be changed to Bottom-
Left if required.  

Before data is imported, an array is prefilled with dummy numbers, according to the “User Defined Dummy Value” 
set  in Environment Options, Data tab. If you set the Specify Dummy checkbox to on and enter a number in the 
Import Dummy Value text box, then when data is imported, any value that matches the Import Dummy Value is 
converted to the User Defined Dummy Value. 

 

 

Figure 4-13.  Reference corners specified in Import File Parameters. 

Save To Directory 

The Save To text box entry is a combination of  the Default File Paths setting in Options for grids or composites and 
the sitename entered in the input template. It determines where the imported data will be saved to. You can modify 
this if you wish.  

Drives and Import Directory 
The Drives and Import Directory settings are taken from the Default File Paths settings in Options. You can change 
these settings in the dialog box and as you do so the listings in the Filenames list box will change. 

Extension 

As you change the extension setting, the list of Filenames displayed will change accordingly. A number of 
predefined extensions are provided or you can enter your own extension – do not include a decimal point. 

Filenames. 

The Filenames list box displays any files that are in the specified import directory and that have the chosen file 
extension. Highlight the files you wish to import using the Shift key and mouse left-click to select a contiguous 
block or the Ctrl key and mouse left-click to select individual files. 
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Figure 4-12.  The default Import dialog box. 

Import Process 
When all selections are made in the dialog box, click OK to start the import. Geoplot will check to see if any grids 
or composites already exist in the Save To directory with the same name and warn you if that is the case. You may 
then wish to specify a different Save To directory – you will have to if raw grid files already exist with the same 
name.  Geoplot will also check that the input details match the import data files and warn you if there is a problem 
with the input details. If all is well, the imported files will be saved in the Save To directory and the form will still 
be present ready for you to import further files if you wish. 

Completion 
The resulting grid and composite information files will contain file statistics, histogram etc and a copy of the input 
details. Geoplot will not have taken any action based on the input details such as Traverse mode, but will merely 
record them. For example, if Traverse Mode is set to Zig-zag Geoplot will not make a correction for every other 
traverse. This is unlike the situation when downloading data from Geoscan instruments when direct action will be 
taken, based on input details. If you need to make a correction such as Zig-Zag then you must subsequently use the 
Edit menu, though of course you can only apply this to data imported and stored in grid format. 

Import Example 
An example file of an XYZ comma separated variable file is provided in the default import directory which you can 
use to experiment with : c:\geoplot\impdata\1.xyz. Try importing it with the following settings (a) grid input 
template Grid Length = Grid Width = 5m, Sample Interval = Traverse Interval = 1m, (b) import dialog box has 
Reference Corner = Bottom-Left, Reference X and Y Coordinates = 0, X and Y Increment = 1. When the file is 
imported into Geoplot and looked at in the data view it will appear thus : 

1  2 3 4 5  
6  7 8 9 10 
11  12 13 14 15 
16  17 18 19 20 
21  22 23 24 25 
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If you open the data file 1.xyz in Notepad it will appear as below. Note that the smallest X and Y values = 0, and 
determine the Reference Corner X and Y values you should enter. The Z value of 21 is at X=0, Y=0 and if you want 
this to appear as in the table above Reference Corner should equal the default of Bottom-Left. Both X and Y 
increment from 0 to 4. 

X,Y,Z 

0, 0, 21  
1, 0, 22  
2, 0, 23  
3, 0, 24  
4, 0, 25  
0, 1, 16  
1, 1, 17  
2, 1, 18  
3, 1, 19  
4, 1, 20  
0, 2, 11  
1, 2, 12  
2, 2, 13  
3, 2, 14  
4, 2, 15  
0, 3, 6  
1, 3, 7  
2, 3, 8  
3, 3, 9  
4, 3, 10  
0, 4, 1  
1, 4, 2  
2, 4, 3  
3, 4, 4  
4, 4, 5 

 
If you set Reference Corner = Top-Left the Z value of 21 will appear in the top-left hand corner thus : 

21  22 23 24 25 
16  17 18 19 20 
11  12 13 14 15 
6  7 8 9 10 
1  2 3 4 5  
 

If  the smallest values of X and Y were 1 and X and Y incremented from 1 to 5 then you would set Reference X and 
Y Coordinates = 1 to import the data correctly. 

 

 

 

 

 

 

 

 

 

 

 

 



 4-22       Data Input 

Reference Section 

Grid Input Template - Acquisition Details 
Grid length and width may be tabbed through predefined values : 5m, 10m, 15m, 20m, 30m, 50m, 100m, 200m, 
500m, 1000m. Sample and Traverse interval may also be tabbed through predefined values : 0.125m, 0.25m, 0.5m, 
1m, 2m, 5m, 10m, 20m. Note that these parameters are entered in units of metres not readings. 

If you need to cater for a grid size that is not provided for directly in Geoplot then you must scale the dimensions 
and sampling intervals accordingly. 

For example if you wish to input magnetic susceptibility data sampled over a 800m square with sample and traverse 
interval 20m (ie 40 readings by 40 readings), then you could enter the details either as length = width = 20m and 
sample and traverse interval 0.5m, or as length = width = 10m and sample and traverse interval = 0.25m. This will 
preserve the correct number of readings though of course the scales on graphics plots will be too small by a factor of 
40 or 80 respectively. If the available number of readings possible with grid input details is not suitable for your 
particular data set size consider breaking it down into smaller blocks - this may be possible if inputting data 
manually. The blocks should preferably be of equal size so that they can be recombined using a master grid - fill in 
any extra regions with dummy readings. If it is not feasible to do this, as may happen if you wish to input from a 
disk file, then you must input the data in composite format. 

The FM18, FM36 and DL10 loggers have certain limitations with regard to acquisition details which arise due to 
their method of logging readings (also see later section on Dual Gradiometers if operated in that mode) : 

FM18 and FM36 

The FM18 and FM36 can have grid sizes of 10m, 20m or 30m and you can set a sample interval of 0.25m, 0.5m and 
1m. However, you cannot specify a traverse interval - the number of traverses stored per grid will always equal 10, 
20 or 30, depending on the grid size set in the menu. Therefore, if you wish to survey at sample and traverse 
intervals of 0.5, on say a 20m grid, then you must split the 20m square grid into two blocks of 20m by 10m, with the 
20m corresponding to the grid length, and (if enabled) log zero at the end of each 20m by 10m survey area. When 
inputting data the input details should be set to : Grid Length = 20m, Grid Width = 10m, Traverse Interval = 0.5m, 
and Sample Interval = 0.5m.  

A sample interval of 0.125m is not directly available on the FM18/36, even though such a rate is provided on the 
ST1 sample trigger. In order to use 0.125m sampling, you should adopt a similar approach to that just described. For 
example, if you wish to survey with a sample interval of 0.125m, traverse interval of 1m, with grid set to 20m, then 
set the sample interval to 0.25m and remember that the survey tracking will show two traverses for every one 
actually completed, and Log Zero Drift will occur after 10m. Input details should be set to : Grid Length = 20m, 
Grid Width = 10m, Traverse Interval = 1m, and Sample Interval = 0.125m. 

DL10 

The DL10 can have grid sizes of 10m, 20m or 30m but you cannot specify a sample or traverse interval. This will 
always be assumed to be 1m so that the logger stores 100, 400 or 900 readings in each 10m, 20m or 30m grid 
respectively. If you wish to survey at 0.5m sample and traverse intervals then set the DL10 grid size to 20m, and 
perform the survey on a 10m grid. Input details would be set to : Grid Length = 10m, Grid Width = 10m, Traverse 
Interval = 0.5m, and Sample Interval = 0.5m. 

Grid Input Template - Instrumentation Details 
If you choose RM15, FM18, FM36, FM256, an instrument + DL10 or an instrument + DL15 for the Instrument type 
then Geoplot will assume that you will be downloading data via the RS232 port. Usually you will see "AUTO" as 
the default setting in Range and Gain fields. If you do, then leave that entry as it is, since Geoplot will automatically 
generate the correct entry here as the data is input. Some instrument combinations with the DL10 require you to 
enter the Gain or Range manually. You must take very great care to ensure that the status of some entries such as 
HCR or Log Zero Drift are correctly set since Geoplot may make corrections to the data based on this. In general 
set the baud rate on the instrument to the maximum possible and match it in Geoplot. The following tables show the 
default settings for the input details, which may of course be changed, as indicated in the text. 
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Instruments with Loggers 

RM15, RM15 + MPX15 (Single), RM15 + MPX15 (Parallel) and RM15 + MPX15 (Multiple) 

Instrumentation  Default  Further settings available   

• Survey Type  Resistance  
• Instrument  RM15 
• Units   ohms  large range of units and user defined 
• Current Range  AUTO  0.1 mA, 1mA, 10 mA 
• Gain Range  AUTO  x 1, x 10, x 100 
• Baud Rate  9600  9600, 2400, 1200, 600 
• Frequency  137 Hz  85 Hz, 35 Hz 
• High Pass Filter 13 Hz  8 Hz, 1.6 Hz, 0.16 Hz, 0.05 Hz, 0.01 Hz 
 
Leave Current and Gain Range set to AUTO since the software will interpret the correct range from the data input. 
Memory size may be 4000, 16000 or 32000. See Accessories section below for other very important details when 
using the MPX15. 

RM4 + DL10 

• Survey Type  Resistance 
• Instrument  RM4 + DL10 
• Units   ohms  large range of units and user defined 
• Range  2000 ohm 200.0 ohm, 20.00 ohm 
• HCR mode  Off  On 
• DL10 Baud Rate 2400  1200, 600 
 
Leave Range set to AUTO since the software will interpret the correct range from the data input. HCR mode may be 
Off or On - see the RM4 manual for further information. If HCR is set to On Geoplot will multiply the data by 2.75 
as it is input. This will correct for data recorded with the RM4 High Contact Resistance switch set to on.  

FM18 or FM36   

• Survey Type  Gradiometer 
• Instrument  FM18 (or FM36) 
• Units   nT  large range of units and user defined 
• Range  AUTO  0.1nT, 1 nT, 10 nT 
• Log Zero Drift  Off  On 
• Baud Rate  2400  1200, 600 
• Averaging  Off  On 
• Averaging Period 16  32, 64, 128 
 
Leave Range set to AUTO since the software will interpret the correct range from the data input. It is extremely 
important to make sure the Log Zero Drift status is correct – if software and instrument settings do not match the 
data will be stored incorrectly and you may not be able to unscramble it.If being used in Dual Gradiometer mode 
with an FM256 see important information about acquisition details and  Log Zero Drift setting later in this chapter. 
The averaging Period settings are simply recorded and no action is taken by Geoplot. 

FM9 + DL10   

• Survey Type  Gradiometer 
• Instrument  FM9 + DL10 
• Units   nT  large range of units and user defined 
• Range  0.1nT  1 nT, 10 nT 
• Averaging  Off  On 
• Averaging Period 16  32, 64, 128 
• DL10 Baud Rate 2400  1200, 600 
 
You must manually set Range to 0.1nT, 1nT or 10nT and Geoplot will scale the data accordingly as it is input. Set 
Averaging to Off or On - see the FM manual for further information. Set Averaging Period to 16, 32, 64, 128. 
Regardless of the Averaging setting, Geoplot will take no action but will merely record this setting.  
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FM256   

• Survey Type  Gradiometer 
• Instrument  FM256 
• Units   nT  large range of units and user defined 
• Range  AUTO  0.1nT, 1 nT, 10 nT 
• Log Zero Drift  Off  On 
• Baud Rate  19200  14400, 9600, 4800, 2400, 1200, 600 
• Data Format  Hex D+R Hex D, Fast ASC, ASC, ASC+SPCS 
• Computer Buffer Size 32767  15000, 7500, 3000, 1000, 500, 100, 10 
 
Leave Range set to AUTO since the software will interpret the correct range from the data input. Leave Computer 
Buffer Size set to the maximum value. It is extremely important to make sure the Log Zero Drift status is correct – 
if software and instrument settings do not match the data will be stored incorrectly and you may not be able to 
unscramble it.It is also extremely important to set the Data Format status correctly so that the data stream is 
properly interpreted. If set incorrectly the downoaded data may be unrecoverable. If being used in Dual 
Gradiometer mode see important information about Acquistion Details later in this chapter. 

AM01 + DL10   

• Survey Type  Gradiometer 
• Instrument  AM01 + DL10 
• Units   nT  large range of units and user defined 
• AM01 Range  10 nT  30 nT, 100 nT, 300 nT 
• DL10 Baud Rate 2400  1200, 600 
 
This combination is for a Philpot analog AM01 gradiometer and DL10. You must manually set Range to 10nT, 
30nT, 100nT or 300nT and Geoplot will scale the data accordingly as it is input.  

DM01 + DL10   

• Survey Type  Gradiometer 
• Instrument  DM01 + DL10 
• Units   nT  large range of units and user defined 
• DM01 Range  200.0 nT 2000 nT, 20000 nT 
• DL10 Baud Rate 2400  1200, 600 
 
This combination is for a Philpot digital DM01 gradiometer and DL10. You must manually set Range to 200.0nT, 
2000nT or 20000nT and Geoplot will scale the data accordingly as it is input.  

User Defined + DL10  

• Survey Type  as set in dialog box instrument choice 
• Instrument  user defined 
• Units   matches survey type large range of units and user defined 
• DL10 Baud Rate 2400   1200, 600 
 

User Defined + RM15 

• Survey Type  Gradiometer 
• Instrument  user defined 
• Units   matches survey type large range of units and user defined 
• DL15 Baud Rate 9600   1200, 600 
 

Instruments without Loggers 
If you choose RM4, FM9 or User Defined for the Instrument type then Geoplot will assume that you will be 
inputting data manually or via Disk input. You must manually set ranges, gains etc in the Instrumentation details. 
Any settings such as HCR, will not have an effect - these settings will only trigger Geoplot into making a correction 
if data is being input via the RS232 port. Do not make any other entries in the Instrumentation or Accessories 
groups, unless you are specifying details for a User Defined instrument, since these fields are reserved for future use 
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by Geoplot. The following tables show the default settings for the input details, which may of course be changed, as 
indicated in the text. 

RM4 

• Survey Type  Resistance 
• Instrument  RM4 + DL10 
• Units   ohms  large range of units and user defined 
• Range  2000 ohm 200.0 ohm, 20.00 ohm 
• HCR mode  Off  On 
 

Set Range to 2000 ohm, 200.0 ohm or 20.00 ohm. Set HCR mode to Off or On - see the RM4 manual for further 
information. Regardless of the HCR setting, Geoplot will take no action. If you wish to correct for data recorded 
with the RM4 High Contact Resistance switch set to on then use the process menu to multiply the data by 2.75 
(when it is in composite format). 

FM9    

• Survey Type  Gradiometer 
• Instrument  FM9 
• Units   nT  large range of units and user defined 
• Range  0.1nT  1 nT, 10 nT 
• Averaging  Off  On 
• Averaging Period 16  32, 64, 128 
 

Set Range to 0.1nT, 1nT or 10nT. Set Averaging to Off or On - see the FM manual for further information. Set 
Averaging Period to 16, 32, 64, 128. Regardless of the Averaging setting, Geoplot will take no action but will 
merely record this setting. 

AM01   

• Survey Type  Gradiometer 
• Instrument  AM01 
• Units   nT  large range of units and user defined 
• AM01 Range  10 nT  30 nT, 100 nT, 300 nT 
 

You must manually set Range to 10nT, 30nT, 100nT or 300nT but Geoplot will not scale the data as it is input, 
unlike the situation when data is input using a DL10 – see above. 

DM01 

• Survey Type  Gradiometer 
• Instrument  DM01 
• Units   nT  large range of units and user defined 
• DM01 Range  200.0 nT 2000 nT, 20000 nT 
 

You must manually set Range to 200.0nT, 2000nT or 20000nT and Geoplot will not scale the data accordingly as it 
is input, unlike the situation when data is input using a DL10 – see above. 

User Defined – for particular survey type 

• Survey Type  as set in dialog box instrument choice 
• Instrument  user defined 
• Units   matches survey type large range of units and user defined 
 

User Defined – for unlisted survey type 

• Survey Type  user defined 
• Instrument  user defined 
• Units   user defined  large range of units and user defined 
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Grid Input Template - Accessories Details 
The following discussion applies only to the RM15 system. In particular, if you intend to use an MPX15 system 
then you should be familiar with the MPX15 instruction manual since this introduces new terms and ways of data 
storage that require the data dump procedure to be changed slightly from the general method already described. 

The Accessories tab of a grid input template changes according to whether the instrument choice is RM15, RM15 + 
MPX15 (Single), RM15 + MPX15 (Parallel) or RM15 + MPX15 (Multiple). A comparison of the entries that appear 
is shown below. Although many of the settings are for record purposes only, there are some settings that must be 
made correctly : 

(a)  Parallel Twin Log Mode. You must enter the number of Parallel Readings correctly otherwise data will be 
downloaded and stored incorrectly. 

(b)  Multiple Log Mode. You must enter the (number of) Readings per station correctly otherwise Geoplot will not 
know how many separate grids it should store the data in, one for each configuration in a multiplex sequence. 

When you have made these entries and clicked OK you will be presented with the standard dialog box for entering 
input file names, figure 4-14. This box and entry procedure will be unchanged for Single and Parallel Twin log 
modes, but entry for Multiple log modes is different.  

The aim of downloading Multiple logged data is to assemble the readings associated with each probe configuration 
in a sequence into separate grids (see Appendix A of the MPX15 instruction manual). For example, assume we 
survey 2 grids, and the RM15 / MPX15 logs data with a 0.5m, 1m and 1.5m Twin at each reading station, that is, 3 
multiplex configurations per sequence. Instead of just entering the grid names 1 and 2 in the dialog screen, you must 
also allocate names to each probe configuration in a multiplex sequence, so that it can be assigned a grid of data. In 
our example, grid 1 consists of 3 multiplex configurations, which we might call a, b and c. Grid 2 will also consist 
of 3 multiplex configurations. If we combine these with grid names 1 and 2 we would then store data in 6 grids 
named : 1a, 1b, 1c, 2a, 2b, 2c. 

Figure 4-14 shows these entries made in the dialog box. The Quick Entry dialog box is modified for the Multiple 
Log Mode. A check-box is provided, called Auto RM15 Multiple Log Mode Suffix, which by default is set to on. 
This will automatically add the letters a,b,c etc to the end of any grid names generated by the other Quick Entry 
fields : Prefix, Start, End and Suffix. Figure 4-13 shows the Quick Entry settings you would need to make to 
generate grid names for the example just discussed. Geoplot uses the "Readings per station" entry made in the 
previous dialog screen to determine how many letters to add. Downloading of data is now just the same as for 
Single and Parallel RM15 data. 

 

Accessories  Default  Further settings available 

RM15 

• Array Hardware PA5  PA1, PA2, PA3, user defined 
• Interface  AD1  AD2, AD3 
• Log Mode  Single 
• Configuration  Twin  Pole-Pole, Double-Dipole, Wenner, Schlumb., Gradient, user def. 
• Probe Spacing  0.5 m  0.75 m, 1.0 m, 1.25 m, 1.5 m, 2.0 m, user defined 

 

RM15 + MPX15 (Single) 

• Array Hardware PA5  PA1, PA2, PA3, user defined 
• Interface  MPX15 
• Log Mode  Single 
• Configuration  Twin  Pole-Pole, Double-Dipole, Wenner, Schlumb., Gradient, user def. 
• Probe Spacing  0.5 m  0.75 m, 1.0 m, 1.25 m, 1.5 m, 2.0 m, user defined 
 

RM15 + MPX15 (Parallel) 

• Array Hardware PA5  PA1, PA2, PA3, user defined 
• Interface  MPX15 
• Log Mode  Parallel 
• Parallel Readings 2 (3 probe) 2 (4 probe)              [3 and 4 are no longer recommended for use] 
• Configuration  Twin 
• Probe Spacing  0.5 m  0.75 m, 1.0 m, 1.25 m, 1.5 m, 2.0 m, user defined 
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RM15 + MPX15 (Multiple) 

• Array Hardware PA5  PA1, PA2, PA3, user defined 
• Interface  MPX15 
• Log Mode  Multiple 
• Readings per station enter 1 to 8 
• Configuration 1 user defined 
• Configuration 2 user defined 
• Configuration 3 user defined 
• Configuration 4 user defined 
• Configuration 5 user defined 
• Configuration 6 user defined 
• Configuration 7 user defined 
• Configuration 8 user defined 
 
 

 

Figure 4-13.  Quick Entry dialog box shown in its modified form for RM15 / MPX15 Multiple Log Mode. 

 

Figure 4-14. Input File Names dialog box showing entries for RM15 / MPX15 Multiple Log Mode, 
generated with the Quick Entry settings made in figure 4-13, and Readings per station = 3 in the 
Accessories tab of the input template. 



 4-28       Data Input 

Grid Input Template – FM256 Dual Gradiometer Data 
The FM256 fluxgate gradiometer system can be operated as a dual gradiometer system whereby two gradiometers 
are carried together 1m apart and are used to collect data simultaneously (this may be two FM256s or an FM256 and 
FM36). Depending on the configuration used, this may be for covering a given area twice as fast or for covering the 
area with more detailed sampling. The grid data from each instrument is downloaded normally, and combined, using 
a master grid, into two separate composites. The Merge facility on the File menu is then used to combine the two 
data sets into one final composite, using the traverse interval of one composite to detect which method of coevrage 
has been used, as shown in Table 4-2 below. Figure 4-15 shows the form used to merge the two highlighted 
composites. Note in the form (a) the naming convention required for merging – this influences the file naming 
convention, and (b) the relative positions of the two gradiometers (slave or master).  

 

 

Figure 4-15.  Form used to merge composites  - note the naming convention used and relative positions 
of the gradiometers.  

File Naming Convention 
Two separate grid data sets will be collected per surveyed grid, one for each gradiometer. This data might well be 
stored under the same sitename for convenience. You could differentiate between these grids using, for example 
names such as 1a, 2a, 3a etc (slave data) and 1b, 2b, 3b etc (master data). These will eventually be merged to form 
the final grids 1, 2, 3 etc, though this will be done at the composite stage – see the File Menu in Chaper 5 and 
Processing Techniques in Chapter 6 for further details. It is vitally important to download and save the data from 
each instrument with names that indicate and preserve their relative positions in the dual configuration otherwise 
the data will not be merged correctly. 

Traverse Interval Entry in Acquisition Details 
Since two gradiometers are used to cover a given area of ground, rather than one, the traverse interval setting made 
in Geoplot should match that of the instrument and be double that of the final merged traverse interval. The table 
below shows the allowable traverse interval settings and merge pattern used. Note that you cannot use Traverse 
Interval settings greater than 2m or less than 0.5m. Make sure you enter the Traverse Interval Setting in the 
Acquisition Details, and not the final Merged Traverse Interval  

Traverse Interval Setting (m) Merged Traverse Interval (m)       Merge Pattern Mode 

   2    1    ab  Double speed 
   1    0.5    aabb  Double density 
   0.5    0.25    aaaabbbb Quad density 
 

Table 4-2.  Relationship between survey mode, traverse interval setting, merged traverse interval, and 
survey merge pattern. 
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FM18/ FM36 Acquisition Limitations 
If one of the gradiometers is an FM18 or FM36 there are limitations with regard to the traverse interval setting 
discussed above, since you cannot specify a traverse interval with an FM18 or FM36. The number of traverses 
stored per FM18 / FM36 grid will always equal 10, 20 or 30, depending on the grid size specified.  

Double Speed Mode 

If the dual configuration is being used for double speed coverage you cannot set an FM18 / FM36 instrument to the 
required 2m traverse interval. Instead, since it is fixed at 1m, you must use each instrument grid to record the 
equivalent of two FM256 grids (eg for a 20m grid, lines 1-10 for the first FM256 grid, lines 11-20 for the second 
FM256 grid) but download the data as you would for the FM256 acquisition details – this is possible since data is 
simply logged in an FM18 or FM36 on a serial basis. However, you must not use Log Zero Drift.  

Double Density Mode 

If the dual configuration is being used for double density coverage then the FM18 or FM36 will automatically have 
the correct 1m traverse interval setting and Log Zero Drift could be used if necessary.  

Quad Density Mode 

If the dual configuration is being used for quad density coverage then you must use an FM18 / FM36 instrument to 
record two grids for every one FM256 grid. Again, you must not use Log Zero Drift.unless you are prepared to 
break off half way through each FM256 grid which may not be practical in most cases. 

Traverse Mode 
If Traverse Mode is set to Zig-Zag, then Geoplot will correct for the way the data was collected, reversing every 
other line of data as it is dumped. If Grid Traverse Mode is set to Parallel then no correction will be made.  

Sample Interval 
Sample interval settings in the acquisition details should match the instrument settings in the normal way. Note that 
if using an FM18 / FM36 as part of the dual configuration and you wish to survey with a sample interval of 0.125m 
you must use the workaround detailed earlier at the start of this reference section. However, this may get confusing 
when combined with the acquisition limits just discussed since the line numbers and grids will not match, making it 
much harder to track any problems during surveying. If used for Double Speed coverage at 0.125m sample interval, 
one complete FM18 / FM36 grid will match one complete FM256 grid. If used for Double Density coverage at 
0.125m sample interval, two complete FM18 / FM36 grids will match one complete FM256 grid. If used for Quad 
Density coverage at 0.125m sample interval, four complete FM18 / FM36 grids will match one complete FM256 
grid. You should  not use Log Zero Drift.in the last two cases unless you are prepared to break off part way through 
each FM256 grid. 

Grid Length and Width 
Grid length and width acquisition details should match the instrument settings in the normal way. The merge facility 
will use this information, in conjunction with the traverse interval, to combine the data correctly.  



 4-30       Data Input 

 



 

 

Chapter 5  

ADDITIONAL 
INFORMATION 

Introduction 
This chapter provides additional information to the previous chapters. The text assumes you have worked 
through the tutorial and so have an understanding of the Geoplot environment. Major topics are : (a) Export, (b) 
Pseudo-section creation and (c) generation and overlay of contour plots. This chapter also presents guidelines on 
how to approach data processing for several survey types. 

Major Improvements On Geoplot 2.02 for DOS 
• Flexibility and convenience of a Windows program, eg mouse facilities and toolbars. 
• Publication facilities added. 
• The Windows environment removes the 640K limit for composite sizes that was found in the DOS 

environment, meaning much larger composites can be created. 
• You can combine many composites together to create one large composite. 
• Composites, like grids, can be now rotated in 90 degree steps.  
• You can create a blank composite for pasting other data onto. 
• Much larger master grids (formely mesh templates) can be created. 
• Sample and traverse interval can now also be 2m, 5m, 10m and 20m so large scale magnetic susceptibility 

surveys can be handled more easily. 
• Interpolate (Shrink) can now shrink below 1m, for example to 2m, 4m, 8m etc so for very dense trace plots 

Shrink can remove every other line for better visibility. 
• Median filter process function added. 
• Cut and Combine process function extends to manipulating grids as well as composites. 
• You can add, insert and delete comments in an edit or process history. 
• Improved Import and Export facilities. 
• Graphics bitmaps can be saved for use in other packages as well as in publication. 
• Customisable colour and grey palettes for shade plots. 
• Instrument units can be edited. 
 

Many other improvements have also been made to Geoplot with the introduction of version 3.0. 

General Notes 
Whenever you choose a printer from within Geoplot this will become the default printer for the system. If you 
change any major print options eg paper size, then the first time you print nothing will appear to have changed. 
However, subsequent submissions of the print job will print properly. You can avoid this waste of paper by 
exiting Geoplot, set the new default printer and its properties and then restart Geoplot. 
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If you have your Windows language settings so that the decimal separater is set to a comma (eg German, 
standard), then the data view will show numbers with this setting and data will also be exported with comma 
separators too which will be confusing if using the comma separated variable method. You may also experience 
problems in changing graphics options. Therefore you must ensure a decimal point is used as the decimal 
separator by changing your language settings. 

File Menu 
The Windows master grid file format is different from the DOS versions to allow much larger master grids to be 
created, up to 50 by 50 names. Older versions of a mesh or master grid can be opened and edited if you wish 
though if you subsequently try to save them using the same name, you will be prevented from doing so, being 
asked to choose a new name – this leaves the original file still accessible using the DOS Geoplot. Unlike the 
DOS version, there is no need to enter the name DUMMY for blank grids – Geoplot will interpret cells not filled 
in as dummy grids. You can use the Insert Row and Insert Column buttons to add extra grid names to an existing 
master grid at the top and left hand side respectively. The Add ‘a’ Suffix and Add ‘b’ Suffix buttons allow you 
to quickly add an ‘a’ or ‘b’ at the end of names in a previously created master grid making it easier to create 
matching dual FM256 composites for merging – this topic is discussed in more detail in the Data processing 
chapter. In Geoplot version 3.00n you are no longer required to have matching directory names for the grids and 
master grid - the ‘Grid Source for Composite Creation’ box allows you to define the location of thegrid names 
specified in a master grid and automatically tracks the location of any grids loaded or the location of a saved 
master grid. 

Combine Composites on the File menu allows you to combine existing composites into one much larger 
composite. Up to 100 composites can be combined. To aid in entering the full path name you can use the Prefix 
Path button. This will enter the default path name, obtained from your Composite Default File Paths Options 
settings, (and optionally a sitename) a specified number of times. You then just need to type in a file name - 
there is no need to add the extension. You also need to specify where, on the new combined composite, the top 
left hand corner of each composite should be positioned - this is entered as an X and Y coordinate.  Once all the 
information is entered, press the Combine button. Any areas in the combined composite not occupied will be 
filled with dummy readings. After the composites have been combined you are prompted to enter a name to save 
the new composite as. Note that you can : (a) use the Page Up/Down keys or Ctrl+ Up/Down keys to move up 
and down the table, (b) use the Tab, Enter and left and right arrow keys to move the cursor. 

You can create a blank composite, using the Create Blank Composite function, which is populated with dummy 
readings and has a clean history report. This can be very useful for pasting on other composites during more 
involved processing sessions, such as preparing a source composite for generating pseudo-sections, as described 
below. You can select the survey and instrument type, just as for the input routines, and can then define the 
composite dimensions etc in the form provided.  Remember to define dimensions in terms of metres, not 
readings. Save the blank composite with any name you like. 

You can export data into a range of new file formats for use by another packages. This topic is covered in more 
detail later on in the chapter. 

Merge Composites on the file menu allows you to combine dual gradiometer data. This topic is dicussed in more 
detail in the Data Processing chapter. It also allows you to combine RM15/MPX15 Twin 0.5m data which was 
collected using the multiple log  mode (to enable simultaneous collection of 1m or 1.5m Twin data). 

You can create stacked pseudo-sections from a sequence of expanding Twin surveys (eg 0.5m wide to 1.5m) 
using the Create Pseudo-Section function on the File Menu. This topic is covered in more detail in this chapter. 

Not only can you print to paper, you can also print to a file. This offers a much better method of obtaining high 
quality trace plots images (eg for inclusion in desktop packages) than simply saving a trace plot bitmap using the 
Graphics menu. First of all install a printer that uses a Postscript driver (the Apple LaserWriter or QMS PS-810 
for example) – no physical printer is needed. Modify the printer properties to set an encapsulated Postscript 
filename (.eps) and direct it to print to a file rather than LPT1, for example. Set this printer as the default printer 
before launching Geoplot. Print as though you were sending the print job to a physical printer (at the resolution 
and scale you would use in a final paper copy), except that the job will now go to a file which you can name – 
ensure it ends in .eps. This encapsulated postscript file can be opened or imported into a desktop publishing 
packege or graphics packege such as Paint Shop Pro (PSP). If using PSP ensure you open the file with sufficient 
resolution eg 360 dpi – it may take some time to open. This image can now be saved as a .jpg for inclusion in 
Word etc. and the quality will be as good as a physically printed  copy. 
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Edit Menu 
The three Edit menu items : Flip Horizontal, Invert Traverse Mode and Data can only be applied to grid data, 
not composite data. Rotate, Swop Adjacent Traverses, North Direction and Units can be applied to both grid and 
composite data.  

You can change the units of a data file, selecting either from the offered list or by typing in your own units. This 
entry is reflected in the File Details view and Graphics view. 

Comments can be added, inserted or deleted when the history view is shown. These occupy three lines: the 
comment itself and a line of “===” characters before and after the comment.  Note that a comment can be added 
(but not inserted or deleted) whilst any other view is shown, it being added simply as the next edit or process. 

To insert or delete a comment you must be in the History View. Choosing either of these menu items shows a 
form for entering your edits and changes the History view so that each entry is preceded by a number. Identify 
the location where you want to insert or delete a comment by entering the corresponding number. In the case of 
delete comment, you should enter just the number corresponding to the comment itself, not the surrounding 
“======” character lines - these will be removed along with the comment. 

Graphics Menu 
The minimum colour setting is 256 colours and any higher setting may be used. Whilst you can successfully use 
16 bit colours we recommend that you increase resolution to 24 bit or 32 bit colour to improve graphics display 
on some systems. If your Windows resolution is set to 16 colours then all graphics will be dithered and result in 
an unacceptable appearance. If you do change colour resolution then you may need to reboot Windows in order 
for the new resolution to work properly, especially if you change down to 256 colours. Screen resolution may be 
VGA and upwards - we suggest SVGA as a minimum resolution for an uncluttered screen. If your Windows 
colour resolution is set to 256 colours then you will only be able to work with palettes of less than 100 colours.  

Setting a high screen resolution (eg 1024 x 1024) enables a higher resolution bitmap to be saved for import into 
other software packages. This can greatly improve transfer quality. 

It may be advisable to set the screen background and dummy colours to white when saving bitmaps for export to 
other packages, depending on how you wish to use the images. 

When a bitmap is saved it has stored with it the location of the original data set and the palette used. This is so 
that when printing a Publish document in Geoplot, the Publish view can access the original data set for a high 
quality printout, regardless of the resolution the bitmap was originally saved at. It is therefore imperative you do 
do not subsequently move the data files from their original location, otherwise the Publish view will not be able 
to locate the data. 

Some combinations of sample interval, traverse interval magnification and graphic type can cause problems with 
the graphics image, gridding or survey number. These have been trapped so you may find some magnifications 
are skipped over (primarily x3 and x5) and you will find gridding and survey numbers have been turned off in 
pattern plot to avoid these errors. 

When using Trace plots, if the traverse interval is small and/or the number of traverse to be displayed is large 
then it may not be possible to distinguish each trace line. In this case use the Interpolate (Shrink) function to 
remove every other line for better visibility. Bear in mind that the data set is being reduced too, so you may wish 
to apply this only to a special data set saved purely for trace display manipulation.  

You can obtain a much higher quality trace plot graphics image by printing to a file (eg for inclusion in desktop 
packages) than by simply saving a trace plot bitmap using the Graphics menu. See File menu for details. 

You may find in Windows 98 that the when the shade plot parameters form is displayed, the listbox for the 
palettes scrolls slowly until settling down. You can avoid this by turning off Animation in Desktop properties. 

Although there is no contour plotting routines provided you can, for smaller data sets, create an impression of a 
contour levels using shade plots. You can achieve this by doing repeated interpolations in both x and y directions 
until the original data points cannot be seen at the magnification used and then choose a palette with a reduced 
number of levels. For example, open the example composite data set gkiln\1.cmp and display a shade plot using 
the default plotting parameters and the grey07 palette. At first sight this plot does not show much promise. 
However, if you interpolate Y and X alternately, three times for each, until sample and traverse interval both 
equal 0.125m then you will see grey levels appear, as in the left hand plot of figure 5-1. If you redisplay the 
graphic plot using the greycol7 palette (a range of colour levels at either end of the palette with grey levels in 
between) then you will see a combination of  colour levels superimposed on a background of a normal grey 
scale plot, right-hand side of figure 5-1. This palette simultaneously lets the grey levels show fine detail at low 
signal levels whilst the colour levels show, and clearly separate out, the greater magnitude information. 
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Figure 5-1.  Contour level plots using combination of interpolation, shade plot and appropriate palette. 
The left-hand palette has 7 grey levels whilst the right-hand palette has a combination of colour bands 
at either end and a central grey range. 

Contour lines can be also be generated and overlaid on shade plots by using a combination of process functions 
and appropriate shade palettes. This topic is covered in more detail later on in the chapter. 

Process Menu 
Please see the separate Data Processing chapter for further detailed information. In brief, if you apply the 
Spectrum process to the data the graphics plot details on the right-hand side will change to show spectrum type 
and spectrum units, and the coordinates reported on the status bar, as the mouse moves, will show Y position 
and frequency index, instead of X and Y coordinates. The frequency index value, which identifies a periodic 
component, should be entered in the Periodic Filter parameters form when you wish to remove this component. 

Publish Menu 
If you import a graphics bitmap which has grid numbers superimposed on it, publish view will use the smallest 
font used in the publish document when printing these out. If the rest of your document uses too large a font, 
then simply add a text object that is blank but which has a font size of a small enough size. 

Options Menu 
If you change the File Paths settings and specify a directory that does not exist, Geoplot will offer to create that 
directory for you. You should in general always accept the offer, since if you do not subsequently create that 
directory yourself, you may get an error message if you try to then Open data. 

You can set various parameters relating to data input : (a) RS232 port (1-4) for download, (b) specify download 
progress style, (c) date storage format (European or USA), (d) turn off date storage altogether to avoid Y2K 
problems on older computers where the BIOS or RTC functions provide misleading information. 

The default colours for the Dummy colour are : Red=125, Green=125, Blue=255. The default colours for the 
Gridding colour are : Red=255, Green=203 and Blue=0. 

Help Menu Notes 
Selecting the “About Geoplot” item on the Help menu displays a form that displays the version number of 
Geoplot. The form also includes a checkbox which allows you to show a floating form that reports your 
computers Windows system resources and is updated every 1.5 seconds.  
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Export of Data 
You can export grid or composite data to a disk file in a new file format for use by another packages. Eight file 
formats are supported : ASCII column data, XYZ data (where the data separator can be either comma, space or 
tab), Geosoft, Surfer (ASCII or Binary Surfer Grid) and Grass for GIS use. You can either export a batch of data 
in one go or export the currently loaded data set, though please note that the Grass format cannot be used in 
batch mode. Exported Surfer data generates a Surfer Grid file directly which can save considerable time in 
preparing data for immediate use within Surfer. Note that Geoplot and Surfer grid formats are totally different. 

Export Dialog Boxes 
A different Export dialog box is used, depending on whether you choose to export current data or a batch of 
data. Both dialog boxes are accessed from the File menu : select Export Batch Data or Export Current Data, 
though note that you can only access the latter if data has previously been opened using the File menu. Figures 
5-3 and 5-4 show the respective forms and you can see there are some similarities. Export File Format an Export 
File Parameters have the same appearance on both forms and in fact are used in the same way, as discussed next. 
Export File Name and Export File Names behave differently and this is discussed later. Export Batch Data 
additionally has a Save To Directory text box. 

When either dialog box is displayed, a message will appear on the status bar which indicates the order in which 
you complete the dialog box. In the case of export batch data this is : Export File Format, Export File 
Parameters, Save To directory, Drives, Data File Type, Directories, and lastly Filenames. In the case of export 
current data this is : Export File Format, Export File Parameters, Drives, Directories, and lastly Filenames. Set 
each of these in turn as discussed below. 

Export File Format 

Export File Format can be set to XYZ - CommaSV (comma separated variables), XYZ - SpaceSV (space 
separated variables), XYZ - TabSV (tab separated variables), Z (ASCII column data), Geosoft, Surfer (Ascii), 
Surfer (Binary) and Grass. Typical data has the following appearance : 

• XYZ – CommaSV 1,1,205.6 
1,2,213.7 etc 

• XYZ - SpaceSV  1  1  205.6 
1  2  213.7 etc 

• XYZ - TabSV   1 2 205.6 
1 2 213.7 etc 

• Z   205.6 
213.7 etc 

• Geosoft, Surfer and Grass formats are proprietry formats. 
 

Z data is simply a vertical column of data values, separated by carriage return, line feed characters. Data is 
exported from an internal array on a row by row basis. As you change the Export File Format setting, the Export 
File Parameters settings will changes accordingly. 

Export File Parameters 
The Export File Parameters displayed will change, depending on the choice of Import File Format made earlier. 
All the XYZ Export Formats have settings for : Reference Corner, Reference X Coordinate, Reference Y 
Coordinate, X Increment, Y Increment, a check box for Specify Dummy value and a text box for entering 
Export Dummy Value.  

For XYZ, Geosoft, Surfer and Grass exported data, Reference corner specifies where the origin of the X and Y 
coordinates lies within the import data set itself, not Geoplot coordinates ie which quadrant the data set was 
defined in, figure 5-2. The default setting is Bottom-Left but can be changed to Top-Left if required. The 
Reference X Coordinate and Reference Y Coordinate specify the origin of the Reference Corner within the 
export data set itself, not Geoplot coordinates. Usually the origin is 0, 0 (the default values) but can be changed 
should you wish to offset the data – see the example at the end of this section for further clarification and an 
example. The X Increment and Y Increment entries are taken from the sample and traverse intervals of the 
currently loaded data set or are set to default values of 1. If you are exporting a batch of data these values should 
be changed to match the sample and traverse interval of these data sets.  
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For Z exported data, Reference corner specifies the position of the first reading to be exported in terms of 
Geoplot’s X and Y coordinates, figure 5-2. The default setting is Top-Left but can be changed to Bottom-Left if 
required. 

Geosoft exported data has in addition a setting for Rotation Angle. A positive value entered gives clockwise 
rotation, a negative value gives anti-clockwise rotation. 

 

 

Figure 5-2.  Reference corners specified in Export File Parameters. 

Grass exported data has settings for Bias Value and Decimal Places. Bias is added so that all exported data 
values are positive, (with one value at least equal to zero) – the default value is set equal to the Complete 
Statistics minimum value but can be changed if desired. The positive numbers are then multiplied by either 1, 
10, 100, 1000 etc depending on the Decimal Places setting : 0 multiplies by 1, 1 multiplies by 10, 2 multiplies 
by 100, 3 multiplies by 1000 etc. The default Decimal Place setting is based on the current data view resolution : 
if for example the resolution was set to show 2 decimal places, ie #.##, then Decimal Places would be set to 2 by 
default, and the data would be multiplied by 100. You can change the value if you wish, depending on the 
resolution of the output you require. As an example, assume you have a data set where the minimum was +1 and 
the value we will look at for export is +2.12345. Bias will be -1 by default and will be added to +2.12345 giving 
+1.12345. The effect of Decimal Places on the resultant output is shown in the following table : 

Decimal Places Resultant Output 

5   112345   
4   11234 
3   1123 
2   112 
1   11 
0   1 
 

As you change the Export File Format setting, the extension displayed will change to the default associated with 
that file format. A number of predefined extensions are provided should you wish to change the setting or you 
can enter your own extension – do not include a decimal point. The Surfer extension is fixed however at grd, 
since a Surfer Grid file is exported. As the extension changes, you will see the extension change in the Export 
File Name text entry box in the Export Current Data dialog box. 

If you set the Specify Dummy check-box to on and enter a number in the Export Dummy Value text box, then 
when data is exported, any value that matches the Export Dummy Value will have a record created in the 
exported data file. The Export Dummy Number value is set by default to the “User Defined Dummy Value” set  
in Environment Options, Data tab for Z, XYZ,and Geosoft but is set to 1.70141E+038 for Surfer and –9999 for 
Grass. Export to Surfer always has the check-box set to on. 
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Save To Directory – Export Batch Data 

In the case of Batch Export a Save To text box is provided. The default entry is set by the Default File Paths 
setting in Options for Data Export and determines where the batch of exported files will be saved to. You can 
modify this if you wish.  

Export File Names – Export Batch Data 

Change the Drives, Directories and Data File Type settings to display the desired list of files for export in the 
Filenames list box. Highlight the files you wish to export using the Shift key and mouse left-click to select a 
contiguous block or the Ctrl key and mouse left-click to select individual files.  

The Drives and Directories settings are taken either from the Default File Paths settings in Options if no data has 
previously been loaded, or are taken from the last data set loaded. Data will be saved in the Save To Directory. 

Export File Name – Export Current Data 

Change the Drives and Directories settings to display the path where you wish to save the data to. A list of files 
already exported to that directory will appear in the Filenames list box. Enter the file name you wish to give to 
the exported file in the text box. Note that if you change the Export File Format after entering the file name, the 
extension in the Export File Name text box will also change accordingly.  

The Drives and Directories settings are taken from the Default File Paths settings in Options for Data Export.  

Export Process 

When all selections are made, click OK to start the export. Geoplot will check to see if any files already exist in 
the directory you are saving to with the same name and warn you if that is the case. You may then wish to 
specify a different directory to save to (or different name for Export Current Data). If all is well, the exported 
files will be saved in the specified directory and the form will still be present ready for you to export further files 
if you wish. 

 

 

Figure 5-3.  Typical dialog box for Export Batch Data. 
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Figure 5-4.  Typical dialog box for Export Current Data. 
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Generation of Pseudo-sections 
You can create stacked pseudo-sections in both X and Y directions from a sequence of expanding Twin surveys 
(eg 0.5m wide to 1.5m) gathered using the RM15 / MPX15 Multiple Log mode - see Section 5 and Appendix A 
in the MPX15 instruction manual for further information.  

Preparation 
Before you can create the pseudo-sections you must pre-assemble all the Twin data sets into one source 
composite. This data file will be used to extract data from, and hence generate the pseudo-sections. An example 
source composite is provided with the Geoplot installation for a 6 layer pseudo-section : 
c:\geoplot\comp\rwrox\1rmasrc.cmp, figure 5-5. 

 

 

Figure 5-5.  Example source composite for creating pseudo-sections, consisting of a combination of 
0.25m, 0.5m, 0.75m, 1.0m, 1.25m and 1.5m Twin surveys, starting with the smallest spacing survey of 
0.25m at the left-hand side. 

First use Create Blank Composite on the File menu to create a blank composite – its dimension in the X 
direction should be large enough to accommodate all the data sets side by side.  

Prior to assembly, pre-treat the individual composites that make up the source composite - this might include 
conversion to resistivity, subtraction of mean, normalisation etc. In the example shown the data sets have been 
converted to resistivity and a value equal to the mean has been subtracted.  

Next, use the Cut and Combine function to paste the data sets onto the blank composite in order of increasing 
separation – assembly order is very important and must have the smallest spacing at the left-hand side, largest at 
the right-hand side - the Create Pseudo-section form gives you an example. There is no limit to the number of 
individual data sets that can be assembled in this way, and they can be either grids or composites, but since the 
maximum number of configurations in one multiplex sequence is only 8, to assemble more would require more 
than one multiplexed survey. 

Pseudo-section Creation 
Once the source composite is assembled, select Create Pseudo-Section function from the File Menu to display a 
dialog box similar to that shown in figure 5-6.  

Source Composite is the name of the assembled composite we have just created – enter the full path but no file 
extension, as shown in the figure. Number of layers in a section is equal to the number of data sets used to 
assemble the source composite. Thickness of Layer may be stepped through the values 0.125m, 0.25m, 0.5m, 
1.0m and 2.0m. This allows you to control the aspect ratio of the section for the most pleasing presentation. 
Section direction may be set to either X or Y, and determines in which orientation the pseudo-sections will be 
made : choosing X will give sections that align with the traverse direction, and choosing Y will give sections 
that are perpendicular to the traverse direction.  

After you have made all your entries in the dialog box click on Create and Geoplot will then extract data from 
these combined data sets, putting them in the correct sequence to build up a set of stacked pseudo-sections. A 
Save As form will then appear, allowing you to save the stacked pseudo-section sequence. You can then use 
graphics to look at the result, figure 5-7.  

You will see many such sections stacked under one another, extending right across the site. It can be useful to 
select part of the graphics plot to view just some of the pseudo-sections in detail, rather than trying to get an 
overall view of the sections.  
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Figure 5-6.  Typical dialog box for creating stacked pseudo-sections. 

 

Figure 5-7.  Stacked pseudo-sections generated with direction = X (left-hand side) and direction = Y 
(right-hand side). You can select a smaller graphics block for looking in more detail at the sections. 
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Contours Lines and Overlays 
Contour lines can be generated and overlaid on shade plots by using a combination of process functions and 
appropriate shade palettes. An example data set, where contour lines have been overlaid, is provided in the 
Geoplot installation : c:\geoplot\comp\g_rgrv\1.cmp. Open this file and look at a shade plot using the following 
parameters and palette : minimum = -7.5, maximum = +7.5, contrast = 1, units = absolute, palette = testpal2 (ie 
the palette generated in the tutorial which has a red band at the top). You should see a plot similar to that shown 
in figure 5-8.   

 

 

Figure 5-8.  Example of contour line resistance data overlaying grey scale gradiometer data – the 
contour lines shows much more clearly on screen since they are bright red on a grey background.  

The background data is example gradiometer data set provided with Geoplot, ggrv\1.cmp, which has been 
processed and interpolated so that sample and traverse interval = 0.25m and then saved as ggrv\1dgkc.cmp. 
Superimposed on the central portion of this is a contour line representation of matching resistance data, also 
processed and interpolated so that sample and traverse interval = 0.25m. Although the black and white figure 
does not fully show the excellent contrast seen on screen or with colour plots, you can see that a ditch, running 
vertically through the plot, shows clearly in both surveys (a dark band on the gradiometer plot). There is also 
good correspondance with some of the isolated high strength anomalies. 

We will use the example data set provided, c:\geoplot\comp\rgrv\1.cmp, to illustrate how to generate contour 
lines and then show how to superimpose these on another example plot, c:\geoplot\comp\ggrv\1dgkc.cmp. 

Generation of Contour Lines 
The principle sequence of operations needed to generate contour lines is :  

• Despike data. 
• Make data set bipolar. 
• Interpolate so that sample and traverse interval = 0.25m. 
• Decide whether you want to select positive or negative data. 
• Slice through the data at a level where you want the contour line. 
• Reference the new data to zero. 
• High Pass filter the data to detect the edges of the slice, creating both positive and negative edges. 
• Select the outer, negative, edge only. 
• Bias the contour line above zero. 
 

Before processing the data, we must first create a palette with 25 grey levels that has a red band at the top and a 
blue band at the bottom – this will help to illustrate the generation of contour lines. To do this we can modify 
palette testpal2, which we created in the tutorial, so that it additionally has a blue band at the bottom. Select 
Palette from the Graphics menu, open palette testpal2, move the colour sliders to create a bright blue colour in 
the colour box and then click on node 25 to add the blue band to the palette. Save the palette with the name 
redgblu.  
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We are now ready to create the contour lines. We have already despiked the rgrv\1.cmp data set in the tutorial 
and saved it as rgrv\1k.cmp, so open this data set ready for the next step. Look at a shade plot using the 
following parameters and palette : minimum = -3, maximum = +3, contrast = 1, units = SD, palette = redgblu.  

High Pass Filter the data using X = 10, Y = 10, Weighting = Uniform. This will create a bipolar data set, 
centered around zero. 

Interpolate the data in the Y direction, then X direction (with Method = SinX/X) and interpolate again in the Y 
direction then X direction (with Method = Linear), so that sample and traverse interval now equal 0.25m – see 
the left-hand plot of figure 5-9.  

 

 

Figure 5-9.  Sequence of plots showing steps in the generation of a contour line plot. 

At this point we need to decide whether we want to look at low resistance or high resistance data – since the data 
is now bipolar this translates to looking at negative or positive data. We want to compare the response of 
resistance and gradiometer surveys over a ditch so we are interested in the low resistance or negative data. In 
order to decide on the specific level at which we slice the data, change the plotting parameters units to absolute. 
The plot shows all positive readings above +3 ohms in red and all negative readings below –3 ohms in blue. Try 
changing the plotting parameters to : minimum = -5, maximum = +5, and then back to : minimum = -4, 
maximum = +4. The latter parameters give a balance between sufficient grey background and continous low 
resistance features, second from left plot in figure 5-9.  

We will therefore slice at the –4 ohm level. Apply the Clip process function to the data with parameters : 
minimum = -1000 (a number much larger that the data set), maximum = -4. All data out of this range will in 
effect be rejected, including the positive readings. The graphics plot will appear totally blue at this stage. In 
order to reference the new data set to zero use the Add process function to add +4. Apply the Absolute process 
function so that now we have only positive data on a zero background. The graphics plot will now faintly 
ressemble the original negative readings we wish to convert to contour lines. 

If  you had decided to create contour lines for the high resistance data, ie the positive readings, then instead of 
using Clip with minimum = -1000, maximum = -4, you would have chosen to Clip with minimum = 4, 
maximum = +1000. Then you would have added –4 and omitted the Absolute stage. 

Now use the Search and Replace process function to change all readings above zero to an arbitrary value of 100 
with parameters : Search From = 0.001, To = 1000 (a number larger than the data set), Replace With = 100. 
Optionally apply the Despike process function, using default parameters, to remove any isolated points. The 
graphics plot should now appear similar to the central plot of figure 5-9 and shows the desired slice at the –4 
ohm level. Note that the selected area is slightly different from the previous plot since the use of red and blue 
bands in a 25 colour palette is only a coarse selection procedure. You could improve matching by increasing the 
number of bands in the palette. 

Next, apply the High Pass Filter process function, using X = 1, Y = 1, Weighting = Uniform, to detect the edges 
of the slice. The resulting plot, shown to the right of centre in figure 5-9, has red contours on the inside of the 
low resistance areas and blue contours on the outside. 

To select just the outside blue, negative, contours, which will give a better line contour  appearance, use Search 
and Replace with parameters : Search From = 0, To = 1000, Replace With = 0. Having rejected the positive 
readings, now use Absolute to convert the required negative readings to positive readings. The graphics plot will 
now look like the right-hand image of figure 5-9, which is the desired contour line plot. Although the graphic 
image looks correct with the present plotting parameters, the required underlying data points, which are above 
zero, range from 11.1 to 55.6. Therefore use Search and Replace again with parameters : Search From = 1, To = 
1000, Replace With = 100, and the resulting contour line data set will consist of only 0’s or 100’s. This 



     Additional Information      5-13

completes the generation of  the contour lines and so the data set may now be saved : for example use the name 
contline. 

Overlaying Contour Line Plots on Shade Plots 
We will now overlay the resistance contour plot that we have just created on top of the equivalent gradiometer 
data. This latter data set is provided in the Geoplot installation as c:\geoplot\comp\ggrv\1dgkc.cmp, already 
processed and interpolated to the same sample and traverse interval. Open this file and look at a shade plot, as 
before, using the following parameters and palette : minimum = -7.5, maximum = +7.5, contrast = 1, units = 
absolute, palette = testpal2. This data set has been clipped to +/-6nT so that when used with this palette and 
absolute plotting parameters of +/-7.5, no data points will show as red – this is a vital step in producing the 
following combined plot. 

Next use the Cut and Combine process function to add the contour data set, contline.cmp to composite 1dgkc. 
Since we are adding a file of different dimensions to a position in the centre of the original file we need to enter 
all the details in the dialog box : select contline.cmp in the Cut From File Name text box, set Cut From Top-Left 
X,Y = 1,1, Cut From Bottom-Right X,Y = 160,240, Combine To Top-left X,Y = 81,1 and finally set Combine 
Function to Add. 

 

Quick method for finding composite size 

You can determine the size of a composite, in units of readings, by applying the Statistics 
process function, with Block Off, and look at the “BR” value reported at the bottom of the floating 
form. This will provide any X,Y values you may need to enter in block operations. 

 

 

This will produce an overlay of the contour lines on the shade plot as in figure 5-8. Note that it depends on the 
correct matching of  : (a) plotting parameter clip values, (b) process function clipping of the shade plot data set, 
(c) bias of the contour line data set well above the shade plot data set, and (d) definition of an appropriate 
palette. You can modify the values shown in the preceding example or define a different palatte to suit the 
circumstances. For example, if you only require black contours on top of a normal grey scale shade plot you 
could use a normal palette and possibly omit clipping of the gradiometer data. 
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Introduction to Processing Guidelines 
The following four sections present general guidelines on how to approach data processing. This includes the 
purpose and order of processing, typical process parameters and use of graphics with processing. The first three 
sections are dedicated to specific survey types, resistance, gradiometer and magnetometer data. The fourth 
section gives general advice for data that does not fall into any of these categories, along with brief guidance for 
differential magnetometer, magnetic susceptibility and electromagnetic data. 

It is very important for you to be aware that there is a distinct difference between gradiometer, magnetometer 
and differential magnetometer data - be careful not to confuse the three. Gradiometer refers to a two sensor 
instrument, with sensors fixed relative to one another (eg Geoscan FM18, FM36 or FM256 Fluxgate 
Gradiometer). A gradiometer inherently produces data that is already high pass filtered and centered around 
zero. Magnetometer refers to a single sensor instrument, where there is no second reference sensor (eg a single 
bottle proton magnetometer). Single sensor magnetometer data will be single polarity, with the small reading 
changes of interest superimposed on a much larger background. Differential magnetometer refers to a two 
sensor instrument where one sensor moves, the other is a fixed reference sensor and both are time synchronised 
(eg a pair of single sensor proton magnetometers). Differential magnetometer data will be bipolar and is 
generated by taking the difference between the roving and fixed sensor readings. 

These sections do not present specific examples for each possible step in the processing sequence - specific 
examples for each Process function may be found in the preceding section. Examples of how several process 
functions are brought together may be found in the following case studies section and processing techniques 
section. 

Before further discussion, there are four points relevant to all data processing that should be made: 

• Except for the initial viewing of raw data, it is recommended that all processing results be reviewed with 
graphics plotting parameters entered as absolute units rather than Standard Deviation units since some 
process functions can have a very significant effect on the subsequent standard deviation, eg Despike. It is 
much easier to compare graphics before and after processing using absolute units. 

• Remember that the distance units used in process functions are entered in units of readings, not metres. This 
is especially relevant to block coordinates and process window sizes. 

• Interpolation should, in general, be one of the final functions to be used. There is nothing to be gained and, 
indeed, process time can significantly increase if you expand data prematurely. An exception may be if you 
need to modify the sample or traverse interval of one composite to enable it to be merged with another 
composite prior to a process session.  

• The following sections should be read as guidelines only,  not a rigid set of rules. They may well need 
modifying for specific data sets and circumstances. In particular, sample and traverse interval can have a 
significant impact on your choice of process parameters. 

 

Before reading any further, please make sure you have followed the tutorial and are familiar with the general 
approach to processing in the Geoplot environment. As you read on, the purpose and application of each of the 
functions will become clearer, and you will see how they are used in relation to the other functions.  

Guidelines for Processing Resistance Data 
Introduction 
These guidelines are written primarily for large area resistance surveys performed with the Twin-Electrode 
configuration. However, most of the advice will be equally relevant to other configurations, such as Wenner and 
Double-Dipole, though, for example, in these cases edge matching may not be a problem. The guidelines for 
resistance data may also be used with electromagnetic (conductivity) data if it is first converted to resistivity by 
taking the reciprocal. Note that we principaly refer to resistance data in the text, not resistivity data, though it is 
simple to convert between from one to the other using the Multiply process function. 

Processing Sequence 
A typical processing sequence would be to initially display and review the data, remove data collection defects, 
convert to appropriate units, reduce the geological response, and finally enhance and present the archaeological 
response. Defect removal includes : (a) removal of noise spikes and (b) edge matching. Unit conversion may 
include (a) resistance to resistivity and (b) resistivity to conductivity. Reduction of the geological response 
involves the use of high pass filters. Enhancement and presentation includes : (a) smoothing, (b) interpolation, 
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(c) separation of high and low resistance features, (d) variability plots, and (e) use of compression to optimise 
graphics plots. 

The order of processing can be very important for some functions  - for example we saw in Chapter 3 that you 
should despike before applying a low pass filter, to avoid the spike energy smearing out. As another example, 
you should edge match grids before applying a high pass filter otherwise the edge mismatch will show up 
strongly in subsequent plots. Pay particular attention to the recommended sequence which closely mirrors the 
following discussion. 

Initial Data Display and Review 
Before starting any process session you should look at the data using the Graphics menu. Shade plots (Clip 
parameters) and Trace plots (Standard parameters) using the default plotting parameters are the best way to view 
the raw data. Examine the plots for archaeological features, geological features and data collection defects.  

The archaeological response will be superimposed on a background signal representative of the local geology. 
Archaeological features may show up strongly or weakly, depending on the depth, size and contrast of the 
features with respect to the surroundings. Generally speaking, they tend to be weaker than the geological 
response, which often dominates the plot. 

The geological features tend to be relatively strong and slowly changing across the plot. Often the background 
resistance will vary markedly from one end of a site to the other, especially over large areas. Smaller scale 
geological responses may also occur due to local changes in topsoil thickness, natural depressions in the subsoil, 
etc which can sometimes produce anomalies similar to those produced by archaeological pits. 

The principal defects in Twin Electrode resistance data are noise spikes and discontinuities at the edges of grids. 
Noise spikes arise in two ways, with both most likely to be a problem in very dry conditions. Firstly, you may 
observe low level noise spikes, or "noisy" looking data, and this is usually due to very high contact resistances. 
Secondly, you may observe occasional wild readings, sometimes as large as +/-1000% changes about the mean, 
and these are due to an open circuit at the potential probe at the moment of logging a data point - Trace plots are 
ideal for highlighting these spikes. Grid edge discontinuities are usually due to improper remote electrode 
placement during moves between grids. They can also arise if adjacent grids are surveyed at different times of 
the year, and the resistivity contrast or background has changed. They may even arise if weather conditions 
change from very dry one day, to very wet the next. 

Defect Removal - Noise Spikes 
It is best to remove noise spikes prior to any further processing. This can be done using the Despike function 
alone but using the Clip function first to limit the data is recommended. This will make the statistical 
calculations used in Despike more realistic as the Despike window scans across the data. 

Depending on the data set, you could initially consider clipping at +/- 3 standard deviations (SD) about the mean 
- you can obtain a value for 1 SD using the Statistics function or, for saved data, look at the histogram and 
statistics in the Graphics dialog screen, which gives a value for 3 SD already calculated. However, it is very 
important that you subsequently check that the chosen clipping level has not clipped features of interest - this is 
quite likely if the underlying geology has a regional gradient. You can check the effect of clipping, either by 
careful inspection of the graphics plots (shade colour plots especially), or by using Cut and Combine to examine 
the clipped data. If clipping is removing data then consider clipping instead at +/- 4SD about the mean, or higher 
if neccessary. Clipping levels of below +/-3 SD about the mean are very likely to start removing data in 
resistance plots. 

After using Clip, noise spikes will still remain in the data and should be removed using the Despike function. In 
general, it is advisable to start with a symetric, square window with radii X=Y, Threshold set to the maximum 
value of 3 standard deviations (SD), and Spike Replacement set to Mean. Remember that the window radius is 
expressed in units of readings, not metres, and that the actual diameter of a processing window is equal to (2 x 
radius + 1) readings.    

With these settings a window of X=Y=3 will apply moderate despiking. Decreasing X and Y to X=Y=1 will 
substantially increase the despiking effect. Decreasing the window size to increase the amount of despiking is 
preferable to decreasing the Threshold since lower Threshold values (2 SD and below) can start to remove 
features as well. A combination of larger window sizes and lower Threshold values also can be prone to 
removing features as well as noise spikes. 

If grid edge discontinuities are very bad then consider using X=Y=1, Threshold=3 SD, so that the window is 
least affected when it straddles a discontinuity. If this approach does not work then we recommend that you 
adopt an iterative procedure by performing an approximate edge match first (see next section), despiking the 
data, and then performing a second, final, edge match. 
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Whichever parameter values you try, you are strongly advised to save the despiked data. Then use the Cut and 
Combine (subtract) function to examine the effect of the despike operation - if you can see traces of features 
present in the difference plot then you should reduce the despiking. 

Defect Removal - Edge match  
There are three methods for removal of grid edge discontinuities, depending on the origin and extent of the edge 
match problem. These are, in order of increasing complexity, : (a) use of the Add function, (b) use of the Edge 
Match function, (c) use of the Multiply and Edge Match functions in combination. 

The first approach is most often used if you have deliberately introduced a background shift at some stage in the 
survey. For example, if there was insufficient cable on the remote probes to achieve a proper match with 
previous grids, then you may have to set a new background level. In this case you will probably have two, 
perhaps three, large areas with an edge discontinuity between them, requiring just the addition of a constant 
value to match them up again. This could have been introduced as a Bias when creating a Mesh Template, but if 
this was not done then it can be introduced at the Composite stage using the Add function. An example of this 
approach may be found in the entry for Add in the Reference section. An estimate of the shift required could 
come from field notes or by using the Statistics function in block mode to compare the overall means either side 
of the discontinuity. 

The second approach, using the Edge Match function, may be used for more routine situations, usually where 
the difference between edges is relatively small, though it can cope with large differences too. These edge match 
problems usually originate from improper field procedures with respect to placement of the remote electrodes 
(see the RM4 and RM15 manuals for details). First, examine a Shade plot of the composite and identify areas 
where you are satisfied there are no edge match problems - there is no point in applying the Edge Match 
function to these grids. Next, work out from these areas into regions of discontinuity using the Edge Match 
function. If one route does not work satisfactorily then try another - the example in the Edge Match function 
description shows a survey where it was neccessary to take an indirect route to edge matching and involved 
several repeated edge matches. 

The third approach, using a combination of Edge Match and Multiply, may be called for if you cannot achieve a 
satisfactory edge match using either of the above methods. You will almost certainly have to use this approach if 
you are trying to match two surveys done at different times. This is because not only will there be a difference in 
the background resistance, there will probably be a difference in the contrast mechanism that produced the 
archaeological or geological responses. This will require use of the multiplication function to re-normalise one 
set of data to the other, prior to using the Edge Match function. 

The procedure is to first adjust one grid, which we will call M, with respect to an adjacent, reference grid, which 
we will call R, by multiplication (not addition). Next, you adjust grid M with respect to grid R using the Edge 
Match function. The result will be that grid M will be modified to match grid R. This procedure is described in 
detail next. 

First select the edge to be matched. Use Statistics in block mode to select 1,2 or 3 rows of data on the reference 
side of the edge - use 1 row of data if you can see that a wider block will start to overlap strong anomalies not 
located immediately adjacent to the edge. Process and note the mean value of the selected block, meanR. Next, 
repeat this process on the other side of the edge, noting the mean value of this block, meanM. Use the multiply 
function in block mode to multiply grid M by the ratio meanM / meanR. This will re-normalise any contrast 
differences, and in the process will raise or lower grid M with respect to the reference grid, R. Next use the Edge 
Match function, as described earlier, to match grid M to grid R, and hence produce the final edge match. This 
completes the edge match procedure for one grid. Proceed throughout the area of the composite that needs edge 
matching, grid by grid, correcting all edge defects by means of the Multiply and Edge Match functions in turn. 

In some circumstance it may be impossible to achieve a satisfactory edge match using the above techniques. 
This may arise if the mobile probes have been brought too close to the remote probes and a complex change to 
the background resistance is introduced. Occasionally the polarity of an anomally may reverse from one season 
to another, or it may disappear altogether. In this case, if a feature crosses the edge boundary, it will be 
impossible to edge match the polarity of the response and hence match the grid edges. 

Conversion of Resistance to Resistivity 
The RM4 and RM15 resistance meters make measurements in terms of resistance (units of ohms), not resistivity 
(units of ohm-metres). The resistance value measured depends on the geometry of the probe array used - 
different probe arrays and geometries will give different resistance values over the same ground. To avoid this 
dependance on probe array geometry it is usual to convert resistance to resistivity. (Strictly speaking readings 
are converted to Apparent Resistivity, since the equations used for the conversion usually only apply to the ideal 
situation of a uniform, non-layered, earth). 
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An approximate equation to convert Twin array resistance data to resistivity (providing the distance to the 
remote probes is much greater then the mobile probe separation) is : 

Resistivity (ohm-metres) = 3.1415 x Resistance (ohms) x Mobile Probe Separation (metres) 

For example, if the mobile probe separation is 0.5m, then multiplying resistance by (3.1415 x 0.5) = 1.5707 will 
convert the data to resistivity. 

If you only wish to look for changes within the survey data and are not concerend with comparing the response 
for different probe configurations then you may wish to omit this stage of processing. This approach fits the 
present release of Geoplot which assumes the presence of resistance data, rather than resitivity data - any 
graphics plot will be labelled in units of ohms, rather than ohm-metres. 

Conversion from Resistivity to Conductivity  
If you wish to compare the results of a resistance survey with that of an Electromagnetic instrument, such as the 
EM31 or EM38, then you must first convert resistance data to resistivity data, as described above. The resistivity 
data can then be converted to conductivity data by using the Power function with Power Value set to -1. Of 
course, conductivity plots will show anomalies inverted with respect to resistivity plots. 

Removal of Geological Background   
The geological response, which sets the background resistance, is often much stronger than the archaeological 
response and can change significantly from one end of a site to the other. Thus the response due to weaker 
archaeological features can be very difficult to observe if the graphics plotting parameters are set to give an 
overall view of the data. This is especially the case where a geological gradient exists accross the site : if the 
plotting parameters are chosen to emphasise a weak archaeological feature at one end, you will probably not be 
able to observe weak features at the other end. 

Fortunately, the geological response usually (but not always) changes slowly throughout the survey, whereas 
cultural features such as pits, ditches, and foundations change more rapidly. Cultural features usually have a 
scale of the order of 0.5 to 2m while geological features have a scale of 10m or more. Great improvement in 
small feature visibility can be obtained by using the High Pass Filter function, described next, to remove the 
geological background response. It is very important that data is edge matched before applying a high pass filter 
otherwise the edge mismatch will show up strongly in subsequent plots. 

Select the High Pass Filter function; this requires entry of a window size and type of weighting. It is advisable to 
use as large a window size as possible, with X and Y radii of the order of 5 to 10 readings, preferably nearer 10. 
Radius values of less than 3 to 4 may result in overly "crisp" data and the unwanted appearance of edges due to 
a geological response. It is common to use filter window dimensions which are equal in units of metres, rather 
than readings so take into account differences in sample and traverse intervals when entering X and Y radii. 
Uniform weighting is recommended. 

Note that the High Pass Filter function is numerically complex and will be slow for large data sets, large radii or 
slower computers. Even so, do not be tempted to use a small radius just to speed up the process - only use small 
radii if you have very good and valid reasons. 

The resulting high pass filtered data will be bipolar, with a near zero mean, because the High Pass Filter will 
have subtracted a moving average from the original composite. This will affect the way graphics plotting 
parameters are entered. For example if you were using Shade plot (Clip) the plotting parameters would be 
entered as absolute values (monopolar) for the non-high pass filtered data, probably determined more by the 
geology than archaeology. After high pass filtering these will have to be changed from monopolar to bipolar 
entries with new magnitudes to reflect the archaeology, not the geology (for example Min = 100, Max = 160 
might become Min = -20, Max = +20). If you want to compare the effect of different window sizes then you 
may find it useful to enter the parameters in units of standard deviation, since these will then track the increasing 
removal of information as High Pass Filter radii are reduced. The mean can be restored by using the Add 
function, though this is not a neccesary step. See the entry for High Pass Filter in the function reference for 
examples. 

Be sure to compare the data before and after high pass filtering for residual signs of the underlying geology. It is 
important that these are not subsequently interpreted as an archaeological response. 

Smoothing 
Occasionally it may be desirable to smooth resistivity data. This process is implemented with the Low Pass 
Filter function which reduces the local variability from the data at the expense of spatial detail. This can improve 
the visibility of weak archaeological features such as deeply buried foundations, wide ditches, subtle linear 
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features. It can also be used to improve the appearance of relief or artificial sunshine plots, especially if data has 
been sampled at 0.5m intervals or finer. The procedure is as follows. 

Select the Low Pass Filter function; this requires entry of a window size and type of weighting. In general it is 
advisable to use small window sizes. If sample and traverse interval are 1m (not uncommon with resistance 
data), then consider X and Y radii of the order of 1 to 2 readings. Radius values of greater than 2 may result in 
increasing suppression of the desired archaeology, and more emphasis of the underlying geological response. 
Often smoothing with radii between 1 and 2 would be desirable. An approximation to this can be made by 
repeated smoothing with radii of X,Y = 1, say three to five times. However, this may be at the expense of slight 
ringing and generation of artifacts in the data so results should be carefully examined. It is common to use filter 
window dimensions which are equal in units of metres, rather than readings so take into account differences in 
sample and traverse intervals when entering the X and Y radii. 

If sample and/or traverse interval are 0.5m then there is greater flexibility in the choice of radii to achieve the 
desired smoothing. Use of such data collection intervals avoids having to try and approximate radii of 1.5. Once 
again very large radii, this time of the order of 4 readings, will start to suppress the archaeology, with more 
emphasis of the underlying geology. 

Gaussian and Uniform weighting is available. Gaussian weighting is always recomended for Low Pass Filtering. 
Uniform weighting will introduce processing artifacts in the vicinity of large data values (impulsive, spikes) and 
will remove Fourier components with a period equal to multiples of the window diameter. Regardless of 
weighting, you should always remove or suppress noise spikes first, using Despike and/or Clip as described 
earlier, to prevent the noise spike energy from smearing. 

Interpolation 
Interpolation (expand) can also be used to give a smoother appearance to the data and can improve the visibility 
of larger, weak archaeological features. However, it does this at the expense of increasing the number of data 
points, so for medium to large composites there may not be enough memory to use this function. In this a large 
composite can be split into a number of smaller composites. 

Remember that if you are using interpolation to improve the visual appearance, this is only a cosmetic change. 
You are creating artificial data points and you cannot subsequently use other processes to try to extract better 
information than was contained within the original data set. Indeed, beware of the danger of reading too much 
into expanded data, especially if you have used interpolate several times. Expansion using Interpolate is no 
substitute for good data sampling in the first place. Also, if used too soon it will unneccessarily increase 
subsequent processing times. It is recommended that Interpolation is one of the last process functions to be used 
in a process session. 

If you do use Interpolate then always choose the Sin(x)/x expansion method for best results. You can use 
interpolate (expand) to improve the appearance of relief or artificial sunshine plots which benefit from greater 
data density. However, remember that the Sin(x)/x interpolation method must be used since the relief plot will 
emphasise the imperfections in linear interpolation, rather than the archaeology, and would thus defeat the 
objective. 

One caution : multiple expansions using Sin(x)/x can introduce “ringing” distortion at edges. It may be better to 
use Sin(x)/x for the first expansion and Linear for second and subsequent expansions; try both and examine the 
results for the chosen display  display format. 

Separation of High Resistance or Low Resistance Features 
It is possible to separate out high and low resistance features within a composite that has previously been High 
Pass Filtered since such data has a zero mean. This can help when trying to interpret some sites. In most cases it 
will be found that high resistance features such as walls, rubble, paving areas, etc will occur as positive readings 
and low resistance features such as pits, ditches, clay dumps etc will occur as negative readings. The Clip 
function may be used to separate these two types of features as follows. To isolate just the high resistance, 
positive, features set the Minimum clip level to zero and Maximum clip level equal to the most positive reading. 
To isolate just the low resistance, negative, features set the Minimum clip level equal to the most negative 
reading and the Maximum clip level to zero.  

There are several ways of looking at the clipped data. You can use Shade plots (Clip parameters), where plotting 
parameters Min and Max are symetrical about zero (for example Min=-20, Max=+20), and Contrast=1. Use of 
the colour palettes will be useful here. If you use Pattern plots then the corresponding Clip plotting parameters 
are best entered as Min=0 and, for example, Max=20. Alternatively you could use either Shade plots or Pattern 
plots with Relief plotting parameters which can be especially effective. 
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Areas of Statistically Different Activity 
Areas of statistically different activity can be located by using the Standard Deviation / Variance Map function 
and may be used to compliment standard graphical methods for site interpretation. This function replaces the 
data set by either the local variance or local standard deviation, whichever parameter is chosen, so make sure 
you have saved any intermediate results. The new data set will consist of all positive numbers, with a value of 
zero indicating uniform activity in that region. Numbers greater than zero indicate by their magnitude the 
increasing level of activity or degree of change in that region. 

Small window sizes (radii 1m to 3m) will give a more detailed picture of activity, whereas larger window sizes 
(5m to 10m) will give a less detailed, broader picture of changes. If large window sizes are used over non-high 
pass filtered resistivity data then the variability plot is more likely to reflect the geology rather than the 
archaeology. It may be preferable therefore, if you want just a broad overall view of the archaeology, to perform 
a high pass filter prior to creating a Variance Map. 

Graphics in Processing and Use of Compression 
The Graphics menu contains a versatile suite of tools for viewing resistance data, whether it be raw, high pass 
filtered, smoothed, high/low separated, or variability data. Shade and Pattern plots are particularily useful, with 
either Clip, Compress or Relief plotting parameters. However, it is very important to keep in mind the dynamic 
range of the data and the dynamic limits of the screen and the printer. With few exceptions, resistance data will 
exceed the capability of these display devices. 

Often use of Clip plotting parameters is sufficient to cope with such circumstances, and large value readings are 
simply limited to a set level. If you wish to view both large and small magnitude features at the same time then 
you can do this by compressing the data. Three of the Graphics types, Shade, Pattern, Dot-Density (but not 
Trace) offer Compress plotting parameters, which apply an auto-scaling arctangent compression to help in this 
respect. However, for maximum flexibility, it may be best to use the Compress function in the Process menu, 
then you are free to choose subsequent plotting parameters, which can then include Clip and Relief. You can 
then also look at compressed data using Trace plots. The entry under Compression in the process reference gives 
guidance on how to compress the desired range of data into the number of available display levels, using either 
Logarithmic or Arctangent compression. 

Finally, it is recommended that resistance data be viewed using all the parameter modes of Shade or Pattern 
plots : Clip, Compress or Relief. A combination of these will often help resolve subtle archaeological and 
cultural features. For example, rotating the sun direction and changing the elevation in Relief plotting 
parameters often reveals features that would otherwise be missed - usually this is best applied to non-high pass 
filtered data. Similarly, adjusting the Contrast between 0.1 and 10 in Clip and Compress will render subtle 
features visible.  

Guidelines for Processing Gradiometer Data 
Introduction 
These guidelines are primarily written for large area magnetic surveys performed with a fluxgate gradiometer 
such as the Geoscan Research Fluxgate Gradiometers FM256, FM9, FM18 or FM36. Note that there is a distinct 
difference between gradiometer and magnetometer data - see the introduction to Processing Guidelines for 
further clarification. 

Processing Sequence 
A typical processing sequence would be to initially display and review the data, clip the data, identify and 
neutralise the effect of major geological and ferrous responses if they are a potential problem, remove data 
collection defects, and finally enhance and present the archaeological response. Initial clipping is to reduce the 
effect of iron spikes. Neutralisation of the effect of major geological and ferrous responses involves replacement 
with dummy readings, where necessary, though in many cases the process functions are able to handle these 
situations without replacement. Defect removal includes: (a) removal of grid slope, (b) edge matching, (c) 
removal of traverse stripe effects, and (d) removal of traverse stagger effects, (e) removal of periodic errors. 
Enhancement and presentation includes: (a) removal of iron spikes (b) smoothing, (c) interpolation, (d) 
separation of positive and negative features, (e) variability plots, (f) use of compression to optimise graphics 
plots. Statistical analysis can also be applied and an example of this is discussed later in this chapter. The order 
of processing can be very important for some functions - for example you should despike before applying a low 
pass filter, to avoid the spike energy smearing out.  
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Initial Data Display and Review 
Before starting any process session you should look at the data using the Graphics menu. Shade plots (Clip 
parameters) and Trace plots are the best way to view the raw data. Since gradiometer data is bipolar, centred 
around zero, it is best to use absolute plotting parameters, say Clip plotting parameters of Minimum=-10nT, 
Maximum=+10nT initially, and Trace resolution of 1nT initially. This is because surface iron can significantly 
distort the standard deviation of a composite and hence, if you used standard deviation parameters, you would 
get a distorted initial view of the data, showing the ferrous response rather than the archaeology. Examine the 
plots for archaeological features, ferrous objects, geological features and data collection defects. 

The archaeological features may show up strongly or weakly, depending on the depth, size and contrast of the 
features with respect to the surroundings. Generally speaking, they tend to be weaker than the ferrous response 
that can predominate on some sites, especially in an urban environment. If the survey is over a quiet site, with 
few apparent features, then you should try much smaller Clip plotting parameters, say Minimum=-2nT, 
Maximum=+2nT to see if there are any very low level features present - some weak, but archaeologically 
significant, features may have strengths of under 1nT. 

Ferrous objects are usually unwanted modern iron features that are deemed to be archaeologically uninteresting 
(although occasionally there may be ferrous responses of archaeological interest). These objects may be 
scattered randomly throughout the site, often near the surface, have a strong response, often bipolar (depending 
on the sample interval used), and are very localized. We refer to these as "iron spikes". Some iron dumps may 
show up as broad regions of very strong positive or negative response, surrounded by a region with strong 
response of opposite polarity (as opposed to kilns which have a more characteristic response). Modern ferrous 
pipelines usually show up as strong regular alternating patterns of positive and negative regions, distributed 
along the length of the pipeline, although they can also show up as strong, linear, single polarity, responses. 
Wire fences at the boundary of a survey often give a strong response. 

Geological features are often more difficult to positively identify. Since gradiometers inherently perform their 
own high pass filter they will already have reduced the broad scale geological response (and, incidentally, any 
broad scale archaeological response such as that due to an extensive midden). The high pass filtering action may 
not, however, have reduced any response to local changes in topsoil thickness, natural depressions in the subsoil 
etc which can produce anomalies similar to those produced by archaeological pits. Nor will this action have 
removed the strong response due to large linear regions such as igneous dykes. 

There are several data collection defects that can arise in a fluxgate gradiometer survey. These include: slope in 
the grid data, discontinuities at the edges of grids, traverse striping, traverse staggering and periodic errors.  

Slope errors in grid data show as a very small and slow drift in the average data value throughout a grid, leading 
to a small difference in the background levels between the first and last traverses. However, it is essentially 
constant during the time required to scan an individual traverse.  

Grid edge discontinuities arise due to improper choice of the zero reference point, incorrect zeroing at the 
reference point, or failure to regularly check alignment and re-zero the instrument every few grids. 

Traverse striping is where alternate traverses have a slightly different background level. They show up in 
graphics plots as a series of stripes orientated in the traverse direction, and are especially noticeable if the 
plotting parameters are set to look at very weak features. They occur because lf instrument tilt, usually due to 
improper alignment, failure to check alignment regularly or inattention of the operator to carrying angle. It can 
be particularly noticeable with zig-zag traverses. 

Stagger defects arise due to poor positioning of the instrument along the traverse when a reading was recorded. 
For example, a linear anomaly running perpendicular to the traverse direction shows, not as a clean linear 
response, but as a chevron type pattern, with the maximum of the response being displaced first forward and 
then backwards in each alternate traverse. It usually occurs when zig-zag traverses are being used at a rapid 
walking pace and small sample interval. 

Periodic errors (periodic modulation of the data) show up as a series of linear bands, perpendicular to the 
traverse direction, with a periodicity usually approximately equal to one or two walking paces (1 c/m or 0.5 
c/m). They usually arise because the operator changes his stance or elevation slightly whenever the left or right 
foot is placed on the ground, or when launching forward for the next pace. It is more likely to be a problem if the 
speed of walking is high, the ground has a higher than normal magnetic susceptibility, the terrain is uneven e.g. 
ploughed, the alignment of the gradiometer sensors is not checked often enough or done over a poor alignment 
and balance station, or any combination of these factors. It is also more likely to be noticeable if you are setting 
plotting parameters to look at very weak responses.  
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Clipping of Iron Spikes 
It is useful to clip noise spikes prior to any further processing. This will make the statistical calculations of some 
other process functions less liable to be compromised by wild data values. It is further useful because it reduces 
the demands on the limited dynamic range of the display devices. 

Depending on the data set, you could initially consider clipping at +/- 3 standard deviations (SD) about the mean 
- you can obtain a value for 1 SD using the Statistics function or, for saved data, look at the histogram and 
statistics in the Graphics dialog screen, which gives a value for 3 SD already calculated. However, it is very 
important that you subsequently check that the chosen clipping level has not clipped features of interest - this 
can often happen on sites with low standard deviation. You can check the effect of clipping, either by careful 
inspection of the graphics plots (shade colour plots especially), or by using Cut and Combine to examine the 
clipped data. If clipping is removing data then consider clipping instead at +/- 4SD about the mean, or higher if 
necessary. You may even wish to clip at standard levels, e.g. +/-10 nT about the mean, but this depends on the 
features of interest. For example to preserve kiln responses you may have to clip at levels greater than +/-100 nT 
about the mean. 

Note that after using Clip, noise spikes will still remain in the data, though at a reduced and controlled 
magnitude. However, it is best not to consider using the Despike function until much later. In any case, the 
process functions that might be used next, Zero Mean Grid, Zero Mean Traverse, Spectrum and Periodic Filter, 
will not be affected by the presence of these spikes, since they have their own internal mechanisms for dealing 
with spikes. The only process function that may be affected, Deslope, can have its parameters set manually so 
again noise spikes can be present and still accounted for. Destagger has its parameters set manually also and will 
be unaffected. 

Neutralisation of Major Responses. 
Major anomalies such as pipelines, ferrous dumps, wire fences and igneous dykes can occasionally cause 
problems with some of the subsequent process functions such as Spectrum, Periodic Defect, Zero Mean Grid, 
and Zero Mean Traverse. The net effect may be that the functions make the graphics plot far worse than if they 
were not used. The problem becomes noticeable as the sphere of influence of the major anomaly becomes 
comparable with the grid dimensions. This leaves the process functions with very few, possibly no, data points 
with which to calculate the true background. Simply clipping the data will not help.  

To see if there will be a problem you should try each of the above processes in turn (having first saved any 
previous processes). If the anomaly is not too wide (for example less than half a grid wide) then the functions 
will probably work correctly. If it is wider than this and the functions cannot cope then you should adjust the 
threshold value in Zero Mean Grid and set ‘Apply Threshold’ to ‘On’ in the other functions that should allow 
the functions to operate correctly. Should the response still be very disruptive you can reduce the problem by 
replacing the major anomaly with dummy readings using the Search and Replace function. Be sure to restrict 
Search and Replace to just the areas in the immediate vicinity of the major anomaly, by using the block facility.  

Defect Removal - Slope Errors 
If required, the Deslope function can be used to remove small linear trends with grid data. Remember, though, 
that if you plan to subsequently use the Zero Mean Traverse function (see next section), and any slope is in the 
Y direction, then there may be no need to use the Deslope function itself.  The Zero Mean Traverse function will 
automatically perform any slope correction for you in each grid. However, there are times when you would not 
want to use the Zero Mean Traverse function (for example, if it removes linear features in the traverse 
direction). Also, if the slope is in the X direction then Zero Mean Traverse cannot help in this regard. In such 
situations you will have no alternative but to use the Deslope function if there are slope errors. Often, though, 
you will find there is no need to apply any slope correction. 

Defect Removal - Edge Match 
The principle method of removing grid edge discontinuities is to use the Zero Mean Grid function. Initially use 
the default settings for the Threshold and ensure that you have applied Deslope first, if necessary, to individual 
grids. Zero Mean Grid will simply shift each grid up or down with respect to zero, hence producing minimal 
distortion to the data. If grids are not edge matched using the default Threshold value then increase the value a 
step at a time until better matching is achieved – this may not be totally possible in grids where there is an 
extensive ferrous response. Also, if there is a non-linear slope within grids, which Deslope is unable to 
completely correct for, then you may still observe edge discontinuities even after use of Zero Mean Grid.  

To overcome these last two problems you could consider using the Zero Mean Traverse function, providing 
traverses are in the X direction. This function will perform a very effective edge match (as well as removing 
stripe effects - see next section). However, Zero Mean Traverse does have a tendency to remove linear features 
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in the traverse direction unless ‘Apply Thresholds’ is activated. For this reason it is perhaps best to consider 
Zero Mean Grid as a first method of correcting edge match problems, and if that fails consider using Zero Mean 
Traverse, though you must then examine the results carefully for signs of feature removal or distortion.  

In general you should apply Zero Mean Grid to match grids prior to merging dual gradiometer data as we have 
just seen in the earlier section, ‘Merging Dual Gradiometer Data’. 

Defect Removal - Traverse Stripe Errors 
The Zero Mean Traverse function can be used to remove stripe effects within grids. It can also correct for any 
slope or drift along a traverse if the Least Mean Square Fit parameter is set to On, the default setting. As an 
additional benefit it will also automatically edge match grids. Try using Zero Mean Traverse with Least Mean 
Square Fit set to ‘Off’ if the site is noisy or results are unsatisfactory. As noted earlier, major anomalies such as 
pipelines, ferrous dumps, wire boundary fences and igneous dykes can occasionally cause problems, so either 
activate ‘Apply Thresholds’ and vary the levels or neutralise the source using dummy readings prior to 
application of Zero Mean Traverse. 

Remember that Zero Mean Traverse tends to remove linear features in the traverse direction unless you activate 
‘Apply Thresholds’ so you must examine the results carefully for such signs and vary the threshold values 
accordingly. If this is apparent, even using thresholds then it is sometimes feasible to correct for this by using 
the Cut and Combine function to temporarily store linear features before using Zero Mean Traverse and then 
restore them afterwards. 

Defect Removal - Stagger Errors 
Stagger defects can be corrected for by using the Destagger function. You will probably find that different parts 
of the survey require different degrees of stagger correction and so the function is applied on a grid by grid 
basis. 

Defect Removal - Periodic Errors 
Periodic defects are removed by using a combination of the Spectrum and Periodic Filter functions. Spectrum is 
first used to identify the frequency of the offending periodic error and this information is then used by the 
Periodic Filter function to adjust the offending spectral components in each traverse, generating a new filtered 
data set with any periodicity removed. An internal, non-linear, filter caters for spurious effects associated with 
large dynamic range spikes (e.g. modern iron) if they are also present. If extensive ferrous responses are present 
then set ‘Apply Thresholds’ to ‘On’ in both Spectrum and Periodic Filter to allow these responses to be catered 
for. If periodic errors are low level, say < 1nT, then it is normal to remove these at this point in the processing 
sequence. If, unusually, the periodic errors are significant, say > 5nT, then they may require removing fairly 
early on in the process sequence otherwise they could distort any estimation of the normal background level by 
functions such as Zero Mean Grid or Zero Mean Traverse.  

Removal of Modern Iron Spikes 
Modern surface and near surface iron objects are often found, scattered randomly over archaeological sites. 
Their presence can clutter the survey results and make interpretation difficult, sometimes impossible. It is 
possible to minimize these features with the application of the Despike function, and possible additional use of 
the Clip function. 

The data will already have been clipped. However, it may be useful to perform a further clip prior to use of the 
Despike function. Examine the data set using a Trace plot and note the maximum data values (both positive and 
negative) associated with the archaeology of interest. Clip the data with the Minimum and Maximum Clip 
parameters set equal to these positive and negative data values. Check that the archaeological features are still 
present after clipping. 

After using Clip, noise spikes will still remain in the data and can be removed using the Despike function as 
follows. In general, it is advisable to start with a symmetrical, square window with radii X=Y, Threshold set to 
the maximum value of 3 standard deviations (SD), and Spike Replacement set to Mean. Remember that the 
window radius is expressed in units of readings, not metres, and that the actual diameter of a processing window 
is equal to (2 x radius + 1) readings.    

With these settings a window of X=Y=3 will apply moderate despiking. Decreasing X and Y to X=Y=1 will 
substantially increase the despiking effect. Decreasing the window size to increase the amount of despiking is 
preferable to decreasing the Threshold since lower Threshold values (2 SD and below) can start to remove 
features as well. A combination of larger window sizes and lower Threshold values also can be prone to 
removing features as well as noise spikes. Whichever parameter values you try you are strongly advised to save 
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the despiked data then use the Cut and Combine (subtract) function to examine the effect of the despike 
operation - if you can see traces of features present in the difference plot then you should reduce the despiking. 

Asymmetric window sizes (e.g. Y=0, X=4) may be useful if the spatial distribution of iron spikes is 
predominately in the X or Y direction. However, use such windows with great caution since they will tend to 
remove features perpendicular to the length of the window, even with a high Threshold value. It is especially 
important to use Cut and Combine afterwards to examine the effect of despike for asymmetric windows. 

If you Despike gradiometer data then it is very important that you remember the Despike function will only 
remove the large positive or negative readings and may leave behind associated, encircling low level negative or 
positive readings. You should take great care not to forget the origin of such areas when subsequently 
interpreting the processed data - it is all too easy for ‘pits’ to appear in this way. This is one very good reason 
why you might like to leave despiking of gradiometer until this late stage in the process sequence. 

Remember also that, whilst Despike can remove most modern iron spikes features, it can also remove 
archaeological features if they are spike like, i.e. have a strong response and have dimensions comparable with 
the sample and traverse interval. For example a 1m pit surveyed using a sample and traverse interval of 1m may 
only show as one reading. If it has a strong response, then, depending on the window size and Threshold, 
Despike might possibly remove it. However, if the sample and/or traverse interval is smaller then there is much 
less chance of the feature disappearing. 

Smoothing 
It is often desirable to smooth gradiometer data. This process is implemented with the Low Pass Filter function 
that reduces the variability of the data at the expense of spatial detail. This can improve the visibility of weak 
archaeological features such as deeply buried foundations, wide ditches, subtle linear features. It can also be 
used to improve the appearance of relief or artificial sunshine plots, especially if data has been sampled at 0.5m 
intervals or better. The procedure is as follows. 

Select the Low Pass Filter function; this requires entry of a window size and type of weighting. In general it is 
advisable to use small window sizes. If sample and traverse interval are both 1m then consider X and Y radii of 
the order of 1 to 2 readings. Radius values greater than 2, may result in increasing suppression of the desired 
archaeology. Often smoothing with radii between 1 and 2 would be desirable. An approximation to this can be 
made by repeated smoothing with radii of X,Y = 1, say three to five times. However, this may be at the expense 
of slight ringing and generation of artifacts in the data so results should be carefully examined. It is common to 
use filter window dimensions that are equal in units of metres, rather than readings, so take into account 
differences in sample and traverse intervals when entering the X and Y radii. 

If sample intervals are 0.5m, 0.25m or 0.125m, not uncommon in gradiometer surveys, then there is greater 
flexibility in the choice of radii, especially in the X direction, to achieve the desired smoothing. Window radii 
(readings) may be set to different values in the X and Y directions so you might consider initially setting Y=0 
and X set to a length equal to or slightly greater than the features to be smoothed. By adjusting the X and Y radii 
it is possible to obtain the desired smoothing. In general it is better that the X and Y radii of the window are 
chosen to match the ratio of sample and traverse intervals so that the resulting window size, in terms of metric 
dimensions, is square; this will help reduce artifact generation when interpolation is used next.  

Gaussian or Uniform weighting is available. Gaussian weighting is always recommended for generalized 
processing. Uniform weighting will introduce processing artifacts in the vicinity of large data values (impulsive, 
spikes) and will remove Fourier components with a period equal to multiples of the window diameter. 
Regardless of weighting, you should always remove or suppress noise spikes first, using Despike and/or Clip as 
described earlier, to prevent the noise spike energy from smearing. 

Interpolation 
Interpolation (expand) can also be used to give a smoother appearance to the data and can improve the visibility 
of larger, weak archaeological features. Remember that if you are using interpolation to improve the visual 
appearance, this is only a cosmetic change. You are creating artificial data points and you cannot subsequently 
use other processes to extract better information than was contained within the original data set. Indeed, beware 
of the danger of reading too much into expanded data, especially if you have used interpolate several times. 
Expansion using Interpolate is no substitute for good data sampling in the first place. Also if used too soon it 
will unnecessarily increase subsequent processing times. It is recommended that Interpolation is one of the last 
process functions to be used in a process session. 

If you do use Interpolate then always choose the Sin(x)/x expansion method for best results. You can use 
interpolate (expand) to improve the appearance of relief or artificial sunshine plots which benefit from greater 
data density. However, remember that the Sin(x)/x interpolation method must be used since the relief plot will 
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emphasise the imperfections in linear interpolation, rather than the archaeology, and would thus defeat the 
objective. 

One caution: multiple expansions using Sin(x)/x can introduce “ringing” distortion at edges. In some cases it 
may be better to use Sin(x)/x for the first expansion and Linear for second and subsequent expansions; try both  
approaches and examine the results for the chosen display format. 

Separation of Positive or Negative Magnetic Features 
It is possible to separate out positive and negative magnetic features within a composite since gradiometer data 
has a zero mean. This can help when trying to interpret some sites. Features such as ditches, pits, kilns, hearths 
etc will usually (but not always) occur as positive readings and stone features such as walls etc will usually (but 
not always) occur as negative readings. The Clip function may be used to separate these two types of features as 
follows. To isolate just the positive magnetic features set the Minimum clip level to zero and Maximum clip 
level equal to the most positive reading. To isolate just the negative magnetic features set the Minimum clip 
level equal to the most negative reading and the Maximum clip level to zero. 

There are several ways of looking at the clipped data. You can use Shade plots (Clip parameters), where plotting 
parameters Min and Max are symmetrical about zero (for example Min=-3, Max=+3), and Contrast=1. Use of 
the colour palettes will be useful here. If you use Pattern plots then the corresponding Clip plotting parameters 
are best entered as Min=0 and, for example, Max=3. Alternatively you could use either Shade plots or Pattern 
plots with Relief plotting parameters, as these can be especially effective. Trace plots are especially useful since 
you can observe both the location and magnitude of features at the same time.  

Areas of Statistically Different Activity 
Areas of statistically different activity can be located by using the Standard Deviation / Variance Map function 
and may be used to compliment standard graphical methods for site interpretation. This function replaces the 
data set by either the local variance or local standard deviation, whichever parameter is chosen, so make sure 
you have saved any intermediate results. The new data set will consist of all positive numbers, with a value of 
zero indicating uniform activity in that region. Numbers greater than zero indicate by their magnitude the 
increasing level of activity or degree of change in that region. 

Small window sizes (radii 1m to 3m) will give a more detailed picture of activity, whereas larger window sizes 
(5m to 10m) will give a less detailed, broader picture of changes (remember radii are entered in units of 
readings, not metres). 

Graphics in Processing and Use of Compression 
The Graphics menu contains a versatile suite of tools for viewing gradiometer data, whether it be raw, 
smoothed, high/low separated, or variability data. Shade and Pattern plots are particularly useful with Clip, 
Compress or Relief plotting parameters. Trace plots are especially useful since you can observe both the location 
and magnitude of features at the same time. However, it is very important to keep in mind the dynamic range of 
the data and the dynamic limits of the screen and the printer. Often gradiometer data will exceed the capability 
of these display devices. 

Often use of Clip plotting parameters is sufficient to cope with such circumstances, and large value readings are 
simply limited to a set level. If you wish to view both large and small magnitude features at the same time then 
you can do this by compressing the data. Three of the Graphics types, Shade, Pattern, Dot-Density (but not 
Trace) offer Compress plotting parameters, which apply an auto-scaling arctangent compression to help in this 
respect. However, for maximum flexibility, it may be best to use the Compress function in the Process menu, 
then you are free to choose subsequent plotting parameters, which can then include Clip and Relief. You can 
then also look at compressed data using Trace plots. The entry under Compression in the Geoplot 3 manual 
gives guidance on how to compress the desired range of data into the number of available display levels, using 
either Logarithmic or Arctangent compression. 

Finally, it is recommended that gradiometer data be viewed using all the parameter modes of Shade or Pattern 
plots: Clip, Compress or Relief, along with Trace plots, with hidden line turned on and off. A combination of 
these will often help resolve subtle archaeological and cultural features. For example, rotating the sun direction 
and changing the elevation in Relief plotting parameters often reveals features that would otherwise be missed. 
Similarly, adjusting the Contrast between 0.1 and 10 in Clip and Compress will render subtle features visible.  
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Guidelines for Processing Magnetometer Data 
Introduction 
These guidelines are primarily written for large area magnetic surveys performed with single sensor 
magnetometers. Note that there is a distinct difference between gradiometer, magnetometer and differential 
magnetometer data - see the introduction to Processing Guidelines for further clarification. 

Processing Sequence 
A typical processing sequence would be to initially display and review the data, clip the data, remove any 
regional gradient, and finally enhance and present the archaeological response. Initial clipping is to reduce the 
effect of iron spikes. Removal of the regional gradient involves the use of high pass filters. Enhancement and 
presentation includes : (a) removal of iron spikes (b) smoothing, (c) interpolation, (d) separation of positive and 
negative features, (e) variability plots, and (f) use of compression to optimise graphics plots. 

The order of processing can be very important for some functions - for example we saw in the tutorial that you 
should despike before applying a low pass filter, to avoid the spike energy smearing out. So pay particular 
attention to the recommended sequence which closely mirrors the following discussion. 

Initial Data Display and Review 
Before starting any process session you should look at the data using the Graphics menu. Shade plots (Clip 
parameters) and Trace plots using the default plotting parameters are the best way to view the raw data. Examine 
the plots for archaeological features, ferrous objects, geological features and data collection defects. 

The archaeological response will be superimposed on a large background signal. This background signal is 
representative of the local magnetic field, is typically 30000nT to 60000nT and may have a regional gradient. 
(This is very different to a gradiometer signal which has a bipolar response centered around zero). The 
archaeological features may show up strongly or weakly, depending on the depth, size and contrast of the 
features with respect to the surroundings. Generally speaking, they tend to be weaker than the ferrous response 
which can predominate on some sites, especially in an urban environment. If the survey is over a quiet site, with 
few apparent features, and the regional gradient is negligable, then try smaller Clip plotting parameters to see if 
there are any very low level features present - some weak, but archaeologically significant, features may have 
strengths of under 1nT. 

Ferrous objects are usually unwanted modern iron features which are deemed to be archaeologically 
uninteresting (although on historic American sites the ferrous responses may be of archaeological interest). 
These objects may be scattered randomly throughout the site, often near the surface, have a strong response, 
often consisting of an adjacent increase and decrease in response, and are very localized. We refer to these as 
iron spikes. Some iron dumps may show up as broad regions of very strong increases or decreases in 
background response, surrounded by a region with strong response of opposite polarity (as opposed to kilns 
which have a more characteristic response). Modern ferrous pipelines usually show up as strong regular 
alternating patterns of increase or decrease in the magnetic response, distributed along the length of the pipeline, 
although they can also show up as strong, linear, non-alternating increases or decreases in response. Wire fences 
at the boundary of a survey can often give a strong response. 

Geological features are often more difficult to positively identify, and may appear as broad and/or narrow 
responses. As already noted above, archaeological features appear superimposed on a background which may 
have a regional gradient. This gradient may be be due to variations in the main earth's field or due to very deep 
or distant geological sources, both of which may be reduced using a high pass filter. Smaller scale geological 
responses may occur due to local changes in topsoil thickness, natural depressions in the subsoil etc which can 
produce anomalies similar to those produced by archaeological pits. 

Clipping of Iron Spikes 
It is useful to clip noise spikes prior to any further processing. This will make the statistical calculations of some 
other process functions less liable to be compromised by wild data values. It is further useful because it reduces 
the demands on the limited dynamic range of the display devices. 

Depending on the data set, you could initially consider clipping at +/- 3 standard deviations (SD) about the mean 
- you can obtain a value for 1 SD using the Statistics function or, for saved data, look at the histogram and 
statistics in the Graphics dialog screen, which gives a value for 3 SD already calculated. However, it is very 
important that you subsequently check that the chosen clipping level has not clipped features of interest - this 
can often happen on sites with low standard deviation or where there is a regional gradient. You can check the 
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effect of clipping, either by careful inspection of the graphics plots (shade colour plots especially), or by using 
Cut and Combine to examine the clipped data. If clipping at that level is removing data then consider clipping 
instead at +/- 4SD about the mean, or higher if neccessary. You may even wish to clip at standard levels, eg +/-
25nT about the mean, but this depends on the features of interest. For example to preserve kiln responses you 
may have to clip at levels greater than +/-100nT about the mean. 

Note that after using Clip, noise spikes will still remain in the data, though at a reduced and controlled 
magnitude. However, it is best not to consider using the Despike function until much later - see Removal of Iron 
Spikes further on for a discussion of the reasons. 

Removal of Regional Gradient 
The background magnetic response will be much stronger than the archaeological response and can change 
significantly from one end of a site to the other, introducing a regional gradient. Thus the response due to 
weaker archaeological features can be very difficult to observe if graphics plotting parameters are set to give an 
overall view of the data. Equally, if plotting parameters are chosen to emphasise weak archaeological features at 
one end, you will probably not be able to observe weak features at the other end. 

Fortunately, the regional gradient usually (but not always) changes slowly throughout the survey, whereas 
cultural features such as pits, ditches, and foundations change more rapidly. Cultural features usually have a 
scale of the order of 0.5 to 2m while geological features have a scale of 10m or more. Great improvement in 
small feature visibility can be obtained by using the High Pass Filter function to remove the regional gradient. If 
you decide a high pass filter might be beneficial then before proceeding you should consider whether this might 
also remove any wanted archaeological response. For example, an extensive midden area with enhanced 
suspectibility may also give a broad, regional, increase in response, but this too would be removed with a high 
pass filter. If this is likely then you may not want to high pass filter the data. The High Pass Filter procedure is 
described next. 

Select the High Pass Filter function; this requires entry of a window size and type of weighting. It is advisable to 
use as large a window size as possible, with X and Y radii of the order of 5 to 10 readings, preferably nearer 10. 
Radius values of less than 3 to 4 may result in overly "crisp" data and the unwanted appearance of edges of a 
sharp regional gradient. It is common to use filter window dimensions which are equal in units of metres, rather 
than readings so take into account differences in sample and traverse intervals when entering X and Y radii. 
Gaussian weighting is recommended because uniform weighting will remove certain Fourier components from 
the data which can have the effect of generating small false features. 

Note that the High Pass Filter function is numerically complex and will be slow for large data sets, large radii or 
slower computers. Even so, do not be tempted to use a small radius just to speed up the process - only use small 
radii if you have very good and valid reasons. 

The resulting high pass filtered data will be bipolar, with a near zero mean, because the High Pass Filter will 
have subtracted a moving average from the original composite. This will affect the way graphics plotting 
parameters are entered. For example if you were using Shade plot (Clip) the plotting parameters would be 
entered as absolute values (monopolar) for the non-high pass filtered data, probably determined more by the 
geology than archaeology. After high pass filtering these will have to be changed from monopolar to bipolar 
entries with new magnitudes to reflect the archaeology, not the regional gradient (for example Min=50000, 
Max=50100 might become Min=-20, Max=+20). If you want to compare the effect of different window sizes 
then you may find it useful to enter the parameters in units of standard deviation, since these will then track the 
increasing removal of information as High Pass Filter radii are reduced. The mean can be restored by using the 
Add function, though this is not a neccesary step. See the entry for High Pass Filter in the function reference for 
examples.  

Be sure to compare the data before and after high pass filtering for residual signs of the underlying geology. It is 
important that these are not subsequently interpreted as an archaeological response. 

Removal of Modern Iron Spikes 
Modern surface and near surface iron objects are often found, scattered randomly over archaeological sites. 
Their presence can clutter the survey results and make interpretation difficult, sometimes impossible. It is 
possible to minimize these features with the application of the Despike function, and possible additional use of 
the Clip function. 

The data will already have been clipped. If the data has been high pass filtered (resulting in bipolar data centered 
around zero) then it may be useful to perform a further clip prior to use of the Despike function. Examine the 
data set using a Trace plot and note the maximum data values (both positive and negative) associated with the 
archaeology of interest. Clip the data with the Minimum and Maximum Clip parameters set equal to these 
positive and negative data values. Check that the archaeological features are still present after clipping. 
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Noise spikes will still remain in the data and can be removed using the Despike function as follows. In general, 
it is advisable to start with a symetrical, square window with radii X=Y, Threshold set to the maximum value of 
3 standard deviations (SD), and Spike Replacement set to Mean. Remember that the window radius is expressed 
in units of readings, not metres, and that the actual diameter of a processing window is equal to (2 x radius + 1) 
readings.    

With these settings a window of X=Y=3 will apply moderate despiking. Decreasing X and Y to X=Y=1 will 
substantially increase the despiking effect. Decreasing the window size to increase the amount of despiking is 
preferable to decreasing the Threshold since lower Threshold values (2 SD and below) can start to remove 
features as well. A combination of larger window sizes and lower Threshold values also can be prone to 
removing features as well as noise spikes. Whichever parameter values you try you are strongly advised to save 
the despiked data then use the Cut and Combine (subtract) function to examine the effect of the despike 
operation - if you can see traces of features present in the difference plot then you should reduce the despiking. 

Asymmetric window sizes (eg Y=0, X=4) may be useful if the spatial distribution of iron spikes is 
predominately in the X or Y direction. However, use such windows with great caution since they will tend to 
remove features perpendicular to the length of the window, even with a high Threshold value. It is especially 
important to use Cut and Combine afterwards to examine the effect of despike for asymmetric windows. 

If you Despike magnetometer data it is very important that you remember the Despike function will only remove 
the large amplitude readings and may leave behind associated, encircling low level readings of opposite polarity. 
You should take great care not to forget the origin of such areas when subsequently interpreting the processed 
data - it is all too easy for "pits" to appear in this way. This is one very good reason why you might like to leave 
despiking of magnetometer until this late stage in the process sequence. 

Remember also that, whilst Despike can remove most modern iron spikes features, it can also remove 
archaeological features if they are spike like, ie have a strong response and have dimensions comparable with 
the sample and traverse interval. For example a 1m pit surveyed using a sample and traverse interval of 1m may 
only show as one reading. If it has a strong response, then, depending on the window size and Threshold, 
Despike might possibly remove it. However, if sample and/or traverse interval are smaller then there is much 
less chance of the feature disappearing. 

Smoothing 
Occasionally it may be desirable to smooth magnetometer data. This process is implemented with the Low Pass 
Filter function which reduces the variability of the data at the expense of spatial detail. This can improve the 
visibility of larger, weak archaeological features such as deeply buried foundations, wide ditches, subtle linear 
features. It can also be used to improve the appearance of relief or artificial sunshine plots, especially if data has 
been sampled at 0.5m intervals or better. The procedure is as follows. 

Select the Low Pass Filter function; this requires entry of a window size and type of weighting. In general it is 
advisable to use small window sizes. If sample and traverse interval are both 1m then consider X and Y radii of 
the order of 1 to 2 readings. Radius values of greater than 2 may result in increasing suppression of the desired 
archaeology. Often smoothing with radii between 1 and 2 would be desirable. An approximation to this can be 
made by repeated smoothing with radii of X,Y = 1, say three to five times. However, this may be at the expense 
of slight ringing and generation of artifacts in the data so results should be carefully examined. It is common to 
use filter window dimensions which are equal in units of metres, rather than readings so take into account 
differences in sample and traverse intervals when entering the X and Y radii. 

If sample intervals are 0.5m, 0.25m or even 0.125m, then there is greater flexibility in the choice of radii, 
especially in the X direction, to achieve the desired smoothing. Window radii (readings) may be set to different 
values in the X and Y directions so you might consider initially setting Y=0 and X set to a length equal to or 
slightly greater than the features to be smoothed. By adjusting the X and Y radii it is possible to obtain the 
desired smoothing. Once again very large radii, this time of the order of 4, 8 or 10 readings respectively, will 
start to suppress the archaeology. 

Gaussian or Uniform weighting is available. Gaussian weighting is always recomended for generalized 
processing. Uniform weighting will introduce processing artifacts in the vicinity of large data values (impulsive, 
spikes) and will remove Fourier components with a period equal to multiples of the window diameter. 
Regardless of weighting, you should always remove or suppress noise spikes first, using Despike and/or Clip as 
described earlier, to prevent the noise spike energy from smearing. 

Interpolation 
Interpolation (expand) can also be used to give a smoother appearance to the data and can improve the visibility 
of larger, weak archaeological features. However, it does this at the expense of increasing the number of data 
points, so for medium to large composites there may well not be enough memory to use this function, especially 
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if a small sample interval has been used. In this case use of the Low Pass Filter is the only option, unless a single 
composite is split into several smaller composites. 

Remember that if you are using interpolation to improve the visual appearance, this is only a cosmetic change. 
You are creating artificial data points and you cannot subsequently use other processes to try to extract better 
information than was contained within the original data set. Indeed, beware of the danger of reading too much 
into expanded data, especially if you have used interpolate several times. Expansion using Interpolate is no 
substitute for good data sampling in the first place. Also, if used too soon it will unneccessarily increase 
subsequent processing times. It is recommended that Interpolation is one of the last process functions to be used 
in a process session. 

If you do use Interpolate then always choose the Sin(x)/x expansion method for best results. You can use 
interpolate (expand) to improve the appearance of relief or artificial sunshine plots which benefit from greater 
data density. However, remember that the Sin(x)/x interpolation method must be used since the relief plot will 
emphasise the imperfections in linear interpolation, rather than the archaeology, and would thus defeat the 
objective. 

One caution : multiple expansions using Sin(x)/x can introduce “ringing” distortion at edges. It may be better to 
use Sin(x)/x for the first expansion and Linear for second and subsequent expansions; try both and examine the 
results for the chosen display  display format. 

Separation of Positive or Negative Magnetic Features 
It is possible to separate out positive and negative magnetic features within a composite that has previously been 
High Pass Filtered since such data has a zero mean. This can help when trying to interpret some sites. Features 
such as ditches, pits, kilns, hearths etc will usually occur as positive readings and stone features such as walls etc 
will occur as negative readings. The Clip function may be used to separate these two types of features as 
follows. To isolate just the positive magnetic features set the Minimum clip level to zero and Maximum clip 
level equal to the most positive reading. To isolate just the negative magnetic features set the Minimum clip 
level equal to the most negative reading and the Maximum clip level to zero.  

There are several ways of looking at the clipped data. You can use Shade plots (Clip parameters), where plotting 
parameters Min and Max are symetrical about zero (for example Min=-20, Max=+20), and Contrast=1. Use of 
the colour palettes will be useful here. If you use Pattern plots then the corresponding Clip plotting parameters 
are best entered as Min=0 and, for example, Max=20. Alternatively you could use either Shade plots or Pattern 
plots with Relief plotting parameters which can be especially effective. Trace plots are especially useful since 
you can observe both the location and magnitude of features simultaneously. 

Areas of Statistically Different Activity 
Areas of statistically different activity can be located by using the Standard Deviation / Variance Map function 
and may be used to compliment standard graphical methods for site interpretation. This function replaces the 
data set by either the local variance or local standard deviation, whichever parameter is chosen, so make sure 
you have saved any intermediate results. The new data set will consist of all positive numbers, with a value of 
zero indicating uniform activity in that region. Numbers greater than zero indicate by their magnitude the 
increasing level of activity or degree of change in that region. 

Small window sizes (radii 1m to 3m) will give a more detailed picture of activity, whereas larger window sizes 
(5m to 10m) will give a less detailed, broader picture of changes (remember radii are entered in units of 
readings, not metres). If large window sizes are used over non-high pass filtered data then the variability plot is 
more likely to reflect changes in the regional gradient rather than the archaeology. It may be preferable 
therefore, if you want just a broad overall view of the archaeology, to perform a high pass filter prior to using 
the Standard Deviation / Variance Map function. 

Graphics in Processing and Use of Compression 
The Graphics menu contains a versatile suite of tools for viewing magnetometer data, whether it be raw, 
smoothed, high/low separated, or variability data. Shade and Pattern plots are particularily useful, with either 
Clip, Compress or Relief plotting parameters. Trace plots are especially useful since you can observe both the 
location and magnitude of features at the same time. However, it is very important to keep in mind the dynamic 
range of the data and the dynamic limits of the screen and the printer. Often magnetometer data will exceed the 
capability of these display devices. 

Often use of Clip plotting parameters is sufficient to cope with such circumstances, and large value readings are 
simply limited to a set level. If you wish to view both large and small magnitude features at the same time then 
you can do this by compressing the data. Three of the Graphics types, Shade, Pattern, Dot-Density (but not 



 5-30       Additional Information 

Trace) offer Compress plotting parameters, which apply an auto-scaling arctangent compression to help in this 
respect. However, for maximum flexibility, it may be best to use the Compress function in the Process menu, 
then you are free to choose subsequent plotting parameters, which can then include Clip and Relief. You can 
then also look at compressed data using Trace plots. The entry under Compression in the process reference gives 
guidance on how to compress the desired range of data into the number of available display levels, using either 
Logarithmic or Arctangent compression. 

Finally, it is recommended that magnetometer data be viewed using all the parameter modes of Shade or Pattern 
plots : Clip, Compress or Relief, along with Trace plots, with hidden line turned on and off. A combination of 
these will often help resolve subtle archaeological and cultural features. For example, rotating the sun direction 
and changing the elevation in Relief plotting parameters often reveals features that would otherwise be missed - 
usually this is best applied to non-high pass filtered data. Similarly, adjusting the Contrast between 0.1 and 10 in 
Clip and Compress will render subtle features visible.  

Guidelines for Processing Other Data 
Introduction 
This section attempts to give some general advice on processing surveys other than resistance, gradiometer or 
magnetometer. This includes surveys made by the following instruments : differential magnetometer, proton 
gradiometer, magnetic susceptibility meter, and electromagnetic (EM) instruments.  

The following advice is restricted to general comments. For more detailed advice you should look for parallels 
with the survey types already discussed and examine the advice given there. Whilst the advice on defect removal 
and dealing with regional gradients may be different, the general sequence of processing may well be relevant. 
For example, differential magnetometer data processing will be very similar to magnetometer data processing, 
the base station readings being the primary difference. Proton gradiometer data processing will be very similar 
to fluxgate gradiometer data processing, except that many of the defect functions may not be needed. EM 
conductivity data processing will be similar to resistance data processing if conductivity is converted to 
resistivity. EM magnetic data processing will be similar to magnetometer data processing, with the very 
important exception of possibly preserving regional gradients. Magnetic susceptibility data processing will be 
similar to magnetometer data processing, with the very important exception of preserving regional gradients in 
some situations. 

Processing Sequence 
A typical processing sequence would be to initially review the data, clip the data, remove data collection defects, 
remove any regional gradient if appropriate, and finally enhance and present the archaeological response. 

Initial clipping is used to reduce the effect of instrumental noise spikes or surface iron spikes on subsequent 
statistical calculations. These calculations may occur in other process functions or in graphics plots that use 
standard deviation units for plotting parameter entry. 

Defect removal may include some of the following : (a) removal of instrumental noise spikes, (b) removal of 
periodic errors, (c) removal of grid slope, (d) edge matching, (e) removal of traverse stripe effects, (f) removal 
of stagger effects. Note, however, that the exact order of use may be different from that shown above, depending 
on the combination of functions used and the nature of the data type. These are discussed briefly in the 
following sub-sections for each survey type. 

Removal of any regional gradient, or geological background, would involve the use of a high pass filter with 
large window area. 

Enhancement and presentation includes : (a) removal of ferrous and non-ferrous spikes (b) smoothing, (c) 
interpolation, (d) separation of positive and negative features, (e) variability plots, and (f) use of compression to 
optimise graphics plots. 

Differential Magnetometer Data 
If the differential magnetometer data consists of two data sets, one for the roving single sensor and one for the 
fixed base station, use of the Cut and Combine function to find the difference will yield the required differential 
data set. If the data set is already presented as the difference then clearly this step will not be required. 
Subsequent processing will be virtually identical to that described for magnetometers, except that the data set 
will now be bipolar - even so, removal of any regional gradient may still be desirable in some circumstances. 
Edge matching may also be required if the reference magnetometer is moved during a survey. 
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Proton Gradiometer Data 
Treatment of proton gradiometer data will be virtually identical to that described for fluxgate gradiometers. The 
principle difference will be that the defect errors : (a) periodic, (b) slope, (c) edge match, (d) traverse stripe and 
(e) stagger will not need to be corrected. 

Magnetic Susceptibility Data 
Treatment of magnetic susceptibility will be virtually identical to that described for magnetometers with the very 
important exception of whether to remove a regional gradient or not. If the data sampling has been done on a 
fine grid, say every 0.5m or 1m, in order to locate fine structure, then you may wish to consider removal of any 
large regional gradients in order to see this detail. However this would also remove possibly important 
archaeological information about regional magnetic susceptibility, a major attribute of the magnetic 
susceptibility measurement. If data sampling is done on a much coarser grid, say every 5m or greater, with the 
intention of identifying local trends in magnetic susceptibility, then you would clearly not want to use a high 
pass filter to remove regional gradients. 

Often interpolation is used to expand magnetic susceptibility data, either for comparison with fluxgate 
gradiometer data or to present a smoother appearance to the data. Since this can involve several interpolations, 
great care should be taken not to interpret too much into the subsequent data set. If you do interpolate then 
always choose the Sin(x)/x expansion method for best results. 

Electromagnetic (EM) Data 
Treatment of EM conductivity data will be virtually identical to that described for resistance data. The principle 
difference to remember is that conductivity is the reciprocal of resistivity, so anomalies will be inverted with 
respect to the description for resistance data. However, there may also be more defect errors present such as : (a) 
periodic, (b) slope, (c) edge match, (d) traverse stripe and (e) stagger. These defects are more typical of fluxgate 
gradiometer data so if these are present then you should additionaly consult the relevant processing advice for 
fluxgate gradiometer data. There may also be a response to metallic objects, both ferrous and non-ferrous so 
again the advice given for dealing with modern iron spikes in fluxgate gradiometer data may be relevant. 

Treatment of EM magnetic data will be virtually identical to that described for magnetometers with the very 
important exception of whether to remove a regional gradient or not. Data sampling is usually done on a fine 
grid, say every 0.5m or 1m, in order to locate fine structure, so you may wish to consider removal of any large 
regional gradients in order to see this detail. However this would also remove possibly important archaeological 
information about regional magnetic susceptibility. There may also be more defect errors present in EM data 
than magnetometer data such as : (a) periodic, (b) slope, (c) edge match, (d) traverse stripe and (e) stagger. 
These defects are more typical of fluxgate gradiometer data so if these are present then you should additionaly 
consult the relevant processing advice for fluxgate gradiometer data. There may also be a response to metallic 
objects, both ferrous and non-ferrous so again the advice given for dealing with modern iron spikes in fluxgate 
gradiometer data may be relevant. 
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Chapter 6  

TROUBLE-SHOOTING 

Up-to-date Information 
The most up-to-date trouble-shooting information will soon be available on our web site at :  

www.geoscan-research.co.uk 

Problems Starting Geoplot when using a Hardware Lock 
Geoplot 3.0, protected by a hardware lock or dongle, can be installed into Windows 3.1, 3.11, 95, 98, ME and 
NT4. If you wish to run Geoplot on Windows 2000, XP or higher then you will need to download and apply 
new drivers from the Az-Tech website. Go to the Az-Tech website download area: <http://www.az-
tech.com/dnl.htm> and download Azsetup.exe and Azsetup.txt. Azsetup.txt gives instructions on installing the 
new driver. You will need to be a System Administrater yourself or will need to contact your IT department in 
order to run program Azsetup.exe successfully. However, these new drivers do not work on all 2000 and XP 
systems – should they not work on your system you will need to swop your dongle for a software authorisation 
version – note that if you do this you will no longer be able to run the DOS version. In the case of 2000 and XP, 
once you have installed Geoplot you should  

If you cannot start Geoplot successfully when using a hardware lock then it is likely that a device driver or 
diagnostic has been loaded by Windows that is preventing access to the parallel port, and access to the dongle. 
Examples are drivers for laser printers, parallel port scanners, parallel port CDROM or ZIP drives. In order to 
get Geoplot running it is neccessary to identify the driver or diagnostic and either disable it or change its 
settings. Advice is given below for the different operating systems. Before looking for these drivers it is worth 
checking that the latest DLL and VBX files are present on your system, as outlined below. 

If you are installing Geoplot on a new computer ensure that the parallel port has been enabled – this is not 
always the case ! You can check if the parallel port is active by trying to print using other applications. If it is 
not active you will need to reconfigure the hardware at bootup to activate a parallel port. 

If you experience difficulties accessing the dongle please could you let us know of the problem and details of 
how you manage to resolve them or otherwise. In particular please could you let us know which version of 
Windows you are using, setup details specific to your machine, any other software loaded and drivers that 
caused a problem - we can then advise other users of potential conflicts. Remember that if you are using NT4 
you must be a System Administrator and run the NTSetup program first. If you are on a network you must 
disable the network connection. 

If the advice given below fails to cure the problem, and you have a dongle with a number earlier than 98167 
then we may need to issue a new dongle. We believe at this stage that this applies more to NT4 than the other 
operating systems. Note however that a new dongle will not cure any device driver conflict problems or a faulty 
Windows installation, rather it may help with interfacing to new high speed parallel ports. 

Check DLL’s and VBX’s 
Check to see that there are no other DLL’s, VBX’s or SYS’s on your system which are earlier than the ones 
distributed with Geoplot. These files would normally be found in the System directory of Windows. The files 
Geoplot installs in its own directory (C:\GP300) are : 
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• VBRUN300.DLL 398,416  22/09/94 
• COMMDLG.DLL 88,544  25/03/99 
• KECHK2.DLL  23,040  02/11/98 
• CMDIALOG.VBX 18,688  28/04/93 
• THREED.VBX 64,432  24/08/96 
• TRUEGRID.VBX 328,720  17/02/95 
• VSVBX.VBX  92,176  05/01/95 
• MSCOMM.VBX 34,816  12/05/93 
• DOWNTVDD.DLL 11,776  29/10/96 
• DS1410D.SYS  7,328  07/08/97 
 

If you find that there are earlier files installed in the Windows System directory you should replace these by the 
later files supplied with Geoplot. 

Problems with Windows 3.1 Drivers 
You should first of all try disabling drivers from the Program Manager - either from the Control Panel icon in 
the Main group or from any specific device driver groups. For example the Windows 3.1 diagnostics driver 
provided with the HP LaserJet 5L printer loads a TSR that takes control of the parallel port, which prevents 
access to the dongle. The diagnostics program in this case needs to be disabled in Windows and then the 
computer rebooted to remove the TSR which would still be loaded and operating, even though disabled in 
Windows.  

If using the windows control panel does not correct the problem you should then look in the SYSTEM.INI 
[386Enh] section for any drivers Windows may be loading. Any suspect driver can be temporarily disabled by 
placing a semicolon (;) at the beginning of its “device=” line and rebooting Windows. Make sure you have a full 
backup of the original file first and ignore any driver lines that contain an asterisk “*” which are built-in 
Windows drivers that should not be causing a problem. You should consult the documentation provided with 
any driver you disable to determine the effect of disabling it or to determine what other driver settings can be 
made to resolve the problem. If SYSTEM.INI [386Enh] section contains the statement : 

LPT1AutoAssign=xx  

then make sure the value for “xx” is 0 or 1. High values may cause access difficulties to the parallel port.  You 
could also look in the WIN.INI [Ports] and [Printer Ports] sections to make sure these are correctly configured. 
Also check your CONFIG.SYS and AUTOEXEC.BAT files to see if they are loading and running any drivers 
that may access the parallel port. 

Problems with Windows 95, 98, ME and NT4 Drivers 
The first step is to see if other background programs are taking control of the parallel port. With just the desktop 
displayed and no other applications running, press Ctrl-Alt-Del to show a list of current tasks or programs 
running in the background. You can end each task in turn to see if the problem is resolved - but do not under any 
circumstances end the Explorer or Systray tasks. If this does not solve the problem then reboot and start 
Windows 95 in Safe Mode. This will load only the bare minimum of essential drivers that Windows itself needs, 
and you should now be able to run Geoplot, though you will then probably be restricted to a VGA display 
resolution. Should this cure the problem then the next step is to try and identify where the problem driver is 
being loaded when you start Windows normally - any driver that could be accessing the parallel port.  

You should first of all try disabling suspect drivers from the Control Panel. For example the diagnostics driver 
provided with the HP LaserJet 5L printer takes control of the parallel port, which prevents access to the dongle. 
The diagnostics program in this case needs to be disabled using the Windows Control panel settings - you will 
probably also then have to reboot the computer. If this is does not cure the problem, you should look in the 
SYSTEM.INI [386Enh] section. Any driver can be temporarily disabled by placing a semicolon (;) at the 
beginning of its “device=” line and rebooting Windows. Make sure you have a full backup of the original file 
first and ignore any driver lines that contain an asterisk “*” which are built-in Windows drivers that should not 
be causing a problem. You should consult the documentation provided with any driver you disable to determine 
the effect of disabling it or to determine what other driver settings can be made to resolve the problem. If 
SYSTEM.INI [386Enh] section contains the statement : 

LPT1AutoAssign=xx 

then make sure the value for “xx” is 0 or 1. High values may cause access difficulties to the parallel port.  You 
could also look in the WIN.INI [Ports] and [Printer Ports] sections to make sure these are correctly configured. 
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The last resort step is to search registry files for any drivers that could cause problems and either disable them or 
change their settings. Procede with EXTREME CAUTION !!!!  

   EXTREME CAUTION ! 

 Extreme caution should be applied when changing registry settings. Only attempt to 
do this if you are totally confident how to do this and can recover from a situation 
where the registry becomes corrupted.  

This must be done using proper registry editing tools by users fully competant in altering the registry - if a 
mistake is made it may make the PC inoperable so you should know EXACTLY what you are doing and be 
confident in being able to restore the PC back to a working state. Changes should not be undertaken by users 
who are unfamiliar with such steps. You will also need to find out from the supplier of the driver what 
alternative settings are valid. It is more likely you will be able to identify and disable a problem driver using the 
first few suggestion without having to resort to registry changes. 

General Problems when using a Software Lock 
If you want to run Geoplot on more than one computer there is no need to uninstall Geoplot each time – you just 
need to transfer the authorisation from one computer to another using Authmanw. Ensure that you are not using 
Norton SpeedDisk (it may be installed by default as part of the Utilities package) – see Installation chapter for 
more details. 

When transfering the authorisation to or from the authorisation disk, ensure that the Authorisation Name is typed 
in lower case exactly as listed in the Installation Chapter – the name is dependent on the version of Geoplot 
being used. You must use the authorisation disk provided as the transfer medium – it cannot be any floppy disk. 
Also, you must use Authmanw to move the authorisation, you cannot copy or move the file using Windows – if 
you try to do so you will probably corrupt the authorisation. 

If you encounter the message “(09) Error locating authorisation on specified drive!” or “(32) Invalid MASTER 
diskette” check to see that you have the “Transfer Authorisation To” and “Transfer Authorisation From” file 
path locations properly specified. 

The standard defragmentation utilities supplied with Windows 3.1, 3.11, 95, 98, ME and NT4 do not usually 
cause any problems with the authorisation. Under some circumstances the defragmentation utilities supplied 
with Windows 2000 and XP can corrupt older Geoplot software lock authorisations (those supplied before May 
2003). However this seems to be a very rare problem and does not affect authorisations issued after May 2003. 
To be safe, and where possible, you should not attempt to defragment in 2000 and XP if you have an older 
authorisation. 

You can check to see where the authorisation is at any time using the Check utility in Authmanw. Enter the 
Authorisation Name and select the path where the authorisation should be then click OK. If it was successfully 
found a message will report the remaining number of installations – this will be 0 if on the hard-disk or 1 if on 
the floppy disk. If it was not successfully found a message will report “[24] Error locating specified 
authorisation !” 

In some circumstances a corrupted authorisation can be reactivated remotely. This involves the user running the 
Modify utility in Authmanw, pointing at the floppy disk drive. Enter the Authorisation Name and select the path 
where the authorisation should be then click OK. The following form will report a 6 digit User Code which is 
then supplied to Geoscan Research (UK) and in return a new set of numbers will be provided to type into the 
Reset Code 1 field. Clicking OK should reactivate the authorisation on the floppy disk.  

Problems Transferring a Software Authorisation in 2000 or XP 
If software authorisation transfer appears to go correctly but you receive an error message when you then try to 
start Geoplot it is probable your authorisation has been transferred to the wrong location. This can happen with 
some Windows 2000 and XP installations and usually the authorisation has been transferred to the Windows 
directory.  

If you cannot locate the authorisation using Authmanw and Check, as described in the previous section, then use 
Windows Explorer or Windows Search facility (2000 and XP) to look for it as described next.  
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First ensure that any system files will be visible. In 2000 and XP versions of Windows Explorer or Search select 
Tools, Folder Options, and the View tab then set the “Hidden files and folders” radio button to “Show hidden 
files and folders”. Also ensure that there is a tick next to “Display contents of system folders” and there is NO 
tick next to “Hide protected operating system files”.  

If you are using 2000 or XP and Windows Explorer click on the Search button or alternatively select Search on 
the Start menu then Files or Folders to begin the search. Enter gp300.ekb in the “named” field (or gp300d.ekb, 
gp300n5.ekb etc as listed in Chapter 2 Installation). Make sure “Look in” is set to the root directory. In a default 
installation the authorisation should be in directory C:\GP300\AX NF ZZ, though note that Authmanw will not 
list the AX NF ZZ directory when you specify where to transfer the authorisation to : it will just show C:\GP300 
typically and this is correct. If you find the authorisation is not located where you expected through your settings 
in Authmanw but has ended up in the Windows directory, typically C:\WINNT or C:\WINDOWS, then the 
following procedure should relocate the authorisation to its correct position. 

Close Windows Explorer and run Authmanw again. Select Remove from the main dialog box. Enter the 
authorisation name, set “Transfer Authorisation From” to the Windows  directory (typically C:\WINNT or 
C:\WINDOWS) and set “Transfer Authorisation To” to the floppy disk drive. Leave Options set to Smart 
Remove. Click OK to transfer the authorisation. The authorisation should now be successfully put back onto the 
floppy disk. Now follow the normal procedure for transferring the authorisation from the floppy disk to the hard 
disk. You should now find the authorisation is placed correctly in the Gp300 (default) directory. 

If the above procedure does not work then it is likely there is some background program that is intercepting 
system files and directing them to another location. If you know of a likely candidate for this action then disable 
it. If you do not know for sure then reboot the computer into Safe Mode, use the search facilities to find the .ekb 
file as described above. Use Authmanw to move the authorisation back to the floppy disk and then back to the 
hard disk as described above. Once the authorisation is correctly located reboot Windows in normal mode. 

Problems Running Geoplot 
If you find problems similar to the list that follows then it is likely that your Regional settings have the Decimal 
Symbol set to a comma and not a decimal point. Please check Regional settings as advised in the warning box 
under Running Geoplot in Installation, Chapter 2. A typical problem list is : (a) when opening Options – 
Graphics a second time you get the message “Invalid property value” and Geoplot exits immediately, (b) same 
with the Dot-density Graphics plotting parameter form, (c) problems with palettes, (d) problems importing files, 
(e) publish does not work at all, (f) problems with selecting areas and using the zoom controls. Also check that 
you have a valid printer installed, along with valid fonts. 

If you encounter a message similar to “Overflow in form MDIFormLoad at SetPrinterMargin” or “File Not 
Found” when trying to start Geoplot it is likely that the current default printer driver is corrupted. Try changing 
the default printer to another type (you can install a new driver without physically having a the matching 
printer). You may also have to reinstall the Geoplot Options files since these may have changed as a result of a 
faulty printer driver – either use backups of these or reinstall Geoplot. If Geoplot now starts correctly, 
reinstalling the original printer driver and resetting this as the default should cure the problem completely. This 
error may happen when installing new software. For example this error has has been known to occur after 
installing Adobe Photoshop and new network software, with the default printer driver being corrupted. 

Occasionally Windows XP will replace the system files installed with Geoplot with its own versions. 
Unfortunately these are usually older versions and not compatible with Geoplot. Should you get an error 
message when  trying to run Geoplot that implies a problem with a .dll or .vbx file, check the date and version of 
the file installed in the Geoplot directory (typically c:\gp300) and compare this with the table given earlier in the 
section titled “Check DLL’s and VBX’s”. If XP has installed an earlier version replace it with the later version 
supplied with Geoplot – a copy of all .dll and .vbx files is supplied in the RestoreFiles directory of the Geoplot 
CD. 

If you encounter several messages reporting missing files when you first start Geoplot it is probable that you 
have installed Geoplot to a root directory – you must install Geoplot in a directory structure of one or more 
levels. 

Problems Opening Data 
Data must be stored in a sub-directory, not in a root directory. So, for example, you cannot open data stored 
directly in the root directory of a floppy disk. If backing up to floppy disks or Zip drives then always store data 
in a subdirectory – you could use the name of the site as the directory name.  
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Problems Downloading Data 
Make sure the “Download RS232 COMM port” setting in the Environment Options, Input tab is set to the 
correct port number – by default this is “1”. Ensure that there is not a break in the cable.  

If your PC does not possess a serial RS232 port but does have a USB port then you should use a USB to serial 
adapter to download data. This could also be a solution if you continue to experience difficulties using a 
conventional serial port – see paragraphs below. You will need Windows 95 with USB support, Windows 98 or 
higher. The driver software that accompanies the converter will probably assign its virtual COMM port to be 
other than “1”. Typically this is “4” and you should set the Input tab in Environment Options accordingly. If you 
use a USB converter you will probably find that you have to exit Geoplot after a download in order to clear data 
left in the PC’s buffer. For example, if you come to dump data and see the message “Receiving data…” instead 
of the normal “Waiting for data…”, even though you have not yet pressed DUMP on the instrument, this is a 
sure sign that data is still left in the PC’s buffer. If you do not exit Geoplot at this stage and decide to continue 
the data will be scrambled. 

Before you download you must ensure that screen savers, battery standby, battery monitor, hard disk standby are 
disabled – a reminder is given on the dialog boxes. If you do not disable them, then when these become active 
they can interrupt the real-time handling of the data flow into the PC, leading to loss of data. As well as 
disabling screen savers, battery standby and battery monitor, make sure there are no other background tasks 
operating that may interrogate the serial ports or acquire CPU time, for example : 

• Some personal organiser synchronising software, by default, continually scans the serial ports for activity – 
this must be disabled before downloading data. 

• Some virus checkers may need disabling if they monitor the serial port and hence interupt the flow of data. 
• Software for modems may take control of the serial port and must be disabled. In some circumstance the 

serial port may not be active, most common on computers with internal modems and must be activated 
before you can download data. This may be done either using special utilities provided with your computer 
or by changing the system bios settings when you first start your computer. Please note that making 
incorrect changes to the system bios may prevent your PC from booting so consult your system 
documentation very carefully before doing so.  

• You should disable Infra-Red ports since they also use the serial port and may interrogate it every 3 seconds 
by default. 

• You may in some circumstances need to mute the sound system – this is more likely to be a problem for 
FM18/FM36 gradiometers than for resistance meters. 

• If the battery level is low on an FM18/FM36 then this may cause download problems with some PCs– try 
recharging the batteries or inserting a fresh battery pack before trying to download again. 

• Do not use a serial mouse since this will generate interupts that may affect data handling. 
• Running a portable computer from battery, rather than the mains supply can solve download difficulties 

(this was experienced on a DELL computer running Windows 98).  
 

In all the above cases you should always restart Geoplot after making setup changes, and in many cases you 
will also have to reboot the operating system.  

Data download requires the version of MSCOMM.VBX dated 5/12/93. This is automatically installed with the 
other DLL and VBX files. If you experience problems with data download check to see if there are any other 
versions present on your machine and ensure it is not dated earlier than 5/12/93. 

A progress report consisting of a bar and reading count is shown as the data is downloaded. If there is a large 
quantity of data and the computer is slow then you may get a “Buffer Overflow” or “Port Overrun” error 
message. If so, then go to Environment options and change the progress report to either Bar only or none at all.  
Also, do not move the mouse or progress form during download since this will generate a Windows call which 
will be serviced in preference to handling the RS232 data. The internal buffer may not have sufficient capacity 
to temporarily store the incoming data in the interim. 

If you are using Windows 3.1 on an older, slower, computer (eg 486DX2) then it is advisable to make some 
changes to your System.ini file to improve throughput of data into the RS232 port and avoid buffer overflow. In 
the [386Enh] section add : 

• COMxBuffer=8192     (where x = the Comm port number)      
• COMxFIFO=On 
If you are using Windows 3.11 you may also need to add : 

• COMxFIFO=0 
You should experiment to find the optimum combination, though there is only likely to be a buffer overflow 
problem if you are trying to download more than 15000 readings. 
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It is possible that if Windows, or one of its components, is not correctly installed, or conflicts occur within the 
hardware installation then you may have difficulty downloading data correctly. For example, you may have a 
mechanical switch that connects a single serial port to either a modem or an instrument for download – however, 
the modem driver / installation may be permanently trying to access the serial port at the same time.  

Problems Printing 
Geoplot 3.0 supports parallel and USB printers. However, if you connect a parallel port printer to a USB port via 
a USB/Parallel port interface you will in general need to change the Details entry on the Properties form of the 
printer to redirect printing from the parallel port to the USB/Parallel port interface adapter. 

If you are attempting to print to a network from a Windows 2000 terminal you may only be able to print once 
before getting a printer error message. To work around this, set the default printer to a local printer and then use 
the Net Use command to redirect printing from LPT1 to the network printer. An example command line is: “net 
use lpt1 \\geoscan1\epson_q”. Create this in Notepad, save as a batch file, eg redirect.bat and create a desktop 
shortcut to it. To cancel this command create another batch file: “net use lpt1 /delete”. 

If you change printer settings, eg paper size, sometimes this change will not come into effect immediately but 
will only come into effect on the second time of submitting a print job. 

In general, single users with a dongle protected Geoplot cannot print directly to a network printer since the 
dongle will only work correctly when the parallel port system is disconnected from the network. Instead you 
must either use a local printer attached to the parallel port and dongle or enquire about network versions of 
Geoplot which are protected with a software lock. 

If you are unable to access the printer when using a hardware lock and conventional parallel port, even though 
Geoplot runs correctly apart from this, then it is likely that the printer driver is the cause of the problem. Some 
printer drivers, especially those supplied with Hewlett-Packard printers, are set up for bidiectional use, with the 
printer trying to send and receive information on most of the parallel port lines all of the time. If the dongle and 
printer try to access the same line then problems can arise. The solution is to disable this bi-directional mode of 
operation using configuration settings in the printer driver – please consult your printer driver technical guide 
for details on how to do this. You will probably need to reboot the PC for any changes in printer driver settings 
to take place. By changing the bidirectional settings you are unlikely to loose any major functionality – for 
example you may simply no longer get a report of the amount of ink left in the printer cartridges. If  you cannot 
resolve the problem by making such changes and have a dongle with a number earlier than 98167 then we may 
issue you with a new dongle and disks. Note however that a new dongle will not necessarily cure any dongle and 
printer driver conflicts. It may be necessary to issue you with a software lock to overcome such problems. 

If you experience general printer problems even with a software authorisation then try installing a generic 
printer driver for your printer, eg Epson Esc 2 for many Epson printers and set this as the default. If this solves 
the problem then you should try and obtain an updated driver for your printer.   

Problems with Graphics 
If you get a specific error message concerning graphics, for example advising that the plotting parameters should 
be changed, but doing so does not improve matters, then try Clipping the data beforehand. 

Less specific graphics problems are generally caused by the driver for the graphics card so make sure you have 
the latest driver installed. For example you may have a problem using Save Graphic Plot – other programs are 
unable to read the resulting file - or the graphics image is “dithered”, even at 256 colours. If you are unable to 
change the graphics driver it is possible to allow other programs to read the file by first importing it into 
Windows Paint and saving it in Paint. 

If the saved bitmap image is distorted (graphics image in the wrong place or segments swopped) when running 
in 24 or 32 bit mode, changing your display setting down to 256 colours will usually remove the problem. 

When saving Trace plots for export or use in Publish, use Resolution = Absolute for consistent plots. 

Problems creating Composites from Master Grids 
If you cannot create composites from Master Grids it is likely that you have stored the master grid in a sub-
directory with a name that does not match the grid directory – see “Creating a Master Grid” in the Tutorial 
section for further details. Versions 3.00p and later does not have this limitation. Note that all grids referenced in 
a master grid must be located in one directory only. If you wish to combine grids located in different directories 
you must first move them all into one common directory, renaming some if there are duplicate names. 
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Problems with Publish 
If you import a dot-density plot followed by a shade plot then a printed dot-density scale will be empty. To work 
around the problem reverse the order of import ie import shade plots first, then dot-density plots. 

Text in Publish must consist of more than one character otherwise it may not be printed. If you wish to use just 
one character then, as a work around, add a decimal point after it to make it printable. 

Although a published document appears to be complete on screen, it is actually stored as a text file that defines 
the relative positions of all the objects that you see on screen (and on paper). The text file refers to graphics 
plots, bitmaps and metafiles by their path names – it does not actually embed graphic images in the document 
file. It is therefore vitally important that the original file can be located whenever you open up a published 
document. Bear this in mind when backing up data, restoring data or relocating data. If the file is no longer at its 
original location the published document will not open properly. In this case use use Notepad to open up the 
.pdo file and check the paths of the graphics files referenced. If printed publish documents have a white or grey 
rectangle where you would normally expect a graphics to be then check the file paths as just described. 

If  any publish objects appear to be corrupted, for example a scale bar appears to be just an empty rectangle, then 
save your published document, restart Geoplot and reload the document to clear the error. 

The aspect ratio of imported metafiles may be incorrectly set as square. Right-click on the object to show its 
properties and resize to the correct aspect ratio. 

Problems with Process 
It is sometimes possible when you are using Periodic Defect Filter to get an “incorrect frequency index”  
message even when you are using a valid frequency index. This arises only when certain graphics 
magnifications are being used. Should you get such a message you should reload the original data set since the 
data in memory may well be corrupted if you see such a message. Change magnification before trying to use 
Periodic Defect again. 

Problems with Import 
If you keep getting the message that the import parameters do not match the file size then check the import file 
using a text editor such as Notepad to ensure that there are no extra characters or lines at the end of the file. 

Loss of Floating History or Statistics Forms 
If you reduce screen resolution and previously had the floating History or Statistics forms near the bottom of the 
screen they may no longer be visible. To restore them either (a) increase resolution again and move them higher 
upt the screen before reducing resolution or (b) replace the hist.ini and stat.ini files with the default files 
provided in RestoreFiles on the Geoplot CD or (c) open up hist.ini and stat.ini in Notepad and edit these files so 
that they show “1000 1000”, ie new X,Y coordinates that should place them back in the visible area. 

Problems running under Windows 98 and later 
The palette list on shade plotting parameters and options forms may take a long time to settle. If so, then turn the 
Animation effect off to greatly speed up the response time. 

Problems running under Windows 2000 and XP 
Geoplot functions correctly in Windows 2000 and XP when using a software lock though some form labels may 
appear to be of a slightly different shade of grey. The Process and Drawing toolbars may not align properly with 
the top toolbar in 2000 and XP. If that is the case run Windows in “Classic Mode” to restore proper alignment. 

Under some circumstances the defragmentation utilities supplied with Windows 2000 and XP can corrupt the 
Geoplot software lock authorisation – however this is not a problem on all systems. To be safe, and where 
possible, you should not attempt to defragment in 2000 and XP. This problem is currently being investigated by 
the suppliers of the software protection scheme we use and we hope to have a fix available shortly that will 
allow defragmentation on 2000 and XP at all times.  
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Problems with Networks 
If you are prevented from logging on as a specific user number, because Geoplot reports it is already in use, yet 
you know that it is not in fact in use, then a file called loggedon.ini may be present in the options directory for 
that specific user – see Appendix B, Installation Files for a description of the location where this file will be 
found. The file loggedon.ini should normally be erased whenever a user logs off, but if the program crashes, the 
process that erases that file will not take place. Removing the file manually should cure the problem. 

If Geoplot reports missing files then you will need to copy / move / remap (depending on what your network 
system allows) the files listed in Appendix B, especially the Options files in which individual user preferences 
are stored and their log-on file is stored. Individual users need to access the contents of the following directories 
(shown with a default C drive) as listed in Appendix B :  

C:\GP300\GP300\OPTIONS 

C:\GP300\GP300\GPBITM 

C:\GP300\GP300\NORTH 

C:\GEOPLOT\PALETTE 

Optionally, but strongly recommended, users should also have access to the contents of the following directories 
to enable them to follow the tutorial and examples :  

C:\GEOPLOT\GRID 

C:\GEOPLOT\COMP 

C:\GEOPLOT\IMPDATA 

Once copied, moved or remapped ensure that the Default File Paths specified in the Options menu match the 
location where the above files are stored.  

General 
If you experience unexpected problems using Geoplot try exiting and restarting Geoplot. If this fails, then reboot 
your computer to clear any operating system errors that may have occurred, since these can have unexpected 
effects in unrelated areas. If you are not a UK user, then you may find loading of new software may change your 
regional settings, leading to problems with Options files and recognition of valid decimal separators. 

If you are unable to resolve problems using the advice given in the preceding sections, and you have a dongle 
with a number earlier than 98167 a new dongle may help alleviate the problem, though not neccessarily. A new 
dongle will not cure any device driver conflict problems or a faulty Windows installation – see below - rather it 
may help with interfacing to new high speed parallel ports. 

If you are still unable to resolve problems then it is possible your Windows installation may be faulty and you 
may have to consider a re-installion. Unfortunately faults in one area of Windows can have unexpected effects 
in other totally unrelated areas, so it may be impossible to pinpoint exactly where a problem lies and the only 
resort is to start again with a rebuild. 

For your information when trouble shooting in general in the Windows operating system, please note that 
Geoplot 3.0 is a 16 bit application written in Visual Basic 3. 

If you need to contact us for technical support please could you supply the following information : 

• Your name, organisation and Geoplot Licence number (appears on disks or Lock). 
• Type of protection : dongle or software authorisation. 
• Geoplot type : single or network, full or trial version, educational network. 
• Full version number (eg 3.00g) – this information can be found in the Geoplot Help menu, About Geoplot. 
• The type of hardware you are using (processor, speed, graphics display resolution and number of colours, 

printer type, serial or PS2 mouse). 
• Operating system in use, along with version number and service packs applied. 
• Network details if appropriate. 
• Details of the problem you are experiencing – please be as specific as possible. 
• The exact error number, location and message reported if one occured. 
• How you have tried to solve the problem. 

 



 

Appendix A 

GEOPLOT 3.0 DATA SHEET 

Introduction 
Geoplot 3.0 is a Windows program for the processing and presentation of geophysical data collected from a 
variety of instruments including : resistance meters, gradiometers, magnetometers, EM instruments, magnetic 
susceptibility instruments. Processing facilities include : high pass, low pass, median and periodic filters, 
spectrum and variance analysis, despiking, interpolation, edge matching, zero mean traverse correction, 
destagger correction, several numeric functions and a powerful cut and combine function for combing data sets 
mathematically. A record of every edit and process is maintained with each data file. Graphics may be produced 
as shade plots (grey scale or colour), trace plots (stacked profiles or 3D), dot-density or pattern plots and printed 
out at any scale or saved as bitmaps for use in other software packages. A publishing mode is included which 
allows you to combine many graphics images, text, drawn objects etc. Data may be imported and exported, 
allowing data exchange with other software packages. 

Environment 
Geoplot 3.0 retains all the functionality of the previous DOS version but adds the flexibility and convenience of 
a Windows environment. For example you can still navigate using the keyboard, menus and shortcut keys alone, 
essential for field use when a mouse or other pointing device is hard to use. However, the new Windows version 
brings the extra versatility of a mouse pointer and fast access to commonly used features using the new toolbars 
for process functions, graphics and drawing. You can identify data values by scanning the mouse over a graphics 
plot or select new graphics or process areas using the mouse. A typical opening screen consists of : a standard 
menu at the top, a horizontal toolbar just underneath which gives fast access to common menu items, a process 
toolbar to the left, a drawing toolbar to the right, status bar at the bottom, and floating complete statistics and 
latest history forms which can be invaluable aids for processing data. The View menu lets you turn toolbars etc 
on and off, though some control is also replicated on the horizontal toolbar. 

There are four views you can have of opened data : graphics view, data view, history view and file details view. 
You can easily swop to a different view using the View menu or function keys. A fifth view, publish view, is 
available for creating a published presentation of your graphics plots. A hardcopy can be made of all the views 
using the File menu. There is extensive control in the Options menu over how Geoplot operates and your 
prefered defaults for different views and forms. For example default plotting parameters and default palette can 
be set, along with default screen colours. Default numeric resolution in the data view can be set together with 
dummy number status. You can define what your prefered view is when you load new data (graphics, data, 
history, file details or last view), and also if previous plotting parameters or default ones are to be used if a 
graphics plot is to be made. Many other options can be defined. 

Data is handled in grid, master grid or composite format. A master grid defines how the individual grids lie in 
relationship to one another and can be used to combine individual grid data files into one file called a composite. 
Grids and composite files have associated with them an edit and process history respectively, as well as 
dimensional and other file information details. Input templates, which document data collection details and user 
comments, make data input rapid and easy to accomplish, and can avoid errors in the field. Files can optionally 
be date stamped when input in either European or USA format but date stamping can be turned off to avoid Year 
2000 problems on older computers where the BIOS or RTC functions provide misleading information. 

Data may either be downloaded from Geoscan Research instruments via the RS232 port, manually input via the 
keyboard or input via batch file transfer. Raw grid data downloaded from instruments is software write-
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protected, preventing loss of data whilst in Geoplot. Imported data can be stored in grid or composite data 
format and a variety of input formats are recognised, including plain ASCII, XYZ and Spreadsheet, so that data 
from instruments other than those made by Geoscan Research can be handled. Data can also be batch exported 
in a variety of formats including plain ASCII, XYZ (comma, space or tab separated), Geosoft, Surfer grid files 
(ASCII and binary) and Grass for GIS. Generating direct Surfer grid files within Geoplot can save considerable 
time when using Surfer's facilities.  

Usually you will use SVGA or higher for desktop work but the forms have been designed for VGA use too, 
which can be extremely useful for data download in poor lighting conditions or where older laptop computers 
with VGA LCD's are to be used. 

The file manu also has facilities for combining several composites into one, creating blank composites for 
complex data manipulation, and the generation of stacked pseudo-sections from expanding Twin array data sets. 

Whenever an edit or process function is applied to data the default is to immediately update the current view, be 
it graphics, data, history or file details. The floating history and statistics forms are updated too. You can, if you 
wish, turn off automatic graphics update.  The Edit menu allows you to Flip Horizontal, Invert Traverse mode 
and directly change grid data. The Edit menu also allows you to change the North direction and change the 
Units, and Rotate both grids and composites. You can additionally document the recorded edits or processes by 
adding, inserting or deleting comments in the file history.  

Graphics 
Four graphics presentation types are provided : shade, trace, dot-density and pattern. Shade plots can have 
between 2 and 234 different shades of grey or colour. Trace plots represent data by a series of line graphs 
stacked vertically above one another. The data may be viewed from all four sides, and the trace angles adjusted 
to give a 3D style view. Dot-density and pattern plots represent data values by the number of dots within a cell 
plotted either randomly or in a systematic way. Plotting parameters can be entered in standard, clip, compress or 
relief mode, with default settings being defined in Graphics Options. Relief plots (artificial sun) are particularly 
effective at removing background resistance variations and present an almost photographic style quality (see 
adjacent figures). You can select a smaller portion of a graphics plot for display either by entering co-ordinates 
in the graphics parameter form or by selecting an area with the mouse. Plotting size varies between x 5 and x 
1/32, providing a large dynamic range. You can magnify, reduce, zoom in or out at a point and pan in a graphics 
plot using either buttons on the toolbar or shortcut keys. A special toolbar button allows you to magnify x2 a 
small localised area of a plot (see figure). 

A range of shade palettes are supplied and you can create and edit your own (see figure opposite). Each palette 
comprises one or more flooded regions and individual colour bands can also be superimposed anywhere on the 
palette. When in graphics view you can change the palette either by using the palette tools (next palette, 
previous palette, invert palette) or by bringing up the graphics parameter form. You can quickly display the 
Shade and Trace parameters forms by clicking on two special icons on the horizontal toolbar, or by choosing 
from the Graphics menu as normal. 

Grid lines and numbers can optionally be superimposed on graphics plots, as well as your own user defined grid. 
As you move the mouse over a graphics plot its x, y co-ordinates are reported on the status bar (in both metres 
and reading units), along with the data value at that point. You can set any colour you like for the graphics 
screen background, dummy values etc. using the Graphics Options. Plot details can optionally be displayed on 
the right-hand side of the screen which includes palette or trace scale-bar, distance scale-bar, plotting 
parameters, direction of first traverse and histogram. The resolution of the numbers on the palette scale-bar can 
be controlled using the Graphics Options form. If you apply the Spectrum process to the data the plot details on 
the right-hand side will change to show spectrum units and the co-ordinates reported on the status bar, as the 
mouse moves, will show x position and frequency, instead of x and y co-ordinates. 

A default style printout of a graphics plot can be made to any scale or print size using the File menu. You can 
choose whether you want to : (a) plot the whole data set, (b) a specific block, or (c) just what you see on screen. 
Graphics plots, palette scale-bars, north symbols histograms and distance scale-bars can also be saved to files. 
These can subsequently be imported into the publish view, at a specific scale, for publishing. Alternatively, you 
can use the saved bit-map for importing into other Windows packages. 
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Figure A-1. Typical appearance of Geoplot 3.0 showing the graphics view. 

 

 

Figure A-2.  Typical appearance of Geoplot 3.0 showing the publish view. 
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Publishing 
Once you have processed your data and set the graphics plotting parameters you can save this image, along with 
scale bars, north direction and histogram for use in the publishing mode. This mode allows you to tailor the 
printout to your own requirements, rather than using the default presentation of the standard graphics view, 
allowing you, for example, to choose a border and add text in various fonts and sizes, select a north direction 
symbol. Images may be positioned, rotated and scaled to your liking. More than one image can be incorporated 
in the document, for example images from different sites, different graphics types (eg shade and trace plots) and 
even your own logo. The published graphics image is not just a screen grab with limited resolution, but a 
properly regenerated plot showing full detail on large size printers. 

Processing 
Processing includes a comprehensive range of functions for manipulation of all data types, together with specific 
routines to correct for data collection artefacts such as edge matching and drift correction. Some functions are 
designed specifically for Geoscan Research instrumentation but all may be equally applied to other 
instrumentation data sets. Mathematically, any real bipolar or monopolar two dimensional data array may be 
processed. 

A processing tutorial is included in the instruction manual, together with "QuickStart" cards which guide you 
through the processing sequence appropriate for each data type. Both assist new users in becoming an adept and 
competent processor with a minimum of effort, and help to prevent inappropriate processing of the data. 

Processing functions can be applied to the complete data set or any specific rectangular area, known as a block. 
You can specify a block either by entering co-ordinates in a form or, by selecting the area using the mouse. This 
block remains operational until turned off. You can select process functions and process area from the menu, or 
more conveniently from the process toolbar. 

Processing history is stored with each data file. This records function applied, the chosen parameters and co-
ordinates of any selected block, giving full traceability. A floating form, "Latest History" shows the last four 
processes applied and you can instantly switch to the history view to see a full listing of all processes. The 
process history shows a dotted dividing line between those processes that have been saved and any new 
functions that have been applied but not saved. History comments can be added, inserted or deleted when the 
history view is shown. Functions include : 

Numeric Functions 
Add, Multiply, Absolute, Power, Clip, Compress, Search and Replace, Randomise are general purpose numeric 
tools with a variety of applications. Some examples follow though they are by no means limited to these. The 
Add function can be used to edit a single data point or bias a block of data. Multiply can be used to normalise 
data or convert resistance to resistivity. Absolute can be useful in the generation of magnetic-resistance 
correlation plots. Power can be used to convert resistivity to conductivity. Clip can be used to limit data to 
specified maximum and minimum values for improving graphical presentation and also forms a useful pre-
process procedure for many other functions. Compress can be used to fit data within the dynamic range of a 
display device or printer, allowing both large and small magnitude features to be visible at the same time. Search 
and Replace can be used, in conjunction with Clip, to convert regions strongly perturbed by nearby iron fences, 
pipelines etc. into dummy regions, allowing other statistical functions to perform correctly. Randomise may be 
used for introducing a controlled amount of noise so that surveys performed at different times or with different 
instruments visually match. 

Cut and Combine 
This function provides Cut and Paste, Add, Subtract and Multiply operations between two data sets (grid and 
composite). This can be applied between any block of source data and positioned at any location in the other 
data set. Applications include merging data sets, splitting data sets, generation of correlation plots between data 
sets etc. Another powerful application is to examine the effect of a process function (by subtracting the original 
data set), thereby ensuring that the process function has been applied with the correct parameters (see figures on 
opposite page). 

Deslope 
Removes a linear trend within a data set. It is typically used to correct for drift in gradiometer data where the use 
of the Zero Mean Traverse function is inappropriate. 
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Despike 
Automatically locates and remove random spurious readings present in resistance data and locates and removes 
random "iron spikes" often present in gradiometer data (see adjacent figures). 

Destagger 
Corrects for displacement of anomalies caused by alternate zig-zag traverses which are sometimes observable in 
gradiometer data. 

Edge Match 
Used to remove grid edge discontinuities which may be present in Twin electrode resistance surveys as a result 
of improper placement of the remote probes. 

High Pass Filter 
Used to remove low frequency, large scale spatial detail, typically  a slowly changing geological "background" 
response commonly found in resistance surveys. 

Interpolate 
Increases or decreases the number of data points in a survey (linear or sinx/x method). Increasing the number of 
data points can be used to create a smoother appearance to the data. Interpolate can also be used to make the 
sample and traverse intervals of differently sampled composites match, prior to combining them. 

Low Pass Filter 
Removes high frequency, small scale spatial detail, useful for smoothing data or for enhancing larger weak 
features. 

Median Filter 
Automatically locates and removes random spurious readings present in survey data and smoothes the data at 
the same time. Most useful for high sample density data. 

Periodic Defect Filter 
Used to remove periodic features which may be present in the soil (eg plough marks) or which may be 
introduced as defects during gradiometer data collection. 

Spectrum 
Analyses the frequency spectrum of the data, splitting it into Amplitude, Phase, Real or Imaginary components. 
The Amplitude spectrum can be used to identify periodic defects in gradiometer data which can then be removed 
with the Periodic Defect filter. 

Standard Deviation or Variance Map 
Replaces the data set by either the local standard deviation or the local variance. A graphics plot of this new data 
set indicates areas of statistically different activity. 

Statistics 
Provides a statistical analysis of any block of data within a data set : localised mean, standard deviation, 
minimum, maximum and a localised histogram (this is in addition to the floating statistics report for the whole 
of the data set). Statistics can often be used to determine appropriate parameters for other process functions. The 
report form can be positioned anywhere on screen or minimised and can be retained whilst a new data set is 
loaded, so that the statistics can be compared.  

Zero Mean Grid 
Sets the background mean of each grid within a composite to zero. It is useful for removing grid edge 
discontinuities often found in gradiometer or similar bipolar data. 
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Zero Mean Traverse 
Sets the background mean of each traverse within a grid to zero. It is useful for removing striping effects in the 
traverse direction which can occur in gradiometer data. This also has has the effect of removing grid edge 
discontinuities at the same time (see adjacent  figures). 

Hardware Requirements 
Geoplot 3.0 consists of  three items: (a) CD with installation code, (b) comprehensive instruction manual with 
tutorial and (c) softare protection -  this is provided as either a USB or LPT hardware dongle, or a software 
authorisation. The software authorisation is transferred to your hard disk from a floppy disk or can be transferred 
to another PC via the floppy disk. 

The software is normally supplied for one user operating on a stand-alone PC or a computer network. Multiple 
user versions are available for use on client-server network systems. Multiple user educational versions, with 
restricted functionality, are available for use on client-server network systems.  

Operating system should be one of the following : Windows 3.1, 3.11, 95, 98, ME, NT4, 2000 or XP. Minimum 
recommended hardware is a Pentium II class processor, cpu speed 266 Mhz or faster, with SVGA display or 
better for desktop work. Geoplot 3.0 will also work on PC's as slow as a 486 DX2 40Mhz processor so an older 
laptop computer with VGA display running Windows 3.1, for example, could be used for downloading data in 
the field. An RS232 communication port is required if data is to be downloaded from instruments into Geoplot 
3.0 - if there is only a USB port available then a USB to serial port adapter may be used. A 3.5 inch floppy disk 
drive (built-in or external USB) may also be required for software authorisation transfer. 

Upgrades and Support 
Geoplot is undergoing constant improvement and refinement. Future upgrades will include interfaces to new 
instruments and new data formats, together with new processing and presentation facilities. If there are specific 
facilities not mentioned above that users would like to be included in future versions then we would be happy to 
consider suggestions. A charge will be made for upgrades. Full technical support is provided free of charge. 

Compatibility with earlier versions 
Grid data, composite data and master grids (meshes) generated using earlier versions may be used directly with 
Geoplot 3.0. However, version 3.0 data is not backward compatible with version 1.2. Version 3.0 data may be 
read by version 2.0 but the resulting layout on the file information and history forms may not be as normal. 
Input templates generated with earlier versions are not compatible. 

Educational Version 
A multiple user (25) educational version, with restricted functionality is available for use on client-server 
network systems. Functions that are disabled are : New Input Template, Open Input Template, Download Data, 
Keyboard Input, Import Data, Export Data, and Create Pseudo-section. There are no other restrictions. 



 

Appendix B 

GEOPLOT 3.0 
INSTALLATION FILES 

Directories and Files – Single User 
The Geoplot 3.0 installation creates the following directories and files (assuming a default C: installation) :   

In the C:\GP300 directory : 

• VBRUN300.DLL  398,416 22/09/1994 
• COMMDLG.DLL  88,544 25/03/1999 
• MSCOMM.VBX  34816 12/05/1993 
• CMDIALOG.VBX  18,688 28/04/1993 
• THREED.VBX  64,432 24/08/1996 
• TRUEGRID.VBX  328,720 17/02/1995 
• VSVBX.VBX   92,176 05/01/1995 
• DEIS11.ISU      for uninstallation 
• ISREG16.DLL      for uninstallation 
 
With Az-Tech hardware copy protection : 

• KECHK2.DLL   23,040 02/11/1998 
• NTSETUP.EXE     for NT4 
• DOWNTVDD.DLL  11,776 29/10/1996 for NT4 
• DS1410D.SYS   7,328 07/08/1997 for NT4 
• GP300.EXE      Geoplot executable 
 

With Matrix hardware copy protection : 

• MATRIX16..DLL  58,016 27/03/2005 
• MATRIX32..DLL  118,784 31/03/2005 
• MXCHECK.EXE  49,152 15/03/2005 
• INF_INST.EXE  40,960 09/11/2004 
• IWPORT.VXD  5,687 17/03/2000 
• IWPORT.SYS   7,896 02/11/2001 
• IWUSB.SYS   20,645 29/11/2002 
• IWUSB.INF   6,633 25/09/2003 
• DRV_INST.EXE  155,648 05/04/2005 
• GP300MX.EXE     Geoplot executable 
 

With software copy protection : 

• AUTHMANW.EXE  388,864 06/06/1999        (pre-May 2003 Geoplot) 
• SCPNT16.DAT  20,992 07/02/1999 for NT4       (pre-May 2003 Geoplot) 
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• AUTHMANW.EXE  427,776 06/05/2002        (post-May 2003 Geoplot) 
• SCPNT16.DAT  25088 08/05/2002 for NT4       (post-May 2003 Geoplot) 
• GP300.EXE      Geoplot executable 
• GP300.NLW 
• GP300.SCW 

In the C:\GP300\AX NN ZZ directory (software protection only) : 

• GP300.EKB      authorisation file 
 

The above GP300 file will be called GP300D.EKB if you have installed the Single user, 60 day trial version. 
Note that although the authorisation file is installed in a directory AX NN ZZ, this is in fact a “hidden” directory 
name which you do not need to specify when transferring the authorisation – just typically specify C:\GP300. 

In the C:\GP300\GP300\OPTIONS directory : 

• DRAWOPT.INI     drawing options 
• ENVOPT.INI      environment options 
• FILEPATH.INI     default file paths 
• GRAFOPT1.INI     graphics options 1 
• GRAFOPT2.INI     graphics options 2 
• HIST.INI      Latest History position 
• MRUFILES.INI     most recently used files 
• PUBOPT.INI      publish options 
• STAT.INI      Complete Statistics position 
• TOOLBAR.INI     Toolbar displacement (version 3.00r onwards) 

In the C:\GP300\GP300\GPBITM directory : 

• Range of BMP files for toolbars, graphics, publishing etc. 

In the C:\GP300\NORTH directory : 

• Sub-directories N1-N6 containing a variety of north symbols for graphics and publish. 

In the C:\GEOPLOT\GRID directory : 

• Sub-directories containing sample grid data. 

In the C:\GEOPLOT\COMP directory : 

• Sub-directories containing sample composite data. 

In the C:\GEOPLOT\IMPDATA directory : 

• Sample import data. 

In the C:\GEOPLOT\PALETTE directory : 

• Range of Shade Plot graphics palettes. 

In the C:\GEOPLOT directory : 

• Range of sub-directories created to match default file paths : 
• Expdata 
• Expimg 
• Iptem 
• Mesh 
• Pubdoc 
• Pubimg 
• Pubtem 
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Directories and Files – Multi-User Network 
Directories and files installation will be the same as for the single user installation except for the following 
differences. Geoplot must be installed in a shared drive and directory. Typically this will be drive G so replace C 
drive with G drive in the above single user paths. The authorisation file will be located slightly differently : 

In the G:\GP300 directory  : 

• GP300N5.EKB     Authorisation file 
• GP300N5.HRD 
• GP300N5.N00 

 

The above GP300N5 files will have a name different from GP300N5, depending on the installed version  : 

  Network, 10 user :    GP300N10 

  Educational Network, 25 user :  GP300E25 

  Educational Network 25 user, 60 day trial : GP300ED  

In the G:\GP300\GP300\OPTIONS\”user number” directory : 

For network operation, Geoplot creates subdirectories in the Options directory with names equivalent to the user 
number, up to the maximum number of users possible – for example G:\GP300\GP300\OPTIONS\1, 
G:\GP300\GP300\OPTIONS\2 etc, for user numbers 1 and 2, and up to G:\GP300\GP300\OPTIONS\25 for a 25 
user network version. Individual sets of the *.ini files listed above for single users will be stored in each of these 
subdirectories, with each set unique to each user number. These files are present permanently. In addition a 
temporary file called loggedon.ini will be created each time a Geoplot user logs on and occurs only in the 
subdirectory relating to that user. It is used to ensure that two users cannot logon and use the same set of options. 
When a user exits Geoplot, the loggedon.ini file in his subdirectory only is killed, so that another user may 
subsequently log on afresh using that same number. 

Default File Paths 
The default file paths provided by Geoplot on installation are as follows : 

• Grid Data   c:\geoplot\grid 
• Composite Data  c:\geoplot\comp 
• Master Grid   c:\geoplot\mesh 
• Input Template  c:\geoplot\iptem 
• Palette   c:\geoplot\palette 
• Data Import   c:\geoplot\impdata 
• Data Export   c:\geoplot\expdata 
• Image Import (*.bmp, *.wmf) c:\geoplot\pubimg 
• Save (Export) Graphic Plot c:\geoplot\expimg 
• Publishing Template  c:\geoplot\pubtem 
• Published Document  c:\geoplot\pubdoc 

 

Geoplot 3.00 Version Information 
Version 3.00s 
Internal maintenance code changes relating to Matrix dongles. Matrix dongles that are HID compliant start 
shipping after serial number GP05698.  

Version 3.00r 
Support for Matrix dongles (USB and LPT) introduced. Periodic Filter allows entry of a band of frequencies, not 
just one frequency. Environment Options provides a setting that allows for correction of the vertical position of 
the side toolbars which can be misplaced in 2000 or XP. 
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Version 3.00p 
Master Grid now allows you to insert rows and columns. It also now allows you to quickly add either ‘a’ or ‘b’ 
at end of names in a previously created master grid making it easier to create matching dual FM256 composites 
for merging. Additionally, you are no longer required to have matching directories for Master Grids and data 
Grids for composite creation. Interpolate (Shrink) now has provision for shrinking data by straight line deletion, 
not just averaging. Odd or Even lines can be specified. This makes it possible to investigate the effect of 
different sampling strategies using already highly sampled data. Destagger can now operate on all grids in one 
pass. It can also be set to either destagger alternate lines (-2-4-6-8) or destagger in pairs of lines (- - 34 - - 78) 
which can be required when a dual system is turned through 180 degrees with zig-zag surveying. It is also 
possible to destagger individual lines. All Save and Save As forms now have a ‘New Directory’ button for easier 
creation of new directory structures within the form. Code has been modified to allow printing to file. The 
Graphic Plot Details panel to the right hand side of the main screen is changed from a white to grey background. 
Fixed grid rotation bug. 

Version 3.00k 
Added Merge Composite code for 180 degree rotation of CF6 carrying frame. 

Version 3.00h 
Provision made for downloading FM256 gradiometer data. Merge Composites facility added to File menu. 
Added threshold facility to Zero Mean Traverse, Spectrum and Periodic Filter. Fixed bug in Deslope and created 
new splash screen. 

Version 3.00g 
Added Swop Adjacent Traverse to Edit menu to provide striping correction for MPX15 data. Changed error 
messages for RS232 downloads. Made floating Statistics form border fixed. 

Version 3.00f 
Added import of spreadsheet data with either comma or tab separation. 

Version 3.00e 
Modifications made to Software Authorisation system. 

Version 3.00d 
Modified download error messages for framing and parity. 

Version 3.00c 
Added educational network version with limited functionality. Fixed process area selection problem. Fixed 
Destagger bug and included shift of dummy readings as well. 

Version 3.00b 
Code added to check if a network user was already logged on. 

Version 3.00a 
Red text added to rotate composite and download forms. Underlying code for individual network user options 
added. 

Version 3.00 
Original shipment code. 

 
 


